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КИРИШ

Географик ахборот тизимлари (ГАТ) кенг тармоқли соҳа бўлиб, хариташунослик, 
масофадан зондлаш, ер тузиш, табиий ресурсларни бошқариш, фотограмметрия, 
география, шаҳарсозлик, самовий видео ҳамда маҳаллий қидирув тизимларида кенг
фойдаланиб келинмоқда. 

ArcGIS дастури пакети дунёнинг ГАТ бўйича етакчи атроф муҳит тизимлари
тадқиқот институти (ESRI) томонидан ишлаб чиқилган. ESRI “ГАТ маҳсулотлари
дастур таъминотининг интеграллашган коллекцияси” сифатида дастур пакетини
ифодалайди, унда фойдаланувчи ёки компания ГАТни тўлиқ амалга ошириши
мумкин.

Амалий машғулот давомида ArcGIS дастурининг иккита маҳсулоти билан
танишилади. Улар – ArcCatalog, ArcToolbox, дастурларидир. ArcGIS дастурлар
пакети тўғрисида батафсил маълумотларни қуйидаги вебсайтдан олиш мумкин: 
www.esri.com. 

ArcCatalog

Барча фазовий маълумотларни йиғиш ва бошқариш учун ArcCatalog дастуридан
фойдаланилади. Бу ўзида географик ахборотни харита ёки жадвал шаклида
ўрганиш, топиш ва кўриб чиқиш жихозларини мужассамлаштиради. Киритилган
фазовий маълумотларни алмаштириш, номлаш ёки ўчириб ташлаш мумкин, ҳамда
уларни кўриш, яратиш ва метамаълумотларни тўғрилаш мумкин.

Огоҳлантириш: ҲЕЧ КАЧОН геомаълумотларни бошқаришда Windows Explorer
дан фойдаланиш мумкин эмас, масалан геомаълумотни номлаш, алмаштириш ва
ўчириш тақиқланади, унинг ўрнига ArcCatalog дан фойдаланиш мақсадга мувофиқ.

ArcToolbox

ArcToolbox дастури фазовий маълумотларни таҳлил қилиш ва геомаълумотларни
қайта ишлаш учун ҳар томонлама жиҳозланган ГАТни таклиф этади. Баъзи
геомаълумотларни қайта ишлашнинг умумий вазифалари қуйидагиларни ўзида акс
эттиради:

 Маълумотларни ўзгартириш (векторни растр маълумотлар тўпламига 
ўзгартириш);

 Маълумотларни кераклигидан ортиқ қўйиш (маълумотлар тўпламини  
бирлаштириш ёки туташтириш);

 Маълумотларни чиқариш (маълумотларни кесиб олиш ёки аниқ тавсифга эга 
маълумотларни танлаш);

 Яқин атрофда нима мавжудигини қидириш (маълумотларни буферлаш ёки 
бошқа объектлар ёнидаги нуқталарни излаш);
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 Маълумотларни бошқариш (жадвалларни бирлаштириш, маълумотлар 
тўпламидан нусха олиш ёки янги маълумотлар тўпламини яратиш).

ArcToolbox ГАТнинг алоҳида дастури ҳисобланмайди. Бу икката ArcCatalog and
ArcMap дастурлари билан бирлаштирилган. ArcToolbox га кириш учун шу икката 
дастурдан фойдаланилади.

Ушбу амалий машғулотда:

 ArcCatalogдан фойдаланиб метамаълумотларни ва маълумотлар тўпламини 
тадқиқ қилиш ўрганилади. 

ArcMap ҳужжати: Intro_АM.mxd
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ARCCATALOG ДАСТУРИ БИЛАН ИШЛАШ

ArcCatalog қўлланилиш ойнаси

ArcCatalog ойнаси (1- расм) турли хил компонентлар ишлатилган ҳолда яратилган: 
Каталог дарахти/Catalog tree (1), намойиш ойнаси /View window (2), меню 
панели/мenu bar (3), асбоблар панели/toolbars (4). 

1-расм. ArcCatalog қўлланилиш ойнаси.

ArcCatalog дарахти / ArcCatalog tree (1)

Каталог дарахти Windows Explorer даги папкалар дарахти  каби ишлайди. У сақланган 
фазовий маълумотларни топиш мақсадида компьютердаги папкаларни кўриш 
мумкин. Шунингдек, агар маълумотлар манбаларига боғланилган бўлса 
компьютердаги  маълумотлардан ташқари ГАТ серверига ҳамда тармоқдаги 
маълумотлар базасига кириш имконини беради. Агар боғланилган бўлмаса, 
ArcCatalog маълумотлар базаси билан ёки ГАТ серверини қўшиш мумкин. 

Намойиш ойнаси / View window (2) 

Намойиш ойнаси ўзида  3 та кўриниш иловасини акс эттиради. Мундарижа/Contents
иловаси, бунда файл ва папкалардаги харита ва жадвалларнинг рўйхати кўринади. 

3 4

1

2
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1 - расмда намойиш ойнасида D:\IGI\Morning\ArcGIS\Data папкасининг 
мундарижасини кўрсатган. Олдиндан кўриш/Preview иловасида йиғилган географик 
ва жадвал кўринишдаги маълумотларни ўрганишингиз мумкин. Йиғилган 
маълумотлар тўпламига кириш учун сиз Метамаълумот/Metadata иловасидан 
фойдаланишингиз мумкин.  

Меню панели/Menu bar (3)

Меню панели ArcCatalog ойнасининг тепа қисмида жойлашган бўлиб, ArcCatalog
менюсини намойиш этади. Меню панелидан  вазифаларни танлаш учун сичқонча ёки
клавиатурадан фойдаланиш мумкин. Баъзи тезкор клавишалар менюда кўрсатилган.  

Асбоблар панели/Toolbars (4)

Асбоблар панели ArcCatalog ойнасининг меню панелидан кейин паст қисмида
жойлашган, турли хил тезкор бошқарувларга ҳамда асбобларга кириш имконини

беради. ArcMap тугмаси ва ArcToolbox тугмалари орқали ишни бошлаш

мумкин. Географик асбоблар панели (Geography toolbar) 
тугмалари орқали осонликча намойиш ойнасида/view window йиғилган географик
маълумотларни ўрганиш мумкин. Меню панелидан View иловаси орқали асбоблар
панелини/toolbars қўшиш мумкин.

Фазовий маълумотларга кириш ва ArcCatalog дастурини бошлаш

ҚЎЛЛАНМА: 

1. ArcCatalog дастурини ишга тушириш учун Пуск тугмасини босинг,
Programs=> ArcGIS => ArcCatalog ни танланг.
2. ArcCatalog дастури очилганда, баннер йўқолади ва ArcCatalogнинг ойна
кўриниши пайдо бўлади. 
3. Каталог дарахтидан /Catalog tree маълумотларни сақловчи
D:\IGI\...*…\ArcGIS\Data (*morning or afternoon) папкани танланг. Ҳозир танланган
маълумотлар намойиш ойнасида/view window кўрсатилган. Мундарижа/Contents
иловасида танланганлигига ишонч ҳосил қилинг.

1.

Каталог дарахти/Catalog tree фазовий маълумотлардан ташкил топган папкани
танланг. Намойиш ойнасидаги Мундарижа/Contents иловасини белгиланг.

1а. Бу папка неча хил турдаги файллардан иборат?
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1b. Shapefile – бу вектор/vector маълумотлар тўплами учун ArcMapнинг сақлаш тури
ҳисобланади. Каталоглар дарахти/Catalog tree ва Намойиш ойнаси/View window да
ҳар бир маълумотлар тўпламининг номлари  қаршисида иконкаларни кўриш мумкин. 
Бу ерда 3 та ҳар хил шейпфайл/shapefile га мансуб иконкалар мавжуд. Бу иконкалар 
нимани билдиради?

Фазовий маълумотларни тадқиқот қилиш

Тармоқда ёки компьютерда жойлашган маълумотлар тўпламини ArcCatalog нинг
олдиндан кўриш /preview  функцияси орқали маълумотларни текшириш мумкин. 
Фазовий маълумотлар харита ва жадвал кўринишидан иборат бўлади. ArcCatalog
дастурида баъзи асбобларни/tools таҳлил қилиш ва жадвалларга /tables ўзгартиришлар
киритиш мумкин. 

ҚЎЛЛАНМА:

1. Каталог дарахтидан/Catalog tree маълумотлар тўпламини/datasets танланг.
2. Намойиш ойнасида/view window олдиндан кўриш/Preview иловаси орқали 

маълумотлар тўпламини/datasets кўриш мумкин.
3. Намойиш ойнасининг/view window пастки қисмида матн менюси/dropdown menu

пайдо бўлади. Танланган маълумотлар тўпламини/datasets текшириш учун 
Географик олдиндан кўриш/Geographic preview ёки Жадвални олдиндан 
кўриш/Table preview иловаларини танлаш мумкин.

4. Олдиндан кўриш/Preview ни иловасини босинг, кейин Географик олдиндан 
кўриш/Geography preview иловасига ўтинг. Намойиш ойнасидаги /View window
чизилган харита ҳар бир вектор/vector маълумотлар тўпламида
объектдан/feature, ҳар бир растр/rastr маълумотлар тўпламида катакчадан/cell
ва ҳар бир TIN маълумотлар тўпламида учбурчакдан/triangle ташкил топган. 
Географик олдиндан кўриш/Geography preview иловасини кўраётганда 
Географик асбоблар панели/Geography toolbar фаол ҳолатда бўлади. Харитани 
тадқиқот қилиш учун Географик асбоблар панелидан/Geography toolbar
фойдаланиш мумкин. 

5. ArcGISда қайдлар/records деб номланадиган қаторларни/rows, майдон/fields деб 
номланадиган устунларни/columns ва танланган жадвалда ҳар бир катакча учун
атрибут қиймат/attribute values деб номланадиган матн менюсини кўриш учун 
Жадвални олдиндан кўриш/Table preview иловасини танланг. 

6. Сичқончанинг ўнг тугмасини босган ҳолда, устуннинг сарлавҳасини танлаб 
майдонни ўчириш/delete ёки майдоннинг қийматини тасвирлайдиган 
статистикани олиш, бир ёки бир нечта майдонларни/fields атрибут 
қийматлари/attribute values орқали жадвалнинг қайдларини/records саралаш/sort
мумкин. 
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7. Жадвалга майдон қўшиш ёки жадвалга махсус қийматни жойлаштириш учун 
намойиш ойнасининг/view window пастки ўнг бурчакдаги Опция/Options
тугмасидан фойдаланинг. 

Эслатма: ArcCatalog да жадвалнинг атрибут қийматларини ўзгартира олмайсиз.

2.

Каталог дархтидан/Catalog tree Мамлакат/‘Country’ маълумотлар тўпламини
танланг. Намойиш ойнасида олдиндан кўриш/Preview иловасини кўрсатинг.  Ушбу
маълумотлар тўпламидаги барча объектларни/features кўрсатувчи мамлакат харитаси
пайдо бўлади. Олдиндан кўриш/Preview иловасида пастки менюдан жадвал 
кўринишини/Table view танланг.

2а. Жадвал нечта қайдлардан/records иборат ва нечта майдон/fields мавжуд?  

2b. Жадвалга опция/Options тугмасидан фойдаланган ҳолда майдонни/field қўшинг. 
Ойнанинг Name майдонига capital деб ном киритинг. Тур/Type майдонининг пастки 
матн менюсидан Матнни/Text танланг. Майдон узунлигини 20 га ўзгартиринг.

2c. Яқиндагина қўшган майдонни/field ўчиринг. 

2d. Ўсиш/ascending бўйича (майдон/field: provnaam) устунини сараланг. Норд-
Брабанд/Noord-Brabant вилоятига нечта қайдлар/records тегишли? 

2e. Мамлакатнинг умумий майдони/total area қанча? Статистика/Statistics
функциясидан фойдаланинг.

2f. Қайси вилоятда 219934.719 метр периметрга эга объект/feature ташкил топган? 
Ушбу объектнинг атрибут қиймати нимага тенг?

2g. ‘FID’ атрибути нимани билдиради? 
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Фазовий маълумотлар тўпламида метамаълумотларни тадқиқот этиш

Агар мавжуд керакли бўлган ресурсларни кўриш учун қидириш, хариталар ва 
маълумотларни бўлишишда метамаълумотлар жуда муҳим ҳисобланади. Кутубхона 
карточкаси каталогдаги китобларни ифодаланган каби метамаълумотлар ГАТнинг 
маълумотлар тўпламини шундай тарзда тасвирлаб беради. Қидириладиган 
маълумотлар тўпламини топишда метамаълумотлар унинг сизга қанчалик зарур 
эканлигини ҳал этади. Бу қарорни қабул қилишда сиз бу маълумотларни канчалик 
аниқ ва айни вақтда эканлигини ҳамда бу ерда яна бошқа чекланишлар мавжудлигини 
ва уни кандай иштишни билишингиз керак. Метамаълумотлар шу саволларга жавоб 
бера олиши мумкин. 

ArcCatalog да ҳар қандай папкалар ва файл турлари Word ҳужжатлари каби ўз ичига 
олганидек метамаълумотларда мавжуд бўлиши мумкин. ArcCatalog билан 
бошқарилганда метамаълумотлар кўчирилиб ўтказилиши, жойи ўзгартирилиши,
ўчирилиб ташланиши мумкин. 

ҚЎЛЛАНМА:

1. Каталог дарахтида/Catalog tree маълумотлар тўпламини танланг.
2. Намойиш ойнасидаги/View window метамаълумот/Metadata иловаси 

танланганда маълумотлар тўпламига тегишли метамаълумотлар кўринади.
3. Метамаълумотлар ҳужжати учта иловадан ташкил топган: Тасвир/Description, 

Фазовий/Spatial вa Атрибутлар/Attributes. 
4. Сиз метамаълумотлар редактори/Metadata editor асбоблар панелини/toolbar

фаол ҳолатида метамаълумотларни қўшиш ёки ўзгартириш киритишингиз 
мумкин.

Меню панелидаги/menu bar кўриниш/‘View’ тугмасини босинг ва кейин Toolbar 
=> Metadata. Метамаълумотлар асбоб панели/Metadata toolbar экранда пайдо 
бўлади. 

5. Метамаълумотлар редактор асбоб панелидаги/Metadata editor toolbar редактор 
метамаълумотлар/Edit Metadata тугмасини босинг.

6. Метамаълумотлар ҳужжатидаги маълумотлар еттита секцияга бўлинган (1), 
метамаълумотлар редакторининг тепа қисмида жойлашган. Редактордаги 
секция номини танлаганингизда бир қанча иловалар пайдо бўлади. Булар 
секциялар ичидаги турли хил гуруҳдаги метамаълумотлар элементларини 
намоён этади (2).
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7. Сиз кўпгина элементларни таъминловчи матн кўринишидаги ойналарда матн 
теришингиз, ўзгартириш киритишингиз мумкин

3.

Каталог дарахтидан/Catalog tree Мамлакат/‘Country’ маълумотлар тўпламини 
танланг. Намойиш ойнасини/view window метамаълумот/Metadata иловасига 
ўтказинг. Намойиш ойнасида/view window метамалумотлар ҳужжатига тегишли 
метамаълумотлар тўплами пайдо бўлади.

3а. Метамаълумотлар хужжатларининг ҳар бир учта иловалари ичида қандай 
маълумотлар сақланади?

3b. Бу маълумотлар тўпламининг атрибутларини ёзинг?

3c. Провнаам/ ‘Provnaam’ атрибутининг маълумот тури/data type нима?  

4.

Агар сиз ‘Country маълумотлар тўплами метамаълумотини кўрадиган бўлсангиз унда 
баъзи маълумотлар етишмаслигига эътибор берасиз. Етишмайдиган маълумотларни 
яратиш учун метамаълумотлар редакторидан фойдаланинг.

4a. Метамаълумотлар ҳужжатларида тасвир/Description иловасини танланг. Abstract  
бу маълумотлар тўплами учун зарур ҳисобланади. 

4b. Метамаълумотлар редакторини/metadata editor очинг. Идентификация
/Identification секциясини босинг ва General тугмасини танланг. Abstract матн 
ойнасига ўтинг ва қизил ранг билан белгиланган матн маълумотини ўчиринг. Энди 
сиз ‘Бу маълумотлар тўплами мамлакатнинг 12 та вилояти ҳақида маълумотларни 
етказиб беради.’/‘The dataset supplies information about the 12 provinces of the country’ 
деган матнни киритинг. Ўзгартирилган матнни сақланг. 

1
2
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4с. ArcCatalog дастурини ёпинг. 
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1-амалий машғулотни бажаргандан кейин ўз-ўзини 

текшириш учун саволлар



19

Cаволлар

1. ArcCatalog дастурида кандай амалларни бажариш мумкин? 
2. ArcToolbox дастури фазовий маълумотларни таҳлил қилиш ва 

геомаълумотларни қайта ишлаш учун ҳар томонлама жиҳозланган ГАТ 
таклиф этади. Геомаълумотларни қайта ишлашнинг умумий вазифаларини 
нимадан иборат? 

3. ArcGIS дастурлар пакетида ArcMap нинг вазифани ёритиб беринг? 
4. Амалий машғулотни 1 – модулини бажаришда қандай ҳужжатдан 

фойдаланилади ва ўрганилади? 
5. ArcCatalog қўлланилиш ойнаси қандай компонентлардан ташкил топган? 

6. ArcCatalog қўлланилиш ойнасидаги ArcCatalog дарахтини / ArcCatalog tree 
таърифлаб беринг. 

7. ArcCatalog қўлланилиш ойнасидаги Намойиш ойнасини/View window 
таърифлаб беринг.

8. ArcCatalog қўлланилиш ойнасидаги Меню панелини/Menu bar таърифлаб 
беринг.

9. ArcCatalog қўлланилиш ойнасидаги Асбоблар панелини/Toolbars таърифлаб 
беринг.

10.Геомаълумотларни бошқаришда нимадан фойдаланиш мумкин эмас, қандай 
вазифалар тақиқланади? ArcCatalog да жадвалнинг атрибут қийматларини 
ўзгартира оласизми? 

11. Метамаълумотларнинг муҳимлиги нималардан иборат? 
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КИРИШ 



Ушбу қўлланма “Географик ахборот тизимлари” (ГАТ) фанининг амалий машғулотларини амалга ошириш учун компьютер дастурлари ёрдамида машқларни бажаришни ўз ичига олади.  

Амалий машғулотнинг асосий вазифалари қуйидагилардан иборат: 

1. ГАТ терминларининг асосини маълумотларни қайта ишлаш орқали машқлар усулида намойиш этиш; 

2. Дизайн ва таҳлил жараёнларида ГАТдан фойдаланишнинг самарадорлигини тушуниш.

Магистрант бу фанни ўзлаштиргандан кейин қуйидагиларни бажара олиши мумкин: 

· ГАТ асосий тушунчасини атроф муҳитда қўллаш; 

· Маълумотларни йиғиш, уни қайта ишлаш ва тақдимот қилишни амалга ошириш;

· ГАТда маълумотларни бошқаришнинг учта синфига аниқлик киритиш; 

· Махсус маълумотларни бошқариш синфларини қўллаш ва ном бериш; 

· Маълумот тизимига ушбу операцияларнинг таъсир қилишини тушунтириш;

· ГАТ дастурининг чекланиш ва имкониятларини ифодалаб бериш;

· Маълумот ҳаракати моделини яратиш; 

· Маълумот ҳаракати моделига асосланиб ГАТ дастуридан фойдаланган ҳолда фазовий муаммоларга ечим топиш. 



АМАЛИЙ ҚЎЛЛАНМА



Қўлланма 8 та амалий машғулотни ўз ичига олади. Амалий машғулотларни бажаришда ГАТ мавзулари асосида ArcGIS компьютер дастуридан фойдаланилади. Ҳар бир амалий машғулот секцияларга бўлинган бўлиб битта мавзунинг турли аспектларни муҳокама қилишга қаратилган. Ҳар бир секция кириш маълумотларидан, компьютер дастурлари қўлланмаларидан ва амалиётнинг назарий қисмини қанчалик тушунганлик тўғрисида бир нечта машқларни бажаришдан иборат. Амалиёт якунида ГАТ фойдаланиб, курс лойиҳасини бажара олишингиз мумкин. 



Шунингдек, ҳар бир амалий машғулот бўйича назарий билимлар ҳам маърузада бериб борилади. Бу қўлланма маъруза матни эмас, ГАТ тушунчаси тўғрисида ўқув қўлланмадан фойдаланиш ва Power Pointда бериладиган маърузадан олиш мумкин. Амалиёт машғулотларни маърузанинг давоми сифатида қараб, ArcGIS компьютер дастуридан фойдаланган ҳолда машқларни бажаришдан иборат. 

		



НАЗАРИЯ



Фаннинг назарий қисми учун қуйидаги маъруза 

матнидан фойдаланилади:



Introduction to Geofraphic Information Systems, 

K.T.Chang, 2006. 3rd edition, McGraw-Hill.



		[image: ]







Веб - сайт 



“Географик ахборот тизимлари” фани бўйича маълумотларни қуйидаги сайтлардан: 

http://www.geo-informatie.nl/courses/grs10306/ 

http://www.biometrica.tomsk.ru/ftp/dict/computer/dict_geo3.htm

http://www.garshin.ru/travel/_htm/my-terms/gis-glossary.htm

ёки фан бўйича тайёрланган мажмуа папкасидан олиш мумкин.



Мажмуа папкаси ушбу фаннинг маълумотларидан, Power Point презентацияларидан, амалий машғулот электрон вариантларидан, курс лойиҳа ва имтиҳон саволларидан ҳамда фанга тегишли бошқа маълумотлардан иборат. 



Амалий машғулот аудиториялари

[image: https://fbcdn-sphotos-h-a.akamaihd.net/hphotos-ak-prn2/v/t34.0-12/10327071_614516348622509_1957417001_n.jpg?oh=a27adfe64313518a9777fe5ebf1b5a11&oe=53739C9E&__gda__=1400082523_c9f9b8f750a677fce93e2ac2878055e7]Амалий машғулот аудиториялари институтнинг 11 корпус, 4 – қават ЭкоГИС марказининг 403 ёки 405 аудиторияларида ўтиш дарс жадвалига киритилган. 403 аудиторияда 6 та компьютер ва 405 аудиторияда 16 та компьютер жойлашган. Аудиторияларда амалий машғулотлари олиб борилаётган вақтда егулик олиб кириш ва компьютерлар ёнида истеъмол қилиш тақиқланади. 

[image: https://fbcdn-sphotos-h-a.akamaihd.net/hphotos-ak-xpa1/v/t35.0-12/10462387_630777660329711_7672819831809167572_o.jpg?oh=93e859db190637829e4a3693438adb56&oe=5399D66D&__gda__=1402589947_213923e2a0ead8ff5cf10c1f16fdfe92]ЭкоГИС марказида компьютер хоналари

ўнгда 403 аудитория

чапда 405 аудитория

Компьютердан фойдаланиш

Хонадаги барча компьютерлар Windows XP professional операцион тизимдан фойдаланилади. Компьютерларга ЭкоГИС маркази томонидан берилган логин паролидан фойдаланган ҳолда кириш мумкин. Вақтинчалик логин: 2011 пароль 001. Логин очиш учун ҳар бир магистрантдан паспорт нусхаси келтирилган тақдирдагина  амалга оширилиши мумкин. 

Амалий машғулот бошланишидан то якунига қадар ҳар бир магистрант биринчи танланган компьютердан фойдаланиш мумкин. Амалий машғулотлари ҳар бир магистрант томонидан индивидуал ҳолда бажарилади.



Принтердан чиқариш имкониятлари

Амалий машғулот якунида ҳар бир магистрант томонидан бажарилган модуллар A-4 форматда принтердан чиқарилиб амалиёт ўқитувчига топширилади. Магистрантларнинг ЭкоГИС маркази принтерларидан фойдаланиши мумкин эмас. 



Компьютер дастурлари 

Хонадаги компьютерларга аввалган D дискда жойлаштирилган ArcGIS компьютер дастуридан фойдаланиш мумкин. 



Маълумотни жойлаштириш 

Биринчи амалий машғулотни бажаришдан аввал D-дискда ҳар бир магистрантга тегишли фамилияси ва исми билан папка очилади. Папкада Word.doc да амалий машғулотдаги машқларнинг жавоблари ёзма шаклда ва расм кўринишида бажарилиб борилади. Расм кўринишда сақлаш учун клавиатурадан Alt ва PRTSC тугмачалари бир вақтда босилади ва Word.doc га сичқончанинг ўнг томонини босган ҳолда “Вставить” функцияси орқали кўчириб ўтказилади. Амалий машғулот материаллари D дискда қуйидаги тартибда жойлаштирилган. 

[image: ]







ArcGIS компьютер дастурини жойлашиши тизими

Папка тизимини ва номларини ўзгартириш мумкин эмас. 

“ArcMap documents”/АркМап ҳужжатлари папкасида барча ArcMap ҳужжатлари сақланади. Ҳар бир амалий машғулотни бажаришда бир ёки бир нечта хужжатлардан фойдаланилади. Маълумотлар тўплами “Data” папкасида жойлашган. “Workspace” папкасида машғулот давомида фойдаланилган маълумотлар тўплами сақланиб борилади. Оригинал маълумотлар тўпламини ўзгартириш мумкин эмас. 















































1 – АМАЛИЙ МАШҒУЛОТ
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КИРИШ 



Географик ахборот тизимлари (ГАТ) кенг тармоқли соҳа бўлиб, хариташунослик, масофадан зондлаш, ер тузиш, табиий ресурсларни бошқариш, фотограмметрия, география, шаҳарсозлик, самовий видео ҳамда маҳаллий қидирув тизимларида кенг фойдаланиб келинмоқда. 



ArcGIS дастури пакети дунёнинг ГАТ бўйича етакчи атроф муҳит тизимлари тадқиқот институти (ESRI) томонидан ишлаб чиқилган. ESRI “ГАТ маҳсулотлари дастур таъминотининг интеграллашган коллекцияси” сифатида дастур пакетини ифодалайди, унда фойдаланувчи ёки компания ГАТни тўлиқ амалга ошириши мумкин.



Амалий машғулот давомида ArcGIS дастурининг иккита маҳсулоти билан танишилади. Улар – ArcCatalog, ArcToolbox, дастурларидир. ArcGIS дастурлар пакети тўғрисида батафсил маълумотларни қуйидаги вебсайтдан олиш мумкин: www.esri.com. 



ArcCatalog



Барча фазовий маълумотларни йиғиш ва бошқариш учун ArcCatalog дастуридан фойдаланилади. Бу ўзида географик ахборотни харита ёки жадвал шаклида ўрганиш, топиш ва кўриб чиқиш жихозларини мужассамлаштиради. Киритилган фазовий маълумотларни алмаштириш, номлаш ёки ўчириб ташлаш мумкин, ҳамда уларни кўриш, яратиш ва метамаълумотларни тўғрилаш мумкин.



Огоҳлантириш: ҲЕЧ КАЧОН геомаълумотларни бошқаришда Windows Explorer дан фойдаланиш мумкин эмас, масалан геомаълумотни номлаш, алмаштириш ва ўчириш тақиқланади, унинг ўрнига ArcCatalog дан фойдаланиш мақсадга мувофиқ.



ArcToolbox



ArcToolbox дастури фазовий маълумотларни таҳлил қилиш ва геомаълумотларни қайта ишлаш учун ҳар томонлама жиҳозланган ГАТни таклиф этади. Баъзи геомаълумотларни қайта ишлашнинг умумий вазифалари қуйидагиларни ўзида акс эттиради:



· Маълумотларни ўзгартириш (векторни растр маълумотлар тўпламига ўзгартириш);

· Маълумотларни кераклигидан ортиқ қўйиш (маълумотлар тўпламини  бирлаштириш ёки туташтириш);

· Маълумотларни чиқариш (маълумотларни кесиб олиш ёки аниқ тавсифга эга маълумотларни танлаш);

· Яқин атрофда нима мавжудигини қидириш (маълумотларни буферлаш ёки бошқа объектлар ёнидаги нуқталарни излаш);

· Маълумотларни бошқариш (жадвалларни бирлаштириш, маълумотлар тўпламидан нусха олиш ёки янги маълумотлар тўпламини яратиш).



ArcToolbox ГАТнинг алоҳида дастури ҳисобланмайди. Бу икката ArcCatalog and ArcMap дастурлари билан бирлаштирилган. ArcToolbox га кириш учун шу икката дастурдан фойдаланилади.



Ушбу амалий машғулотда:



· ArcCatalogдан фойдаланиб метамаълумотларни ва маълумотлар тўпламини тадқиқ қилиш ўрганилади. 



ArcMap ҳужжати: Intro_АM.mxd 



































ARCCATALOG ДАСТУРИ БИЛАН ИШЛАШ



ArcCatalog қўлланилиш ойнаси



[image: ]ArcCatalog ойнаси (1- расм) турли хил компонентлар ишлатилган ҳолда яратилган: Каталог дарахти/Catalog tree (1), намойиш ойнаси /View window (2), меню панели/мenu bar (3), асбоблар панели/toolbars (4). 
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1-расм. ArcCatalog қўлланилиш ойнаси.



ArcCatalog дарахти / ArcCatalog tree (1)



Каталог дарахти Windows Explorer даги папкалар дарахти  каби ишлайди. У сақланган фазовий маълумотларни топиш мақсадида компьютердаги папкаларни кўриш мумкин. Шунингдек, агар маълумотлар манбаларига боғланилган бўлса компьютердаги  маълумотлардан ташқари ГАТ серверига ҳамда тармоқдаги маълумотлар базасига кириш имконини беради. Агар боғланилган бўлмаса, ArcCatalog маълумотлар базаси билан ёки ГАТ серверини қўшиш мумкин. 



Намойиш ойнаси / View window (2) 



Намойиш ойнаси ўзида  3 та кўриниш иловасини акс эттиради. Мундарижа/Contents иловаси, бунда  файл ва папкалардаги харита ва жадвалларнинг рўйхати кўринади. 

1 - расмда намойиш ойнасида D:\IGI\Morning\ArcGIS\Data папкасининг мундарижасини кўрсатган. Олдиндан кўриш/Preview иловасида йиғилган географик ва жадвал кўринишдаги маълумотларни ўрганишингиз мумкин. Йиғилган маълумотлар тўпламига кириш учун сиз Метамаълумот/Metadata иловасидан фойдаланишингиз мумкин.  



Меню панели/Menu bar (3)



Меню панели ArcCatalog ойнасининг тепа қисмида жойлашган бўлиб, ArcCatalog менюсини намойиш этади. Меню панелидан  вазифаларни танлаш учун сичқонча ёки клавиатурадан фойдаланиш мумкин. Баъзи тезкор клавишалар менюда кўрсатилган.  



Асбоблар панели/Toolbars (4)



Асбоблар панели ArcCatalog ойнасининг меню панелидан кейин паст қисмида жойлашган, турли хил тезкор бошқарувларга ҳамда асбобларга кириш имконини беради. ArcMap тугмаси [image: ]ва ArcToolbox [image: ] тугмалари орқали ишни бошлаш мумкин. Географик асбоблар панели (Geography toolbar) [image: ] тугмалари орқали осонликча намойиш ойнасида/view window йиғилган географик маълумотларни ўрганиш мумкин. Меню панелидан View иловаси орқали  асбоблар панелини/toolbars қўшиш мумкин.



Фазовий маълумотларга кириш ва ArcCatalog дастурини бошлаш



ҚЎЛЛАНМА: 



1. ArcCatalog дастурини ишга тушириш учун Пуск тугмасини босинг, Programs=> ArcGIS => ArcCatalog ни танланг.

2. ArcCatalog дастури очилганда, баннер йўқолади ва ArcCatalogнинг ойна кўриниши пайдо бўлади. 

3. Каталог дарахтидан /Catalog tree маълумотларни сақловчи D:\IGI\...*…\ArcGIS\Data (*morning or afternoon) папкани танланг. Ҳозир танланган маълумотлар намойиш ойнасида/view window кўрсатилган. Мундарижа/Contents иловасида танланганлигига ишонч ҳосил қилинг.



		

1.



Каталог дарахти/Catalog tree фазовий маълумотлардан ташкил топган папкани танланг. Намойиш ойнасидаги Мундарижа/Contents иловасини белгиланг.



1а. Бу папка неча хил турдаги файллардан иборат?

	

	

1b. Shapefile – бу вектор/vector маълумотлар тўплами учун ArcMapнинг сақлаш тури ҳисобланади. Каталоглар дарахти/Catalog tree ва Намойиш ойнаси/View window да ҳар бир маълумотлар тўпламининг номлари  қаршисида иконкаларни кўриш мумкин. Бу ерда 3 та ҳар хил шейпфайл/shapefile га мансуб иконкалар мавжуд. Бу иконкалар нимани билдиради?











Фазовий маълумотларни тадқиқот қилиш



Тармоқда ёки компьютерда жойлашган маълумотлар тўпламини ArcCatalog нинг олдиндан кўриш /preview  функцияси орқали маълумотларни текшириш мумкин. Фазовий маълумотлар харита ва жадвал кўринишидан иборат бўлади. ArcCatalog дастурида баъзи асбобларни/tools таҳлил қилиш ва жадвалларга /tables ўзгартиришлар киритиш мумкин. 



ҚЎЛЛАНМА:



1. Каталог дарахтидан/Catalog tree маълумотлар тўпламини/datasets танланг.

2. Намойиш ойнасида/view window олдиндан кўриш/Preview иловаси орқали маълумотлар тўпламини/datasets кўриш мумкин.

3. Намойиш ойнасининг/view window пастки қисмида матн менюси/dropdown menu пайдо бўлади. Танланган маълумотлар тўпламини/datasets текшириш учун Географик олдиндан кўриш/Geographic preview ёки Жадвални олдиндан кўриш/Table preview иловаларини танлаш мумкин.

4. Олдиндан кўриш/Preview ни иловасини босинг, кейин Географик олдиндан кўриш/Geography preview иловасига ўтинг. Намойиш ойнасидаги /View window чизилган харита ҳар бир вектор/vector маълумотлар тўпламида объектдан/feature, ҳар бир растр/rastr маълумотлар тўпламида катакчадан/cell ва ҳар бир TIN маълумотлар тўпламида учбурчакдан/triangle ташкил топган. Географик олдиндан кўриш/Geography preview иловасини кўраётганда Географик асбоблар панели/Geography toolbar фаол ҳолатда бўлади. Харитани тадқиқот қилиш учун Географик асбоблар панелидан/Geography toolbar фойдаланиш мумкин. 

5. ArcGISда қайдлар/records деб номланадиган қаторларни/rows, майдон/fields деб номланадиган устунларни/columns ва танланган жадвалда ҳар бир катакча учун атрибут қиймат/attribute values деб номланадиган матн менюсини кўриш учун Жадвални олдиндан кўриш/Table preview иловасини танланг. 

6. Сичқончанинг ўнг тугмасини босган ҳолда, устуннинг сарлавҳасини танлаб майдонни ўчириш/delete ёки майдоннинг қийматини тасвирлайдиган статистикани олиш, бир ёки бир нечта майдонларни/fields атрибут қийматлари/attribute values  орқали жадвалнинг қайдларини/records саралаш/sort мумкин. 

7. Жадвалга майдон қўшиш ёки жадвалга махсус қийматни жойлаштириш учун намойиш ойнасининг/view window пастки ўнг бурчакдаги Опция/Options тугмасидан фойдаланинг. 



Эслатма: ArcCatalog да жадвалнинг атрибут қийматларини ўзгартира олмайсиз.



		

2.



Каталог дархтидан/Catalog tree Мамлакат/‘Country’ маълумотлар тўпламини танланг. Намойиш ойнасида олдиндан кўриш/Preview иловасини кўрсатинг.  Ушбу маълумотлар тўпламидаги барча объектларни/features кўрсатувчи мамлакат харитаси пайдо бўлади. Олдиндан кўриш/Preview иловасида пастки менюдан жадвал кўринишини/Table view танланг.





2а. Жадвал нечта қайдлардан/records иборат ва нечта майдон/fields мавжуд?  





2b. Жадвалга опция/Options тугмасидан фойдаланган ҳолда майдонни/field қўшинг. Ойнанинг Name майдонига capital деб ном киритинг. Тур/Type майдонининг пастки матн менюсидан Матнни/Text танланг. Майдон узунлигини 20 га ўзгартиринг.





2c. Яқиндагина қўшган майдонни/field ўчиринг. 





2d. Ўсиш/ascending бўйича (майдон/field: provnaam) устунини сараланг. Норд-Брабанд/Noord-Brabant вилоятига нечта қайдлар/records тегишли? 





2e. Мамлакатнинг умумий майдони/total area қанча? Статистика/Statistics функциясидан фойдаланинг.





2f. Қайси вилоятда 219934.719 метр периметрга эга объект/feature ташкил топган? 

Ушбу объектнинг атрибут қиймати нимага тенг?





2g. ‘FID’ атрибути нимани билдиради? 















Фазовий маълумотлар тўпламида метамаълумотларни тадқиқот этиш



Агар мавжуд керакли бўлган ресурсларни кўриш учун қидириш, хариталар ва  маълумотларни бўлишишда метамаълумотлар жуда муҳим ҳисобланади.  Кутубхона  карточкаси каталогдаги китобларни ифодаланган каби метамаълумотлар  ГАТнинг маълумотлар тўпламини шундай тарзда тасвирлаб беради. Қидириладиган маълумотлар тўпламини топишда метамаълумотлар унинг сизга қанчалик зарур эканлигини ҳал этади. Бу қарорни қабул қилишда сиз бу маълумотларни канчалик аниқ ва айни вақтда эканлигини ҳамда бу ерда яна бошқа чекланишлар мавжудлигини ва уни кандай иштишни билишингиз керак. Метамаълумотлар шу саволларга жавоб бера олиши мумкин. 



ArcCatalog да ҳар қандай папкалар ва файл турлари Word ҳужжатлари каби ўз ичига олганидек метамаълумотларда мавжуд бўлиши мумкин. ArcCatalog билан бошқарилганда метамаълумотлар кўчирилиб ўтказилиши, жойи ўзгартирилиши, ўчирилиб ташланиши мумкин. 



ҚЎЛЛАНМА:



1. Каталог дарахтида/Catalog tree маълумотлар тўпламини танланг.

2. Намойиш ойнасидаги/View window метамаълумот/Metadata иловаси танланганда маълумотлар тўпламига тегишли метамаълумотлар кўринади. 

3. Метамаълумотлар ҳужжати учта иловадан ташкил топган: Тасвир/Description, Фазовий/Spatial вa Атрибутлар/Attributes. 

4. Сиз метамаълумотлар редактори/Metadata editor асбоблар панелини/toolbar фаол ҳолатида метамаълумотларни қўшиш ёки ўзгартириш киритишингиз мумкин.



[image: ]



Меню панелидаги/menu bar кўриниш/‘View’ тугмасини босинг ва кейин Toolbar => Metadata. Метамаълумотлар асбоб панели/Metadata toolbar экранда пайдо бўлади. 



5. [image: ]Метамаълумотлар редактор асбоб панелидаги/Metadata editor toolbar редактор метамаълумотлар/Edit Metadata тугмасини босинг.



6. Метамаълумотлар ҳужжатидаги маълумотлар еттита секцияга бўлинган (1), метамаълумотлар редакторининг тепа қисмида жойлашган. Редактордаги секция номини танлаганингизда бир қанча иловалар пайдо бўлади. Булар секциялар ичидаги турли хил гуруҳдаги метамаълумотлар элементларини намоён этади (2).





[image: ]2
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7.  Сиз кўпгина элементларни таъминловчи матн кўринишидаги ойналарда матн теришингиз, ўзгартириш киритишингиз мумкин



		

3.



Каталог дарахтидан/Catalog tree Мамлакат/‘Country’ маълумотлар тўпламини танланг. Намойиш ойнасини/view window метамаълумот/Metadata иловасига ўтказинг. Намойиш ойнасида/view window метамалумотлар ҳужжатига тегишли метамаълумотлар тўплами пайдо бўлади.





3а. Метамаълумотлар хужжатларининг ҳар бир учта иловалари ичида қандай маълумотлар сақланади?





3b. Бу маълумотлар тўпламининг атрибутларини ёзинг?





3c. Провнаам/ ‘Provnaam’ атрибутининг маълумот тури/data type нима?  









		

4.



Агар сиз ‘Country маълумотлар тўплами метамаълумотини кўрадиган бўлсангиз унда баъзи маълумотлар етишмаслигига эътибор берасиз. Етишмайдиган маълумотларни яратиш учун метамаълумотлар редакторидан фойдаланинг.





4a. Метамаълумотлар ҳужжатларида тасвир/Description иловасини танланг. Abstract  бу маълумотлар тўплами учун зарур ҳисобланади. 





4b. Метамаълумотлар редакторини/metadata editor очинг. Идентификация /Identification секциясини босинг ва General тугмасини танланг. Abstract матн ойнасига ўтинг ва қизил ранг билан белгиланган матн маълумотини ўчиринг. Энди сиз ‘Бу маълумотлар тўплами мамлакатнинг 12 та вилояти ҳақида маълумотларни етказиб беради.’/‘The dataset supplies information about the 12 provinces of the country’ деган матнни киритинг. Ўзгартирилган матнни сақланг. 





4с. ArcCatalog дастурини ёпинг. 









































































































1-амалий машғулотни бажаргандан кейин ўз-ўзини 

текшириш учун саволлар

































Cаволлар

1. ArcCatalog дастурида кандай амалларни бажариш мумкин? 

2. ArcToolbox дастури фазовий маълумотларни таҳлил қилиш ва геомаълумотларни қайта ишлаш учун ҳар томонлама жиҳозланган ГАТ таклиф этади. Геомаълумотларни қайта ишлашнинг умумий вазифаларини нимадан иборат? 

3. ArcGIS дастурлар пакетида ArcMap нинг вазифани ёритиб беринг? 

4. Амалий машғулотни 1 – модулини бажаришда қандай ҳужжатдан фойдаланилади ва ўрганилади? 

5. ArcCatalog қўлланилиш ойнаси қандай компонентлардан ташкил топган? 

[image: ]

6. ArcCatalog қўлланилиш ойнасидаги ArcCatalog дарахтини / ArcCatalog tree таърифлаб беринг. 

7. ArcCatalog қўлланилиш ойнасидаги Намойиш ойнасини/View window таърифлаб беринг.

8. ArcCatalog қўлланилиш ойнасидаги Меню панелини/Menu bar таърифлаб беринг.

9. ArcCatalog қўлланилиш ойнасидаги Асбоблар панелини/Toolbars таърифлаб беринг.

10. Геомаълумотларни бошқаришда нимадан фойдаланиш мумкин эмас, қандай вазифалар тақиқланади? ArcCatalog да жадвалнинг атрибут қийматларини ўзгартира оласизми? 

11.  Метамаълумотларнинг муҳимлиги нималардан иборат? 













































2 – АМАЛИЙ МАШҒУЛОТ



ARCMAP ДАСТУРИ БИЛАН ИШЛАШ
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КИРИШ 



Географик ахборот тизимлари (ГАТ) кенг тармоқли соҳа бўлиб, хариташунослик, масофадан зондлаш, ер тузиш, табиий ресурсларни бошқариш, фотограмметрия, география, шаҳарсозлик, самовий видео ҳамда маҳаллий кидирув тизимларида кенг фойдаланиб келинмоқда. 



ArcGIS дастури пакети дунёнинг ГАТ бўйича етакчи атроф мухит тизимлари тадқиқот институти (ESRI) томонидан ишлаб чиқилган. ESRI “ГАТ маҳсулотлари дастур таъминотининг интеграллашган коллекцияси” сифатида дастур пакетини ифодалайди, унда фойдаланувчи ёки компания ГАТни тўлиқ амалга ошириши мумкин.



Амалий машғулот давомида ArcGIS дастурининг битта маҳсулоти ArcMap дастури билан танишилади. ArcGIS дастурлар пакети тўғрисида батафсил маълумотларни қуйидаги вебсайтдан олиш мумкин: www.esri.com. 





ArcMap



ArcGIS дастурлар пакетида ArcMap ГАТ иш столининг маркази ҳисобланади. ArcMap  турли хил форматда сақланган геомаълумотларни визуал ҳолатга келтириш, тўғрилаш ва қайта ишлашда ёрдам беради. Амалий машғулот давомида shapefile (*.shp) форматидаги маълумотдан фойдаланилади. 



Ушбу амалий машғулотда:



· ArcMapдан фойдаланиб жадваллар, қатламлар ҳамда маълумотлар рамкаси билан ишлаш.

· Маълумотларни символлаштириш: тўғри харита турини танлаш ўрганилади.



ArcMap ҳужжати: Intro_АM.mxd 





















ARCMAP ДАСТУРИ БИЛАН ИШЛАШ 



ARCMAP қўлланилиш ойнаси



ArcMap қўлланилиш ойнаси турли хил компонентлардан фойдаланган ҳолда яратилган (2-расм): Мундарижа/Table of contents (1), Жиҳозлар қутичаси ArcToolbox (2), Намойиш ойнаси/View window (3), Меню панели/Menu bar (4) Асбоблар панели/Toolbars (5).  
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[image: ]2 – расм. ArcMapнинг қўлланилиш ойнаси



Мундарижа/Table of contents 



ArcMap бўлимида мундарижа/table of contents рўйхати маълумотлар тўпламини намойиш этади. Бу ҳар хил географик маълумотлар тўплами ташкил этилган турли маълумот рамкаси/Data Frames шаклида (Wag_south1, 3 – расм) намойиш этилган. ArcMap фаол ҳолатдагина фақат битта маълумот рамкасини /data frame кўрсата олиши мумкин. Фаол ҳолатдаги data frame қора ҳарфларда тасвирланган (Wag_south1, 2-расм). 3 – расм. Мундарижанинг деталлари. “Land use” “Wag_south1” маълумот рамкасининг қисми ҳисобланади.





Маълумотлар рамкаси хусусияти сиз ишлаётган маълумотлар контекстини аниклайди: улар координаталар тизимини/coordinate system, ўлчов бирликларини/measurement units, масштабни /scale, маълумотлар тўплами суратларнинг кетма-кетлигини/drawing order of datasets ва ҳоказоларни ўз ичига олади. ArcMapда географик маълумотларни бир – бирига боғлиқлигини маълумотлар тўплами/Data frames ва мундарижа/table of contents кўрсатади. 



ArcMap бўлимининг маълумот рамкаси/data frames ва маълумотлар тўплами/datasets ArcMap document (*.mxd) деб номланган ҳужжат шаклида битта файлда қулай сақланган бўлиши мумкин.



Жиҳозлар қутичаси/ArcToolbox (2)

[image: ]

[image: ]ArcToolboxни ArcMapнинг марказий кучи сифатида кўриш мумкин, чунки ArcToolbox янги географик маълумотлар тўпламини яратиш учун, географик ўзгартиришлар учун, ҳисоб қилиш ва фазовий таҳлил қилиш учун яъни сизнинг геомаълумотларингизни қайта ишлаш/geoprocessing учун барча асбобларни ўзида мужассамлаштирган. Жиҳозлар қутичасини /ArcToolbox  белгиси орқали очиш ва ёпиш мумкин. 



ArcToolbox ойнаси очилганда (4-расм), мавжуд жиҳозлар рўйхати ойнада намоён бўлади (1). Ҳар бир жиҳозлар қутичасида асбоблар тўплами/toolsets (2) мавжуд бўлиб, у геомаълумотларни қайта ишлаш асбобларини / geoprocessing tools ўз ичига олади (3). Агар сиз асбобни танласангиз, кўлланилишда осон бўладиган диалоглар ойнаси/dialog box очилади. 4- расм. ArcToolbox дарахт тизими





Намойиш ойнаси/View window (3)



Намойиш ойнасида сиз тадқиқот қила оладиган, сўров орқали оладиган ва таҳлил қила оладиган интерактив хариталар чизилган. ArcMap намойиш ойнаси мундарижа/table of contents билан боғланган бўлиб, осон тушунтириш ва назорат қилиш учун қулай ҳисобланади. 



Меню панели/Menu bar (4)



Бу панель ArcMapнинг юқори қисмида жойлашган бўлиб, ArcMap менюсини ўзида мужассам этган. Менюдан вазифани танлаб олиш учун сиз сичқонча ёки клавиатурадан фойдаланишингиз мумкин. Менюда тезкор клавиша кўрсатилган.



Асбоблар панели/Toolbars (5)



Асбоблар панели турли хил жиҳозлар/tools ва бошқарувларга тезкор кириладиган тугмаларга эга бўлиб, ArcMap ойнасининг қуйи қисмида жойлашган. Бошқа жиҳозни танламагунча ажратилган ҳолда қолади. Меню панелининг/menu bar View пастки меню иловаси орқали асбоблар панелини/toolbars қўшиш мумкин.  



ArcMap ҳужжатларини очиш ва дастур билан ишлашни бошлаш



ArcMap ҳужжати/ArcMap document файл ҳисобланиб ArcMapда бажарилган ишни ўзида сақлайди. Ушбу ҳужжат ArcMap иловасидаги барча маълумотлар тўплами/datasets, жадваллар/tables, қатламлар/layouts ва scripts/сценарийдан ташкил топган ёки боғланган. Бу билан сизнинг ишингиз қулай жойда сақланган бўлади. ArcMap ҳужжатлари ‘.mxd’ кенгайтмасига эга ва бу ESRI ArcMap document да таъриф берилган. 



ҚЎЛЛАНМА: 



1. ArcMapни ишга туширинг. Пуск тугмасини босинг Programms => ArcGIS => ArcMap ни танланг. 

2. ArcMapнинг ойнасида: ArcMap билан фойдаланишни бошлаш/Start using ArcMap with деб ёзилган ойна кўринади. Бу ерда Мавжуд харита/An existing map тугмасини танланг. Кейин Хариталар учун қараб чиқиш/Browse for maps тугмаси танланг сўнгра OK ни босинг. ArcMapнинг қўлланиш ойнасида очилган баннер йўқолади. 

3. Сиз фойдаланмоқчи бўлган ҳужжат файлини танланг.

4. ArcMapни ёпганингизда ёки янги ҳужжат очганингизда, яратилган ArcMap хужжатингизни сақлашни/save унутманг. ArcMapда ишни тўхтатиш учун файл менюси/File Menuдан чиқиш/Exit тугмасини танланг.



		

1.



1a. ArcMap ни ишга туширинг. “An existing map” ни босинг, кейин “Browse for maps” ни танланг. Сўнгра OK ни босинг ва D:\IGI\...*…\ArcGIS\ArcMap documents ни  қараб чиқинг. ‘Intro_AM.mxd’ деб номланган файлни очинг.











Огоҳлантириш: ArcMap ҳужжати/ArcMap document мундарижа/table of contents таркибида фазовий маълумотлар тўпламини ўзида сақламайди. Бу ArcMap ҳужжати таркибида жойлашган маълумотлар тўплами манбаларини/references сақлайди (бу манба мисол бўлиши мумкин: D:\IGI\ArcGIS\Data\Landuse.shp). Ҳужжатни очаётган вақтда ArcMap маълумотлар тўпламини ушбу манга асосланиб компьютердаги қаттиқ дискдан қидиради. Агар топа олмаса, масалан сиз маълумотни ArcCatalogдан бошқа жойга кўчирган, бошқача номлаган ёки ўчириб ташлаган бўлсангиз, намойиш ойнасида/view window маълумотлар тўплами тасвирланмайди: бу бузилган манба/broken link ҳисобланади. 

Сиз бунга тезда аниқлик киритишингиз мумкин, чунки мундарижада бузилган манба номи қизил рангда ундов белгиси (!) орқали кўрсатилган бўлади ва қатлам очилмайди. 
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Агар маълумотлар вақтинча очилмаса, сиз бузилган манбага эътибор берманг ва ArcMap ҳужжатидан маълумотлар тўпламисиз мундарижани кўрсатинг. Маълумотлар тўплами хаританинг бир қисми бўлиб, улар мундарижа/table of contents таркибида рўйхатда бўлади: содда равишда намойиш қилинмайди. Ҳар қандай ҳолатда бузилган манба осонликча қайта тикланиши мумкин.



ҚЎЛЛАНМА: 



1. Мундарижада/table of contents бузилган манба билан қатламни топинг. 

2. Қатламга сичқончанинг ўнг тугмасидан фойдаланиб Data =>Set Data Source ни танланг. 

3. Қидирилаётган маълумотлар тўпламини топинг ва қўшиш/Add тугмасини босинг. 

4. OK тугмасини босинг.

5. ArcMap маълумотлар тўпламидаги манбани қайта тиклайди. 



		

2.



2а. ‘Soil_types’ маълумотлар тўпламининг бузилган манбаси қайта тикланг.  Қидирилаётган манба D:\IGI\...*…\ArcGIS\Data папкасида “Soil_types.shp” деб номланган. 











Маълумот рамкалари/data frames, маълумотлар тўплами(қатламлар) datasets(layers) ва жадваллар/tables билан ишлаш



Намойиш ойнасида/view window географик маълумотлар тўплами ўзига хос тарзда кўрсатилган. Ҳар бир маълумотлар тўплами ердан фойдаланиш қисмлари ёки йўллар каби географик объектларнинг тўплами ҳисобланади. 

Маълумотлар тўплами кўпинча ArcMapда қатламлар/layers сифатида назарда тутилади. Қатламлар бу контекстда фазовий маълумотлар тўпламининг тасаввур қилиб тақдим этиш/visual representations ифодасидир. Шунга қарамасдан, қатламлар фазовий маълумотлар тўпламига кириши шарт эмас. Бу амалий қўлланмада ‘layer’ ESRI термини қатлам файллари назарда тутилгандагини фойдаланилади (Қатлам файллари билан ишлаш ‘Working with layer files’ бўлимига қаранг). Бошқа ҳолда ‘datasets’ умумий термин сақланган рақамли фазовий маълумотлар учун ишлатилади. 



Барча маълумотлар тўплами ArcMap ҳужжатининг мундарижасида/table of contents  бир ёки бир неча маълумотлар рамкаси/data frames сифатида кўрсатиб ўтилган. Шунингдек, мундарижа/table of contents ҳар бир маълумот тўпламининг объектларини намойиш этишда белгилар ва рангларни/symbols and colors ҳам кўрсатади.  



Маълумот рамкаларини актив ҳолатга келтириш, маълумотлар тўпламини/datasets  ёқилган/on ва ўчирилган/off кўринишга келтириш



Мундарижадаги маълумотлар тўпламининг кетма-кетлигини аниқлаш маълумотларнинг юқоридан пастга қаралган тартибда кетма-кетликда намойиш этиш билан аниқланади. Мундарижанинг пастки қисмида масалан, хаританинг фонини (орқа кисмини) ҳосил килиш учун маълумотлар тўпламини киритиш керак бўлади. Намойиш ойнасида/view window маълумотлар тўплами кўриниши учун маълумот рамкасидаги/data frames  маълумотлар тўплами/datasets актив ҳолатда бўлишлигига эътибор беринг. Актив ҳолатдаги маълумот рамкаси/data frame қора ҳарфларда берилган (2-расм). 



ҚЎЛЛАНМА:



1. Маълумотлар рамкасини/data frames актив ҳолатга келтириш/avtivate учун актив ҳолга келтирмоқчи бўлган маълумот рамкасининг ўнг тугмасини/right-click the data frame босинг ва контекст менюда пайдо бўлган актив ҳолатга келтириш/Activate тугмасини танланг.

2. Маълумотлар тўплами ёқилган/on ёки ўчирилган/off ҳолатга келтириш текшириш катакчасини/check box танлаш орқали бажариш мумкин.

3. Маълумотлар рамкасини/data frame қўшиш/add учун меню панелидаги/menu bar Insert => Data Frame тугмаларини танланг.

4. Сиз қўшилган маълумотлар рамкасини/data frame қайта номлашингиз/rename мумкин. Маълумотлар рамкасининг/data frame сичқонча ёрдамида ўнг тугмасини босиб контекстдан хоссалар/Properties ни танланг. Маълумотлар рамкаси хоссаси/Data Frame Properties ойнаси пайдо бўлади. General иловасини танланг ва маълумотлар рамкасининг Name матн ойнасида ном киритинг.



		

3.



‘Intro_AM.mxd’ ArcMap ҳужжатининг/ArcMap documents Мундарижаси/table of contents бир неча маълумотлар рамкаси ва маълумотлар тўпламидан ташкил топган. 



3а. ‘Intro_AM.mxd’ ҳужжати нечта маълумотлар рамкасидан ташкил топган? 





3b. ‘Wag_south1’ маълумотлар рамкаси нечта маълумотлар тўпламидан ташкил топган? 





3c. Маълумотлар рамкасидаги/data frame маълумотлар тўпламини/datasets ёқилган/оn ва ўчирилган/off ҳолатга келтиринг. 





3d. ‘LU_raster’ маълумот тўплами кўриниши учун ‘Wag_south2’ маълумот рамкасини актив ҳолатга келтиринг. 





3e. Янги маълумотлар рамкасини киритинг. Киритилган маълумот рамкаси актив ҳолатда бўлади. Маълумот рамкасини ‘Soil and Land use’ деб номланг.













Маълумотлар тўпламларини қўшиш



ҚЎЛЛАНМА:



1. Маълумотни қўшишни/add хохлаган маълумот рамкасини/data frame актив ҳолатга/Activate келтиринг. 
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2. Маълумотни қўшиш/Add Data  тугмасини танланг, сақланган маълумотлар тўпламини қаерда жойлашганлигини/directory кўрсатинг.

3. Маълумот рамкасига қўшишни хохлаган маълумот тўпламини танланг. 

4. OK тугмасини босинг. Актив ҳолатдаги маълумот рамкасининг мундарижасини/table of contents юқори/top қисмида янги қатлам пайдо бўлади. ArcMap бу маълумотлар тўплами учун default ранг танланган. 

5. Қатламни сичқончадан фойдаланган ҳолда ўнг тугмасини босган ҳолда ўчириб ташлаш мумкин. Контекс менюсидан ўчириш/Remove  тугмасини танланг. 



		

4.



‘Soil and Land use’ маълумот рамкасини актив ҳолатга келтиринг. 





4а. ‘Soil and Land use’ маълумот рамкасига D:\IGI\...*…\ArcGIS\Data (*morning or afternoon) сақланган ‘Landuse.shp’ номланган шейпфайлни қўшинг.











Қатлам файллари билан ишлаш



Сиз маълумотлар тўпламини қатлам файли /layer files кўринишида сақлашингиз мумкин. Катлам файллари фазовий маълумотлар тўпламини ўзида сақламайди, улар фақатгина бошка жойда сақланаётган растр ва шейпфайллардан ташкил топган фазовий маълумотларгагина манба бўлади. Бу шуни англатадики, сиз шейпфайлни номлашда ёки уни ўчириб ташлаганингизда, у билан боғлиқ қатлам файллар бошқа кўринмаслиги мумкин, чунки сақланган алоқа шейпфайл билан узилган бўлади.



Қатламлар белгиларни/symbology намойиш этади ва номланишни/labeling сақлайди. Улар намойиш ойнасида/view window фазовий маълумотларни қандай ҳолда кўрсатилганлигини аниқлайди. Масалан, қатлам шейпфайлдан аниқ шаҳарларни танлаши мумкин, уларни кўк тўртбурчак шаклида кўрсатиши ва унга боғлиқ жадвалда сақланган матн билан номланиши мумкин. Қатламлар фазовий маълумотлар тўплами эмас!!



ҚЎЛЛАНМА: 



1. Сичқончанинг ўнг тугмасидан фойдаланган ҳолда мундарижада/table of contents маълумотлар тўпламини қатлам файли кўринишида сақланг. Контекст менюдан Save as Layer File тугмасини танланг. Қатлам файллари ‘.lyr’ кенгайтмасига эга.



		

5.



5а. ‘Wag_south1’ маълумот рамкасини актив ҳолатга келтиринг. Маълумот рамкасига ‘Landuse.shp’ маълумот тўпламини ва ‘Landuse.lyr’ қатламини қўшинг.





‘Landuse.shp’ маълумотлар тўпламининг ердан фойдаланиш объектлари оддий рангда/single color намоён бўлишини кўришингиз мумкин. ‘Landuse.lyr’ қатлам файли ердан фойдаланиш турларини намойиш этишда мос белгилардан/appropriate symbology ташкил топган.  





5b. Ердан фойдаланиш қатлам файлининг ‘Layer properties’ ойнасини очинг. Source иловасини босинг. Бу қатлам файлнинг маълумот манбаси қандай?











Мундарижада/table of contents маълумотларни тартибда сақлаш учун бир-бирига боғлиқ бўлган маълумотлар тўпламини битта маълумот рамкасида гуруҳланган қатлам/group layer сифатида тартибга солишингиз мумкин. Масалан, сизда иккита малумотлар тўплами маълумотлар рамкасида мавжуд, бири ‘railroads’, иккинчиси ‘highways’ ни намойиш қилади. Бу маълумотларни гуруҳлаш ва ‘transportation network’ деб номлаш мумкин. 



ArcMap ҳужжатларини/ArcMap documents ёки бошқа маълумотлар рамкасига қўшиш, гуруҳланган маълумотлар тўпламини қайта номлаш ва қатлам файл/layer file сифатида сақлаш мумкин. 



ҚЎЛЛАНМА: 



1. Гуруҳ қатламини ҳосил қилишнинг икки йўли мавжуд:



· CTRL тугмасини босган ҳолда гуруҳламоқчи бўлган қатламларни танланг. Қатлам танланганда унинг ёнида кўк рангда ойна ҳосил бўлади. Танланган қатламда сичқончанинг ўнг тугмасини босинг, пайдо бўлган контекст менюдан Group ни танланг. Танланган қатламларда янги гуруҳ қатлами мундарижада/table of content  пайдо бўлади.



· Шунингдек, сиз маълумотлар рамкасида сичқончанинг ўнг тугмаси орқали гуруҳ қатламини яратишингиз мумкин. Янги гуруҳ қатламини/New Group Layer танланг. Янги гуруҳ қатлами мундарижада пайдо бўлади. Энди сиз гуруҳга қатлам қўшишингиз мумкин. Агар сиз қўшмоқчи бўлган қатлам мундарижада/table of content мавжуд бўлса, у ҳолда уни гуруҳ қатламига судраб олиш ва ташлаш (ўтказиш)/drag and drop мумкин.



2. [image: C:\Users\GD\Desktop\Новая папка\20140508_114730.jpg]Гуруҳ қатламини қатлам файли /layer file кўринишида сақлаш учун, сичқончанинг ўнг тугмасини босиб контекст менюдан Save as Layer File ни танланг. Қатлам файли '.lyr' кенгайтмасига эга ва бу кўринишга эга.

3. Сиз гуруҳ қатламини номини қайта номлашингиз мумкин. Гуруҳланган қатламни ўнг тугмасини босиб (сичқонча ёрдамида) хоссаларни/Properties танланг. Қатлам хоссалари /Layer Properties  ойнаси очилади. General иловасини танланг, гуруҳ қатламига ном бериш учун Name матн ойнасидан фойдаланинг. Мундарижада/table of contents фақатгина  ном ўзгаришига сақланган қатлам номи эса ўзгармаслигига эътибор беринг. 

4. Қатламни гуруҳдан чиқариш учун қатламда сичқончанинг ўнг тугмасини босиб пайдо бўлган контекст менюдан гуруҳдан чиқариш/ungroup ни танланг. 



		

6.



6а. ‘Wag_south1’ мaълумот рамкасини актив ҳолатга келтиринг. ‘Soil_points’ ва ‘Soil_types’ қатламларини  гуруҳланг/group. Гуруҳга ‘Soil Data’ деб беринг ва гуруҳни қатламини қатлам файли сифатида workspace directory да сақланг/save. Қатлам файлига Soil data деб ном беринг. 





6b.‘Wag_south1’ мaълумот рамкасида бошқа гуруҳ қатламини ташкил этинг. New Group Layer функциясидан фойдаланинг ва қатламни ‘Infrastructure’ деб номланг.





6с. Инфратизимга боғлиқ бўлган маълумотлар тўплами тузиш учун янгидан гуруҳ ташкил этилди. Бу ҳолатда ‘Roads’ and ‘Trails’ маълумотлар тўплами ҳисобланади. Бу маълумотлар тўплами маълумот рамкасида мавжуд, уни “Infrastructure” гуруҳ қатламига ўтказинг. Гуруҳ қатламини workspace да гуруҳ қатлами сифатида сақланг/save. Қатлам файлига ‘Infrastructure’ деб ном беринг. 





6d. 'Soil data' қатлам гуруҳини мундарижанинг/table of contents тепа қисмига ўтказинг.



6e. “Soil data” ва “Infrastructure” гуруҳ қатламларини гуруҳдан чиқаринг/ungroup.





6f. ‘Soils and Land use’ маълумот рамкасини актив ҳолатга/activate келтиринг ва ‘Soil data’ қатлам файлини қўшинг.





6g. Сизнинг ArcMap ҳужжатингиздан ‘Soils and Land use’ маълумот рамкасини ўчиринг.











Тасвирни кичайтириш (zoom out) ва катталаштириш (zoom in) 



ҚЎЛЛАНМА:



1. Ускуналар панелидаги Tools дан катталаштириш/Zoom in [image: ]ёки кичиклаштириш/Zoom out [image: ]тугмаларни босинг.

2. Тасвир атрофини сичқонча билан белгилаб бир маротаба босинг. Сиз кўрмоқчи бўлган жойни тўртбурчак шаклда уни тортинг, сиз тасвир масштабини ўзгартирасиз. Сиз тўртбурчак билан танлаган жойингиз аниқроқ кўринади.

3. Агар сиз хато қилган бўлсангиз Zoom to Previous Extent [image: ]тугмасини босинг ва олдинги масштабга қайтасиз. 

4. Маълумот рамкасидаги қатламларни фазовий кенликда тўлиқ ҳолда кўриш учун Zoom To Full Extent  [image: ]тугмасини босинг.

5. Агар сиз маълумотлар босқичма – бочқич кўрмоқчи бўлсангиз Fixed Zoom in [image: ]ёки Fixed Zoom out [image: ]тугмаларидан фойдаланинг. 

6. Понарама шаклида кўрмоқчи бўлсангиз маълумот тўплами атрофида [image: ] тугмасини танланг. 



		

7.



7а. ‘Landuse’ маълумотлар тўпламининг юқори чап бурчагидаги сув ҳавзаси маштабининг катталаштиринг ва тўлиқ кенгайтириш/full extension  масштабига қайтинг.











Маълумотларнинг атрибут жадвали/attribute table кўриниши



ГАТда географик ходисаларнинг тавсифларини атрибутлар намоён этади. Масалан, дарёнинг атрибутларига – унинг номи, узунлиги ва ўртача чуқурлигини киритиш мумкин. Улар одатда жадвалларда сақлаб қўйилган бўлиб, улар ноёб идентификатор орқали маълумотлар тўпламининг фазовий объектларига боғланган ҳолда бўлади.  

Атрибут жадвал шундай тузилганки, ҳар бир сатр ҚАЙД/RECORD, устун ва объектларни намоён этувчилар МАЙДОН/FIELD деб номланади ва бу битта атрибутни кўрсатади. 





ҚЎЛЛАНМА: 



1. Маълумотлар тўпламини ўнг тугмасини орқали танланг.

2. Атрибут жадвалини очиш учун Open Attribute Table тугмасини босинг.

3. Маълум бир объектнинг қийматларига тезкор равишда киришни амалга ошириш учун ускуналар панелида Tools да Identify [image: ] тугмасини танланг ва сиз текширмоқчи бўлган атрибутларни намойиш ойнасидаги/view window объектга босинг. 

4.  Identify Results ойнасида объектларни атрибут қийматлари намоён бўлади.



		

8.

‘Wag_south1’ маълумотлар рамкаси актив ҳолатга келтиринг. 



8a. ‘Roads’ маълумотлар тўпламининг атрибут жадвалини очинг.

1. Бу жадвал қандай объект туридан/feature type ташкил топган?

2. Бу жадвал нечта атрибутларни/attributes ўз ичига олади? Бу жадвалнинг атрибутларни ёзинг. 

3. Бу жадвал нечта қайдлардан/records ташкил топган?



8b. ‘Soil_points’ маълумотлар тўпламининг атрибут жадвалини очинг.

1. Бу жадвал қандай объект туридан/feature type ташкил топган?

2. Бу жадвал нечта атрибутларни/attributes ўз ичига олади? Бу жадвалнинг атрибутларни ёзинг. 

3. Бу жадвал нечта қайдлардан/records ташкил топган?



8c. ‘Soil_types’ маълумотлар тўпламининг атрибут жадвалини очинг.

1. Бу жадвал қандай объект туридан/feature type ташкил топган?

2. Бу жадвал нечта атрибутларни/attributes ўз ичига олади? Бу жадвалнинг атрибутларни ёзинг. 

3. Бу жадвал нечта қайдлардан/records ташкил топган?











		

9. 

'Wag_south2' маълумотлар рамкасини актив ҳолатга келтиринг. 'LUraster' маълумотлар тўпламининг атрибут жадвалини очинг.



9a. Бу жадвал нечта атрибутлардан ташкил топган?





9b. Бу жадвал нечта қайдлардан ташкил топган?



9с. Қиймат/Value  ва сон/Count сўзларининг мазмуни нимадан иборат?





9d. Битта растр катакчасининг ўлчами нимага тенг? (Маълумот тўпламида сичқончанинг ўнг тугмасидан фойдаланиб, Properties ни танланг ва Source иловасини босинг). 











Фазовий маълумотларни белгилаш



Фазовий маълумотларни белгилашда фазовий объектларни намойиш этиш учун белгилар/symbols ва рангларни/colors танлашни ўз ичига олади. Мундарижада/table of contents маълумотлар тўпламининг легенда белги(лар)/legend symbol(s) тугмасини танглаш орқали объектларнинг асосий ранглари ва безакларини/basic colors and patterns ўзгартириш мумкин. Лекин харита турини/map type ўзгартириш учун symbology editor тугмасидан фойдаланиш мумкин.



Бу бўлимда Symbology (5-расм) редакторининг асосий вариантлари намойиш этилади. Бу вектор маълумотлар тўплами учун тавсифланишига этибор беринг. Кўз билан кузатиш учун растр маълумотлар тўплами чекланган вариантларга эга. 



Харитада объектларни намойиш этишнинг турли хил йўллари мавжуд. Хаританинг турини/map type танлаш фазовий маълумотларга боғлиқ бўлиб (масалан, категория, синф, микдорий) харитангизда нимани намойиш этмоқчилигингиз танланади.



Харитада маълумотлар тўпламининг объектларини кўрсатиш учун бир неча йўллар мавжуд. Харита турини/map type танлаш фазовий маълумотларнинг турларига (масалан, қатъий/categorical, синфий/classes, миқдорий/quantitative) ва харита орқали сиз фойдаланувчига нимани кўрсатишни хохлаётганингизга боғлиқ. Белгилар редакторининг/Symbology editor кўрсатиш/Show иловасида харита турларини таърифлашингиз мумкин (5-расм, 1-ойна). Энг муҳим бўлганлари қуйидагилар: 



Объектлар/Features



=>Битта белги/Single symbol 		Барча объектлар бир хил бўлган рангда ва белгида кўрсатилади. Бу маълумот объектларининг қаерда жойлашганлигини кўрсатиш учунгина керак бўлади. 

Категориялар/Categories 



=>Ноёб қиймат/Unique value		Маълумотлар тўпламлари атрибутларининг ҳар бири ноёб қиймати (синфи) турли хил ранг ва белгилар билан кўрсатилади. Категорияли маълумотларни курсатиш  учун бу энг самарали усул ҳисобланади. Масалан, ердан фойдаланиш харитасида ҳар бир ноёб тур аниқ бир рангда берилган бўлади.





Миқдорлар/Quantities 



=>Graduated color 		Aтрибут қийматларга асосланган ҳолда объектларнинг ранги ўзгаради (масалан, оч қизилдан тўқ қизилга). Бу харитани микдорлар ёки гуруҳларга бўлганда маълумотларни кўрсатиш учун қулай ҳисобланади. 



=>Graduated symbol	Объектларни намойиш этишда белгиларнинг ўлчами аниқ атрибутларнинг қийматларига асосланган ҳолда ўзгаради. Бу харита тури - ўлчам ва катталигини акс эттиришда маълумотларни белгилашнинг энг яхши йўли ҳисобланади. Бу белги/Graduated symbol фақат нуқта ва чизиқ маълумотлари учун қулай  ҳисобланади.   
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5 – расм. Белгилар редактори/Symbology editor; маълумотларингизни ўзгартириш мумкин бўлган йўлларни кўрсатади. 



Қачонки харита турларининг бири танланганда (уни босиш йўли орқали), ҳар хил турдаги вариантлардан фойдаланиш мумкин бўлади. 



Битта белги/Single symbol



Single symbol харида турида маълумотлар тўпламида ташкил топган барча объектлар битта ранг ва безакда белгиланади.



Ноёб қийматлар/Unique values 



Харитангизда истаган атрибутни кўрсатиш учун Value Field дан пастга қараган стрелкани босинг (5-расм, 2-ойна).  Symbology editor нинг марказий қисми (4-ойна) тўртта устундан ташкил топган: белги/Symbol, қиймат/Value, этикетка/Label ва сон/Count.



· Рангни ўзгартириш учун белги/Symbol майдонидаги рангли тўртбурчакни босинг. Ёки рангли шкала/color ramp танлаш орқали  олдиндан белгиланган ранглардан фойдаланинг (3-ойна). 



· Қиймат/Value қандай атрибут қиймати ранг ва белги орқали намойиш этилишини кўрсатади. 

· Этикетка/Label устунида белги орқали намойиш этиладиган объектлар учун тавсифни теришингиз мумкин, бу мундарижада/table of contents белги ёнида легендани тушунарли бўлишини белгилайди. 

· Сон/Count ҳар бир белги синфи ичидаги катакчаларни ёки объектларни сонини беради.



Graduated colors & Graduated symbols



Сиз кўрсатмоқчи бўлган атрибутни танлаш учун Қиймат/Value тугмасини танланг. Синфлаш/Classification майдонида сиз синфлар сонини, синфлар ўзгаришини ва синфлар қаторини аниқлашингиз мумкин. Харитадаги объектларга Graduated color бераётганда аввалдан аниқланган ранглар шкаласидан фойдаланиш мумкин. Graduated symbol дан фойдаланишни истасангиз Template тугмасини босиб белги турини танлашингиз мумкин.



Кўрсатилиши керак булган аттрибутни танлагач, сиз белги ўлчамини мослаштириб олишингиз мумкин. Символ редакторининг марказий қисми ўзида уч устунни мужассамлаштирган: Symbology editor нинг марказий қисми учта устундан ташкил топган: белги/Symbol, қатор/Range, этикетка/Label. Қатор/Range белги синфидаги атрибут кийматининг қаторини билдиради. 



ҚЎЛЛАНМА (‘Unique Values’ харита тури учун мисол): 



1. Сиз белгиларни/symbology ўзгартирмоқчи бўлган маълумотлар тўпламига икки маротаба босинг. 

2. Symbology иловасини танланг, Show майдонида Categories тугмасини босинг ва Unique values ни танланг.

3. Value Field ойнасида пастка қараган стрелкани босинг; харитада кўрсатмоқчи бўлган атрибутни/atttibute танланг.

4. Add all values тугмасини танланг ва <all other values> текшириш ойнасидаги амални бекор қилинг. 

5. Агар сиз этикеткаларни ўзгартиришни/change the labels истасангиз мундарижада/table of contents белгилар ёнида пайдо бўладиган этикетка ойнасига/Label field матн теришингиз мумкин. 

6. Сиз аввалдан белгиланган ранг шкаласини/pre-defined color ramp танлашингиз мумкин, ёки Symbol field да ҳар бир атрибут қиймати учун рангни танлашда икки маротаба рангли тўртбурчак ойнасини босиш орқали амалга ошириш мумкин.

7. Янги легендадан/legend фойдаланган ҳолда, харитани қайта чизиш учун қўллаш/apply тугмасини босинг.



		

10.



'Wag_southl' маълумотлар рамкасини актив ҳолатга келтиринг. 'Soil_types' маълумотлар тўпламининг қатлам хоссаси/Layer Properties ойнасини очинг ва Symbology иловасини танланг. 



10а. ‘Soil_types’ маълумотлар тўпламини кўрсатиш учун қайси харита туридан фойдаланилган?





10b. ‘Soilname’ атрибутини кўрсатинг. Қайси харита турини танлагансиз? Жавобингизни таърифлаб беринг.





10с. ‘Soil_points’ маълумотлар тўпламининг ‘pH’ атрибутини кўрсатинг.





10d. Қайси харита турини танлагансиз. Жавобингизни таърифлаб беринг. 





10е. Ўрганиш майдонининг қайси қисмида энг юқори pH қиймати мавжуд?







		

11.



“Roads” маълумотлар тўпламининг қатлам хоссаси/Layer properties ойнасини очинг.





11a. ‘Straatnaam’ кўча номи/street name атрибутига асосланган ҳар бир йўлга/road ранг беринг.





11b. Бу маълумот тўплами нечта турли хил кўчалар номидан ташкил топган?





11с.‘Roads’ маълумотлар тўпламининг атрибут жадвалини очинг. Бу жадвал нечта  йўл объектларидан/road features ташкил топган?





































2-амалий машғулотни бажаргандан кейин ўз-ўзини 

текшириш учун саволлар

























Саволлар



1. ARCMAP қўлланилиш ойнаси қандай компонентлардан ташкил топган? 



[image: ]

2. ArcMap қўлланилиш ойнасида Мундарижани/Table of contents таърифлаб беринг.

3. ArcMap қўлланилиш ойнасида Жиҳозлар қутичасини/ArcToolbox таърифлаб беринг.

4. ArcMap қўлланилиш ойнасида Намойиш ойнасини/View window таърифлаб беринг.

5. ArcMap қўлланилиш ойнасида Меню панелини/Menu bar таърифлаб беринг.

6. ArcMap қўлланилиш ойнасида Асбоблар панели/Toolbars таърифлаб беринг.

7. ArcMap ҳужжатини/ArcMap document нималардан ташкил топган ва қандай кенгайтмага эга? 

8. Масалан сиз маълумотни ArcCatalogдан бошқа жойга кўчирган, бошқача номлаган ёки ўчириб ташлаган бўлсангиз, намойиш ойнасида/view window маълумотлар тўплами тасвирланмайди: бу қандай манба ҳисобланади ва қандай белги орқали кўрсатилади? 

9.  ArcMap маълумотлар тўпламидаги бузилган манбани қайта тиклаш учун қандай тугмаларни танлаш керак? 

10. Мундарижада/table of contents бир-бирига боғлиқ бўлган маълумотлар тўпламини қандай қилиб тартибга солиш мумкин? Мисол келтиринг.

11. Гуруҳ қатламини ҳосил қилишнинг мавжуд бўлган иккита йўлини таърифлаб беринг.

12. Гуруҳ қатламини қандай кўринишда сақлаш мумкин ва қатлам файли қандай кенгайтмага эга? 

13. Гуруҳ қатламини номини қайта номлаш мумкинми, қатламни гуруҳдан чиқариш йўлига таъриф беринг? 

14. ГАТда географик ходисаларнинг тавсифларини атрибутлар намоён этади. Атрибут жадвали нималардан тузилган? 

15. Белгилар редакторининг/Symbology editor кўрсатиш/Show иловасида харита турларини таърифлашингиз мумкин. Энг муҳим бўлганлари қайсилар? 

16. Белгилар редакторининг Битта белги/Single symbol, Ноёб қиймат/Unique value, Graduated color ва Graduated symbol харида турларига изоҳ беринг.

17. Symbology editor нинг марказий қисми қандай тўртта устундан ташкил топган? Уларнинг ҳар бирига изоҳ беринг. 
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КИРИШ 



ГАТда фазовий маълумотларни сақлаш билан ушбу амалий машғулот иш олиб боради. Машғулот давомида сиз асосан тақсимланган атрибутлар орқали мантиқан бир-бири билан боғланган жадвалларнинг тизимли маълумотлар тўплами сифатида боғлиқ маълумотлар моделидан фойдаланасиз. 



Ушбу амалий машғулотнинг биринчи қисми жадвалларга асосланган векторда маълумотларни сақлаш билан иш олиб боради. Сиз (иккиламчи) маълумотларни тўплаш усули сифатида нуқталарни оцифровка қилиш орқали янги вектор маълумотлар тўпламини яратасиз. Оцифровка (рақамлар билан белгилаш) – жадвал билан боғлиқ бўлган маълумотлар заҳирасини ёки уларни харитадаги жойларини компьютер файлларда x, y координаталарини ўзгартириш орқали географик объектларнинг жойлашишини автоматик тарзда сичқонча ёрдамида сақлаш ҳисобланади. Натижада сиз жадвалларни кўриб чиқасиз/view, яратасиз/create ва тўлдирасиз/fill.  Бундан ташқари сиз жадвалларни ҳам боғлайсиз.



Иккинчи қисмда, растрда маълумотларни сақлаш билан иш олиб борилади. Растр муҳитида фазовий маълумотларнинг турли тизимда бўлганлигини кўрасиз. 

________________________________________________________________________



Ушбу амалий машғулотда:



· Янги маълумотлар тўпламини яратиш;

· Вектор маълумотлар жадвалига янги атрибутларни қўшиш;

· Полигон объектларининг майдонини ҳисоблаш;

· Жадвалларни қўшиш;

· Вектор ва растр  маълумотлар тизимларини таққослаш ўрганилади.



Вазифалар



Ушбу амалий машғулотни ўзлаштиргандан кейин қуйидагиларни бажара оласиз: 

· ArcMapдан фойдаланиб, янги маълумотлар тўпламини яратиш; 

· ArcMapдан фойдаланиб, янги жадвалларни яратиш ва уни тўлдириш;

· Маълумотларнинг турли кўринишини ёритиш;

· Дискрит/discrete ва узлуксиз/continuos растрлар ҳамда зоналар/zones ва туманлар/regions орасидаги фарқни ажратиш; 

· Вектор маълумотлар тизимини ва растр маълумотлар тўпламини тушуниш.



ArcMap ҳужжати:  	Data storage.mxd

Адабиёт: 			Chapter 3: sections 3.1, 3.2 & intro of 3.3

Chapter 5: sections 5.1-5.3 (except 5.2.2, 5.2.7), 5.3, 5.5 & 5.7

Chapter 9 Attribute data input and management



ВЕКТОР МАЪЛУМОТЛАР ТЎПЛАМИНИНГ МАЪЛУМОТЛАР ТИЗИМИ 



Вектор маълумотлар модели мавжуд бўлган дунёнинг вазифага асосланган/object – based тавсифи ҳисобланади. Географик феномен нуқталар/points, чизиқлар/lines ёки полигон объектлари/polygon features сифатида кўрсатилади. Бир хил турдаги атрибут тўплами функцияси ва фазовий боғланиш (кўпинча ArcGIS орқали объект синфи сифатида қаралади) шейпфайл/shapefile бўлиб вектор маълумотлар тўпламида сақланади. Масалан, 'Landuse.shp' шейпфайл ердан фойдаланиш турларини кўрсатувчи полигон объектларидан ташкил топган. Жадвалларда объектларга боғлиқ бўлган маълумотлар сақланади. Ҳар бир объектда жадвалга киришнинг битта қайди мавжуд. Ҳар бир майдон (устун)/field (column) ўзига хос атрибутни тавсифлайди. Шейпфайл ҳолатида атрибут маълумоти dBase файлида сақланади.



Маълумотлар тўпламининг номланиши бўйича муҳим эслатма!



Маълумотлар тўпламининг номида ҳеч қачон пробелдан фойдаланманг! Сўзларни ажратмоқчи бўлсангиз айириб кўрсатидиган пастки чизиқча "_" белгисидан фойдаланинг. Маълумотлар тўплами номларида (масалан  +, -) каби белгиларни ишлатманг ва номининг узунлигини 10-12 та белгидан оширмасликга ҳаракат қилинг. 



Нуқтали маълумотлар тўпламини яратиш



[image: ]Агар сизнинг маълумотингиз чизиқлар ёки ҳудудлар сифатидан иккисидан бирини тасвирлаб берадиган жуда кичик объектлардан ташкил топган бўлса, у ҳолда ArcMapда нуқтали маълумотлар тўпламини/point dataset яратишингиз керак бўлади. Нуқталар дискрит жойларни/discrete locations қудуқлар/wells, дўконлар/shops, телефон будкалари/telephone booths сифатида намоён этади. Кейинги машғулот давомида сиз шаҳарнинг жанубий қисмида намуна олинган тупроқ нуқталарини намойиш этадиган маълумотлар тўпламини яратасиз. Аввал сиз нуқталарнинг жойларини оцифровка қиласиз ва кейин эса атрибут жадвалини атрибут қийматлари билан тўлдирасиз.



ҚЎЛЛАНМА:



1.  Аввалги амалий машғулотларда тавсифланганидек ArcToolbox ни очинг. 

2.  Data Management Tools => Feature Class =>

Create Feature Class (1-расм) танланг. Диалог ойнаси очилади. Яшил ранг билан белгиланган майдон жиҳозни юргизишдан олдин тўлдирилган бўлиши керак. 1 – расм. Янги вектор маълумот тўпламини яратиш жиҳози



3. Янги маълумот тўплами учун Output Location 

ни танланг. 

4. Output Feature Class майдонида янги маълумот тўпламига ном/name беринг.

5. Geometry Type (point) ни танланг ва OKни босинг (қолган вариантларни бажармасдан/Default очиқ қолдиринг).

6.  Кўрганингиздек янги лекин бўш ҳолдаги нуқтали маълумот тўплами /point dataset яратилди.

7. Редактор асбоблар панелидаги/Editor toolbar (2-расм) пастга қараган стрелкани Редактор/Editor танланг, Start Editing ни танланг ва ойнада workspaceни танланг. Агар асбоблар панели ҳали очилмаган бўлса, меню панелидаги/menu bar кўриш/view ни танланг, Toolbarsни кўрсатинг ва Editor ни белгиланг. 

8. OKни босинг.

9. Editor асбоблар панелидан Task ни танланг (янги объектни яратиш/create new Feature) ва Target дан (таҳлил қилмоқчи бўлган файл) танланг.

10. Cкетч/sketch [image: ]жиҳозини танланг. Энди янги маълумотлар тўплами чегарасида нуқта объектларини чизиш/draw мумкин.  Маълумотлар тўпламининг қаршисида текшириш ойнаси/check box белгиланганлигига ишонч ҳосил қилинг.



11. Тугатгандан сўнг, Редакторда/Editor пастка қараган стрелкасини босинг ва Stop Editing ни танланг. 



КИРИТИЛГАН ТУЗАТИШЛАРНИ САҚЛАБ ҚЎЙИШНИ УНУТМАНГ!!!



Агар сиз нуқтани нотўғри жойга қўйилганлигини билсангиз, уни жойини сиз ўзгартиришингиз мумкин. Сиз ҳар доим нуқта объектларни бироз ўзгартиришингиз/modify point features мумкин.



12. Start Editing ни танланг. 



13. [image: ]Жойини ўзгартирмокчи бўлган нуқтани танлаш учун кўрсатиш жиҳозини/ pointer tool ишлатинг. Нуқтани танлаш учун, ўзгартирмоқчи бўлган нуқтани босинг. Танланган объектлар атрофида танлаш дасталари/selection handles пайдо бўлади.



14. Ажратилган нуқтани судраб ўтказиш орқали янги жойига кўчиринг.



15. Янги нуқталарни кўчириб ўтказишни тугангандан кейин, Stop Editing ни танланг ва ўзгаришларни сақлаб қўйинг/save your changes.



[image: ]



2 –расм. Редактор асбоблар панели/the editor toolbar.
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3-расм. Кузатиш тупроқ нуқталарининг жойлашиши/Locations of soil point observations (X1 – X9). 



		

1.



'Data storage.mxd' ArcMap ҳужжатини очинг.



Ушбу машғулотда сиз 3 – расмда намойиш этилгани каби кузатиш тупроқ нуқталарини оцифровка қилиш орқали янги маълумотлар тўпламини яратасиз. 

'Wag_south' маълумот рамкасини актив ҳолатга келтиринг ва 'Soil_types' ва 'Roads' маълумотлар тўпламини кўрсатинг. 



1а. Янги нуқта маълумот тўпламини яратинг. Output Locations D:\IGI\ ...* ...\ArcGIS\workspace (*morning or afternoon) workspace да эканлигига ишонч ҳосил қилинг ва Output Feature Class матн ойнасида янги маълумот тўпламига 'soil_pts' деб ном беринг.





1b. 3 расмда кўрсатилгани каби тартиб билан кузатиш тупроқ нуқталарининг жойлашишини оцифровка қилинг, профил коди: X1 нуқтадан бошлаб X9 нуқтада тугатинг!





1с. Янги нуқта маълумот тўпламининг атрибут жадвални очинг. 'soil_pts' маълумотлар тўпламининг атрибут жадвали нечта қайдлардан ташкил топган? 





1d. 'Data storage.mxd' ArcMap ҳужжатини сақлаб қўйинг: меню панелидаги/menu bar Файл/File да Сақлаш/Save тугмасини босинг.











Нуқтали объектларга атрибутларни қўшиш



Аввалги машқда сиз тупроқ нуқталаринг жойлашишини оцифровка (рақамлар билан белгилаш) қилган эдингиз. Лекин ҳалигача бу нуқталарнинг маълум хоссаларини тавсифлайдиган жадвал маълумотлари (атрибут маълумот) киритилмаган. Сиз қачонки ArcMapда янги вектор маълумот тўпламини яратсангиз, ушбу маълумотлар тўпламига атрибут жадвали/attribute table беихтиёр тарзда яратилади. Ҳар бир рақамланган нуқта/digitized point учун қайд/record беихтиёр равишда атрибут жадвалга қўшилади.



Дастлаб, атрибут жадвал учта майдондан ташкил топган бўлади: FID, ID ва Shape. вектор маълумотлар тўпламида FID майдони объектларнинг ноёб идентификаториларидан/unique identifiers ташкил топган. Ноёб идентификатор/Unique identifier географик объектларнинг геометриясига тематик (атрибут) маълумотларини боғлайди. Ноёб идентификаторни/Unique identifier ўзгартириб бўлмайди. ID майдонида/ID field фойдаланувчи томонидан белгиланган/user-defined идентификаторлар сақланиб қолиши мумкин. Shape майдони географик объектларнинг (нуқталар/points, чизиқлар/lines ёки полигонлар/polygons) объект турини/feature type сақлайди. Бу майдон ArcMap орқали  қўлланади ва тузатишлар киритиб бўлмайди.



Ушбу жадвалга нуқта объектлари учун қўшимча атрибутни сақлашга янги майдонни ҳар вақтда қўшиш мумкин. Сиз атрибут жадвалида янги майдонни яратаётганда ўша майдон учун маълумот турини/data type танлашингиз шарт. Маълумотлар тури майдонда сақланиши мумкин бўлган маълумотнинг (масалан, матн, сон) турини белгилайди. ArcMap бир нечта маълумот турларини/data types қўллаб қувватлайди лекин энг муҳимлари қуйидагилар ҳисобланади: float, integer, text ва date.



Муҳим:



· ҲЕЧ ҚАЧОН атрибут номида белгилар ва пробеллар (бўшлиқ)дан фойдаланманг, фақат ҳарфлар, сонлар ва пастки ажратиш чизиғидан фойдаланинг. Атрибут номи фақат 10 та ҳарфлардан иборат бўлсин. 

· Майдонларни қўшиш ва ўчиришда пастда ифодаланганидек ArcToolbox ни қўллаб фойдаланилади.

· Жадвалда майдонни ёки сатрни қўшаётганда ёки ўчираётганда, жадвал ўз ҳолича очиқ эмаслигига/NOT open ва тузатишлар киритиш тартиби ҳолатида эмаслигига/NOT in edit mode ишонч ҳосил қилинг!

· Майдонни қўшиш ва ўчиришнинг энг хавфсиз йўли бу ArcCatalog даги ArcToolbox дан фойдаланишдир. Агар сиз ArcCatalog дан фойдаланмоқчи бўлсангиз аввал ArcMap ни ёпганингизга ишонч ҳосил қилинг!!



ҚЎЛЛАНМА:



1. [image: ]ArcToolbox ни очинг, Data Management Tools => Field=>Add field ни танланг.

2. Input table майдонида тузатиш киритмоқчи бўлган маълумот тўпламини танланг, Field name майдонига ном беринг, Field (data) type ни аниқланг, Field length да майдоннинг энини аниқланг ёки Field precision (майдонни ташкил этиши мумкин бўлган рақам сони) ва Field scale (ўнтали жойнинг сони) рақамли қиймат бўлган тақдирда. 4–расм. Объектни танлаш/Selecting a feature



3. OK ни босинг. 

4. Start editing ни танланг. 

5. Attrubute table ни очинг, тузатиш киритмоқчи бўлган катакчани танланг ва атрибут қийматини киритинг. Керакли объектга ўзгартириш киритилаётганига ишонч ҳосил қилинг, объектни танланг/select the feature (сатрнинг чап томонини босинг, 4-расмда кўрсатилган) ва намойиш ойнасида/view window қайси объект кўринганига эътибор беринг.

6. Тугагандан сўнг ўзгартиришлар киритишни тўхтатинг ва ўзгартиришларни сақлаб қўйинг.

7. Агар майдонни ўчириб ташламоқчи/delete бўлсангиз Data Management Tools=> Field=>Delete field ни танланг. 



		

2.



2a. Сиз 'Soil_pts' маълумотлар тўпламининг жадвалига олтита атрибутларни  қўшасиз: Prof_code, pH, Clay, Silt, Sand ва Soilcode. 1-жадвалда кўрсатилганидек майдон кўрсаткичларидан фойдаланинг.





2b. 5-расмга асосланиб 'Soil_pts' атрибут жадвалининг янги майдонларини белгилаганингизда атрибут қийматларини киритишингиз мумкин. Ҳамма атрибут қийматларни киритганингиздан кейин, ўзгартиришларни тўхтатинг/stop editing ва сақлаб қўйинг/save. Сўнгра ArcMap ҳужжатини сақланг.













		Name

		Data (Field) Type

		Length

		Precision

		Scale



		Prof_code

		Text

		2

		-

		-



		pH

		Float

		-

		3

		1



		Clay

		Short

		-

		3

		-



		Silt

		Short

		-

		3

		-



		Sand

		Short

		-

		3

		-



		Soilcode

		Text

		8

		-

		-







1-жадвал. Нуқта объектларини рақамлаш атрибутларининг майдон таърифи/

Field definitions of the attributes of the digitized point features.



Mуҳим!! Майдонга (масалан, маълумот тури)ни сақланганда кейинчалик бу майдонга ўзгартиришлар киритишнинг иложи бўлмайди/not possible to change!! Агар ўзгартирмоқчи бўлсангиз, аввал майдонни ўчириб ташлаб керак ва атрибут жадвалига янги майдонни қўшиш мумкин. 
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5-расм. ‘Soil_points’ вектор маълумот тўпламининг атрибут жадвали/The attribute table of vector dataset ‘Soil_ points’.







Полигон объектларининг майдонини ҳисоблаш 



Сиз ArcMapда маълумот тўпламининг полигон объектларини ҳудудини/area ҳисоблашингиз/calculate мумкин. Буни ArcMapда бажаришнинг иккита йўли мавжуд: ArcToolbox ёрдамида ёки Field calculator билан бажарилади. Бу секция сизни ушбу иккита усулларни таништириш бўйича қўлланмаларидан ташкил топган. 



Сиз ArcToolbox дан фойдаланаётганингизда ArcMap мавжуд бўлган полигон маълумот тўпламидан нусха кўчиради/copy ва полигон ҳудудларда сақланган F_Area деб номланган қўшимча майдонни/extra field қўшади. Бу усул энг тез ва осон ҳисобланади. Ушбу усулнинг ноқулайлиги шундаки, ҳар вақт полигонлар объектларининг ҳудудини ҳисоблаганда, янги вектор маълумот тўплами яратилади ва малумот рамкасига қўшилади. Бунинг натижасида, сиз маълумотлар тўпламини адаштириб юборишингиз ва қайси атрибутлар қайси маълумот тўпламида сақланганлигини йўқотиб қўйишингиз мумкин. Шунинг учун ушбу усул билан ишламоқчи бўлсангиз эътиборингизни маълумотларни тўғри бошқаришга/proper data management қаратинг! Масалан, дастлабки маълумот тўпламини ўчириб ташлаш учун ArcCatalogдан фойдаланинг (area атрибут маълумот тўпламидан ташқари). Маълумот рамкасидан маълумот тўпламини олиб ташлашдан/remove олдин уни ўчириб ташлашни унутманг!



Иккинчи усул бу Field Calculatorдан фойдаланиш озгина мураккабликни талаб этади, лекин бунда янги маълумот тўпламини яратишнинг зарурияти бўлмайди.



ҚЎЛЛАНМА (ArcToolbox):

[image: ]

1.  Ҳудудини ҳисобламоқчи бўлган маълумот тўпламини маълумот рамкасини актив ҳолатга келтиринг. 

2. ArcToolboxдаги Spatial Statistics

Tools => Utilities => Calculate Areas (икки марта босинг) танланг, 6-расм.

3. ‘Input feature class’ ни тангланг (ҳудудини ҳисобламоқчи бўлган полигон маълумот тўплами).

4. Output Feature Class майдонида янги маълумот тўпламини номини аниқланг. Workspace да сақлаётганингизга ишонч ҳосил қилинг ва OKни босинг. 6-расм. Field calculator билан полигон объектларининг ҳудидини ҳисоблаш/ Calculating the area of polygon features with the field calculator.



5. Ишингизни давом эттирадиган 

янги маълумот тўплами/new dataset

 яратилади.



ҚЎЛЛАНМА (Field calculator):



1. Сиз ҳудудини ҳисобламоқчи бўлган маълумот тўпламини маълумот рамкасини актив ҳолатга келтиринг.

2. ArcToolbox дан фойдаланиб ушбу маълумот тўпламининг атрибут жадвалига майдон қўшинг. Майдон ҳудудини номланг (data type = double, precision = 10, scale = 2).

3. Editor асбоблар панелида Start Editingни танланг. 



Сиз тузатишлар киритмасдан ҳам ҳисоблашингиз мумкин. Ушбу ҳолда натижаларни тиклашнинг бошқа йўли  қолмайди. 
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4. Ўзгартириш киритмоқчи бўлган маълумот тўпламини/dataset сичқончадан фойдаланиб ўнг томонини босинг ва Open Attribute Table ни танланг. 

5. Ҳудуд учун field heading ни ўнг томонини босинг ва Calculate Valuesни танланг. 

6. Advancedни текширинг (белги қўйинг). 

7. Биринчи матн ойнасига (Pre-Logic VBA Script Code) қуйидаги ифодани теринг. (7-расм): 

7-расм. Field calculator билан полигон объектларининг ҳудидини ҳисоблаш/ Calculating the area of polygon features with the field calculator.



Dim dblArea as double

Dim pArea as IArea

Set pArea = [shape]

dblArea = pArea.area



8. Иккинчи матн ойнасига: dblArea ни теринг. 

9. OK ни босинг. 



		

3.



3а. ‘Soils’ маълумот тўпламини полигон объектларини ҳудудини ҳисобланг. ArcToolboxдан фойдаланинг. Маълумот тўпламини soils_area деб номланг. Workspace да жойлашганлигига ишонч ҳосил қилинг. 



3b. Машқни қайтаринг лекин бу сафар field calculator дан фойдаланинг.  











Янги жадвални яратиш



Сиз шу вақтгача маълумотлар тўпламининг атрибут жадвалига янги майдон ва атрибут қийматларни қандай қўшишни кўрдингиз. ArcMapда маълумотларни олишнинг бошқа янги йўли шундаки, бўш жадвалларни яратиш ва уларни ўзингиз тўлдиришингиз мумкин.



Маълумотларингиз учун янги жадвал тузиш, ўтган машғулотлар давомида бажарган каби мавжуд маълумотлар тўпламининг атрибут жадвалига янги атрибут маълумотларини қўшишга нисбатан анча осон ҳисобланади. Маълумотларингизни алоҳида жадвалга жойлаштириб, сиз улар билан ҳар қандай ўзига хос маълумотлар тўпламидан ташқари мустақил ишлашингиз мумкин ва сиз уларни хохлаган пайтингизда керакли бўлган маълумотлар тупламига бирлаштиришингиз мумкин.



ҚЎЛЛАНМА: 



1. Data Management Tools=>Table=>Create Table ни танланг.

2. Output location (your workspace) ни танланг ва output table да жадвалга ном беринг.

3. OK ни босинг. 



Жадвал яратилди, лекин у table of contents да пайдо бўлмади. Уни кўрсатиш учун table of contents нинг пастки қисмидаги Source иловасини танланг. Жадвал очилганда у иккита майдондан ташкил этилганлигини кўрасиз: OID ва Field1.



1. ArcToolboxда опциядаги Delete Field дан фойдаланиб ‘Field1’ ни ўчириб ташлашингиз мумкин: Data Management Tools => Fields => Delete Field. Жадвал ҳар доим иккита майдондан иборат бўлиши керак. “Field1” атрибут майдонини фақат янги жадвал кўшгандагини ўчириб ташлашингиз мумкин.  

2. Жадвалга маълумот қўшиш учун Start Editing тугмасини танланг ва жадвални очинг. 

3. Ҳар қандай бўш катакчани танлаш/clicking any blank cell орқали жадвалга маълумот қўшинг. 

4. Киритишни тўхтатганингизда/stop editing ўзгартиришларингизни сақланг/save your changes.



Изоҳ: Сиз OID қийматига тузатиш кирита олмайсиз/cannot edit. Сиз жадвалда биринчи атрибут қийматини тўлдирганда ArcMap OID қийматини автоматик тарзда қайдга бирлаштиради. 



		4.



4а. ‘Landscape’ деб номланган янги жадвал яратинг. Уни Worspace да сақланг. Жадвалга  иккита майдонни қўшинг: LU_code ва LU_descrip. Бу майдонларининг Майдон таърифи/field definition 2 – жадвалда берилган. 





4b. 'Landscape' жадвалининг майдонларини аниқлагач, сиз атрибут қийматларини  киришингиз мумкин. 8 – жадвалга асосланиб янги жадвални тўлдиринг ва сақлаб қўйинг. 











		Name

		Data (Field) Type

		Length



		LU_code

		Text

		2



		LU_descrip

		Text

		25







[image: ]2 – жадвал. Landscape жадвалининг атрибутлари учун майдон таърифи/ Field definitions for the attributes of the landscape table.



8 – жадвал. Жадвалда сақланган ландшафт маълумотлари./Information of landscape stored in a table.



Жадвалларни қўшиш



Сиз жадвал маълумотларини мавжуд маълумотлар тўпламига унинг атрибутлар жадвалини/attribute table бирлаштириш орқали қўшиш мумкин. Сиз жадвални атрибут жадвали маълумот тўпламига бирлаштирганингизда барча майдонлар (атрибутларлар) бирлаштирган жадвалдан маълумотлар тўпламининг атрибут жадвалига қўшилади. Бу майдонларнинг ҳар бирини белгилашингиз/symbolize, этикетка/label, сўров/quary ёки маълумотлар тўпламининг объектларини таҳлил/analyze қилишингизмумкин. 



Бирлаштириш/join иккита жадвалларда/both tables ҳам топиш мумкин бўлган бир хил аниқликдаги атрибутнинг қийматларига/values of a similar defined attribute асосланган ҳисобланади. Атрибутнинг номи иккита жадвалларда ҳам бир хил бўлмаслиги мумкин, лекин маълумот тури/data type ва атрибут қийматлари/ attribute values бир хил бўлиши керак (9 - расм).



ҚЎЛЛАНМА:



1. Бирлаштириш учун ArcToolbox га боринг ва Data Management Tools => Joins => Add Join ни танланг. 

2. Бирлаштирилган жадвалга (Layer name) маълумот тўпламини танланг ва (Input join field) бирлаштириш асосланган майдонни тангланг. 

3. Join table майдонида бирлаштирилаётган жадвални тангланг ва бирлаштириш асосланган Output join field ни тангланг. OK ни босинг. 

4. Маълумотлар тўпламининг бирлашган жадваллари очилганда маълумот тўпламининг атрибут жадвалига ҳамма майдонлар жадвалда бирлашганлигини кўрасиз. Майдонлар жадвалнинг ўнг томонидан пайдо бўлади. 

5. Бирлашишини ўчириш учун маълумотлар тўплами номиги икки марта босинг, Joins & Relates иловасини танланг ва бирлашган майдонларда Remove ёки Remove all ни танланг.
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9 – расм. Умумий майдонга асосланган бирлаштиришнинг натижаси (Land use Code)./ Result of a join based on a common field (Land use Code).



		

5.



5a. ‘LU_code’ умумий майдон орқали ‘Soil_types’ маълумот тўпламининг атрибут жадвалига ‘Landscape’ жадвалининг майдонларини бирлаштиринг. 



5b. Бирлаштиргандан кейин ‘Soil_types’ жадвали нечта атрибутдан ташкил топди? 





5с. Бирлаштиришниг олиб ташланг/Remove the join. 











РАСТР МАЪЛУМОТЛАР ТЎПЛАМИНИНГ МАЪЛУМОТЛАР ТИЗИМИ 



Шу пайтгача ушбу машғулот вектор маълумотлар тизимида/vector data structure  сақланган фазовий маьлумотлар билан иш олиб борди. Географик маьлумотларни сақлашнинг бошқа кенг фойдаланиладиган маълумот тизими растр ёки катакча/raster or grid ҳисобланади (11-расм). Растр жойлашишга асосланган/location-based маълумотлар тизими ҳисобланади. Фазо/Space сатрлар ва устунларда жойлашган бир хил ўлчамидаги катакчаларнинг доимий матрица ичида бўлиб ташланганлиги ҳисобланади. Ҳар бир катакчага қиймат берилган ҳисобланади (10-расмнинг ўнг томони) ўзлари жойлашган фазовий хоссаларга мос келади (масалан: баландлик/elevation, тупроқ/soil ёки ердан фойдаланиш тури/land use type), вектор тизимига қарама-қарши каби атрибутларни географик объектлар/objects билан боғлайди.   
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10-расм. Растр маълумотлар тизими/The raster data structure.



Дискрит/discrete растр узлуксиз/continuos растрга қарши



Тақдим этилган маълумотларга қараб растр маълумотлар тўплами ҳар қандай бутун сон/integer (бутун сонлар) ёки ўзгарувчан нуқта/floating point (ўнлик сонлар) қийматларини яратиши мумкин. ArcGISда растр маълумотлар тўплами бутун сонлар қийматларидан тузилган (дискрит ёки узлуксиз) атрибут жадвалга растр катакча қиймати боғланган бўлиши мумкин. Ушбу жадвалда атрибут қиймати ноёб комбинациялари сақланган. Растр маълумотлар тўплами ўзгарувчан нуқта/floating point қийматлари (дискрит бўлмаган/non discrete ёки узлуксиз/continuous) жадвалларга боғланган бўлмайди/will not have associated tables.

Дискрит растрлар/Discrete rasters чегараларни аниқлай оладиган географик объектларини намойиш этади, баъзида categorical ёки discontinuous маълумот каби номланади. Дискрит жой объектларига/discrete terrain object мисол: кўл, ўрмон, ер, бинолар, йўллар ва бошқалар киради.



Узлуксиз растрлар/Continuous rasters дискрет қадамларсиз фазовий ўзгарадиган географик ҳодисани намойиш этади. Ҳар бир катакча қиймати консентрациянинг ўлчами ёки ўша жойнинг даражаси ҳисобланади. Узлуксиз географик феномен умуман олганда дискрит географик объектлар каби аниқ чегараларга эга эмас. Географик объект - кўл, ҳақиқий ва аниқлай олинадиган чегарага эга. Бироқ, географик феномен – кўл, узлуксиз ўзгариб турадиган чуқурликка эга. Эҳтимол, узлуксиз растрда ҳар бир катакча турли хил қийматларга эга бўлиши мумкин. Узлуксиз маълумотлар манбадан консентрацияси камайган ёки баландлик, оловдан иссиқлик, даражалар ифлосланишини ўз ичига олади. 

Муҳим: Растрлар ҳар доим тўғри бурчакли ҳисобланади. Растрда ҳар бир катакча жойини аниқловчи қийматга эга. Агар маълумот катакча жойи учун етарли бўлмаса ёки мавжуд бўлмаса, жой қийматни NoData деб аниқлайди. NoData  ва 0 бу хил эмас: 0 -  гео маълумотларни қайта ишлашда фойдаланиш мумкин бўлган мавжуд қиймат, мадомики геомаълумотларни қайта ишлашда NoData истисто равишда чиқарилади.  



ҚЎЛЛАНМА:



1. Намойиш ойнасида/View window растр маълумотарни кўрсатинг. 



Ранглар катакча қийматига/value асосланиб, растр катакчаларини тайинлайди. Ҳар бир қиймат бир ранг билан белгиланган. 



2. Катакча қийматини аниқлаб олиш учун Identify tool [image: ]ни танланг. 

3. Намойиш ойнасида/View window катакчани танланг. 



		

6.



‘Vector vs. Raster’ маълумот рамкасини актив ҳолатга келтиринг ва ‘LU_raster’ растр маълумот тўпламини кўрсатинг.



6а. Identify Results dialog да кўрсатилгани каби ‘LU_raster’  маълумот тўпламини атрибутларининг маъносини тушунтириб беринг.





6b. ‘LU_raster’ растр маълумот тўплами discrete ёки continuous растрга мисол бўла оладими? Нима учун?





6с. Open the attribute table of ‘LU_raster’ нинг атрибут жадвалини очинг (маълумот тўпламининг ўнг томонини босинг).  ‘LU_raster’ маълумот тўплами неча турли қийматлардан (масалан: ердан фойдаланиш синфлари/land use classes) ташкил топган?











Растрда зона/zone туманга/region қарши



Растр катакчалари бир хил қийматларни бўлишгани каби географик объектларнинг бир хил турини намойиш этади. Бир хил қийматга узлуксиз растр катакчаларининг боғламлари/cluster туман/region деб аталади. Туман дискрит географик объектни, масалан бино ёки кўлни намойиш этади. Бир хил қийматдаги барча туманлар зонани/zone ташкил этади (11-расм). Зоналар барча географик объектларни бир хил кийматдаги, масалан барча биноларни ёки кўлларни намойиш этади. Шундай килиб, зоналар "Land_use" тематик растр маълумотлар тўпламида ердан фойдаланиш тури ҳисобланади. 



Туман бу вектор полигон объектининг растр эквиваленти ҳисобланишига эътибор беринг: битта географик объектни/feature намойиш этадиган дискрит объект/object. 
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11-расм. Зона ва туманларга тегишли бўлган растр катакчалари. Ушбу растр бешта зонадан ташкил топган. 4 – қийматга эга зона учта туманлардан тузилган. Raster cells belong to zones and regions. This raster contains five zones. Zone with value 4 is made up of three regions.



Бу машғулотда иккита ГАТ маълумот моделлари  муҳокама қилинган (растр ва вектор), растр маълумот тизими энг кўп комплекс атроф-муҳитни моделлаштиришни ва фазовий таҳлил учун операторларни таъминлайди. 



ArcToolbox катакчага асосланган/cell-based (растр) операцияларни бажарадиган комплекс асбоблар тўпламидан ташкил топган. Бу жиҳозлар Spatial Analyst Tools жиҳозлар қутисида топилиши мумкин ва 8 амалий машғулотда муҳокама қилинади. 

		

7.



7a. ‘LU_raster’ нинг атрибут жадвалидаги битта қайдни белгилаганингизда зона ёки туманни танлайсиз? Жавобингизни тушунтиринг! 











		

8.



8а.‘LU_raster’ ва ‘Land_use’ маълумотлар тўпламининг атрибут жадвалларини солиштиринг (12-расм) ва маълумот сақланган иккита жадвал ўртасидаги асосий фарқларни ёзинг. 
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12-расм. Вектор (1) ва растрда (2) атрибут жадвал/Attribute table in vector (1) and raster (2).









































































































3-амалий машғулотни бажаргандан кейин ўз-ўзини

текшириш учун саволлар







































Саволлар



1. 3 – амалий машғулот неча қисмдан ташкил топган ва бу машғулот давомида қандай амаллар бажарилади. 

2. 3 – амалий машғулотни ўзлаштиргандан кейин қандай вазифаларни бажара оласиз: 

3. Вектор маълумотлар тўпламининг маълумотлар тизимида 'Landuse.shp' шейпфайл қандай объектлардан ташкил топган?  

4. Жадвалларда қандай маълумотлар сақланади? 

5. Шейпфайл ҳолатида атрибут маълумоти қандай файлда сақланади.

6. Маълумотлар тўпламини номлашда нималарга эътибор бериш лозим? 

7. Нуқтали маълумотлар тўпламини яратишга тавсиф беринг? 

8. Жадвалда майдонни ёки сатрни қўшаётганда ёки ўчираётганда нималар муҳим? 

9. ArcMapда маълумот тўпламининг полигон объектларини ҳудудини/area ҳисоблаш/calculate мумкин. Буни ArcMapда бажаришнинг нечта ва қандай йўли мавжуд:

10. Жадвалларни бирлаштирганда атрибутнинг номи иккита жадвалларда ҳам бир хил бўлмаслиги мумкин, лекин нималар бир хил бўлиши керак (расмга қаранг).

[image: ]

11. Растр қандай тизим ҳисобланади? Сатрлар ва устунларда жойлашган бир хил ўлчамидаги катакчаларнинг доимий матрица ичида бўлиб ташланганлиги нима ҳисобланади.

12. Дискрит растрлар/Discrete rasters нималарни намойиш этади? Дискрит жой объектларига/discrete terrain object га мисол келтиринг? 

13. Узлуксиз растрлар/Continuous rastersга таъриф беринг. 

14. Агар маълумот катакча жойи учун етарли бўлмаса ёки мавжуд бўлмаса, жой қийматни нима деб аниқлайди?

15. Туман/region ва зонани/zone бир-биридан фарқи нимада? 

16. Ушбу расмда растр катакчалари нечта зона ва тумандан ташкил топган ёки тузилган? 
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КИРИШ 



Ер қопламидаги фазовий объектларнинг жойлашиши, уч ўлчамли координаталар тизими орқали тасвирланган. Аллақачон, 2000 йиллардан кўп вақт давомида фойдаланилаётган Географик Координаталар Тизими/Geographic Reference System деб танилган сферик координата тизими ер қобиғида кенглик/latitude ва узунлик/longitide орқали жойларни ифодалайди (Lo and Yeung, 2002).



Агар сиз ер қопламидаги харита объектларини яратмоқчи бўлсангиз, сиз сферик юзани текис харитага ўтказишингиз керак. Уч ўлчамли юзадан/three-dimensional surface икки ўлчамли харитага/two-dimensional map ўзгартириш проектлаш/projection деб аталади. Математик ифода маълумотларни сферик географик координата тизимини бурчаклидан чизиқлига, текис харитани ортогонал проектлаш координата тизимига айлантиради. Бу ўзгартиришлар/transformation бир неча қадамларни талаб этади.



Ер қопламидан уч ўлчамли/3D координата юзасигача 

Биринчидан, математик уч ўлчамли координата юзаси ернинг физик шакли моделлари эллипсоид шаклида аниқлаштирилиши керак. Эллипсоид – силлиқ юза ҳисобланади. Ернинг ҳақиқий юзаси ‘mean sea level’ орқали намойиш этиладиган қисми силлиқ бўлмайди. Бу эллипсоид ва ‘mean sea level’ ўртасида ҳар доим фарқ мавжудлигини англатади. 

Агар сиз аниқ ҳудуд учун (штат, давлат, континент) уч ўлчамли координата юзасини/3D reference surface яратмоқчи бўлсангиз, сиз эллипсоидни фарқини шундай мослаштиришингиз керакки, координата ернинг ҳақиқий қопламига жуда яқин мослашиши керак. Маълумотлар элементи/Datum – эллипсоид бўлиб, у ернинг ҳақиқий мумкин қадар маълум бир туманнинг шаклига тенглаштирилган.  Маълумотлар элементи/Datum жойнинг географик координаталарини ҳисоблаш учун уч ўлчамли координата юзаси каби хизмат қилади. 

Эллипсоидлар 19-асрдан 20-аср ярмигача фақат ернинг шакли маълум бир мамлакат ёки континент узра мослаштирилган (Snyder, 1987). Бу эллипсоидлар ер ўлчамлари орқали белгиланган. Маълумотлар элементи/Datumлар фақат маълум бир ҳудудда ернинг юзасига мослашган маҳаллий эллипсоидларга асосланади. Намуналар Шимолий Америка континентида ернинг юзасига мослашган қайсики Нидерландияда ва ‘NAD27’ маълумотлар элементи/datum ернинг юзасига яқин тенглаштирилган ‘Amersfoort’ маълумотлар элементини/datum ўз ичига олади. Бу маълумотлар элементи/datum Bessel 1841 ва Clarke 1866 эллипсоидларига мос равишда асосланган. 

Мадомики, фазовий асрда ернинг барча/entire қопламини яқиндан кўрсата оладиган спутник белгилайдиган эллипсоидлар мавжуд бўлди. Энг кўп қўлланиладиган эллипсоид WGS84 ҳисобланади. Чунки бу аллақачон энг яхши яқинлашиш бўлиб, бунда ернинг шаклини ҳеч қандай бошқаришларсиз аниқ шакл керак бўлган ва эллипсоид ўртасидаги фарқга асосланган. WGS84 ҳам эллипсоид, ҳам элементдир/datum. Шуни билингки, глобал эллипсоидлар жой эллипсоидларига нисбатан барча ернинг шаклини умумий яқинликни яхшироқ беради, улар умуман маълум бир туман учун энг яхши мослашишни бермайди (Snyder, 1987). Бу WGS84 элементини минтақавий харита мақсадлари учун камроқ мос тушадиган қилади.



Уч ўлчамли/3D координата юзасидан икки ўлчамли/2D текис юза харита проектигача 



Математик функцияларнинг тўпламидан фойдаланиш орқали (3D) сферик координата юзасининг (the datum) географик координата тизими/geographic coordinate system (2D) текис юза проектининг проектланган координата тизимига/projected coordinate system ўзгартирилиши/transformed ёки проектланиши/projected мумкин. Бу ўзгаришнинг текис юзага параллеллар ва меридианларнинг тизимли келишуви каби аниқланиши мумкин бўлган натижаси харита проекти/map projection ҳисобланади (Chang, 2006). Проектланган координата тизимлари Cartesian (X,Y) координаталари ва чизиқли/linear харита бирликлари орқали жойлашишини ифодалайди. 



Харита проектлари ернинг (сферик юзаси) қоплами ҳудудларни харитага (текис юза) намойиш этишга имкон беради. Ҳар қандай ҳолатда геометрик хоссаларнинг шакл/shape, ҳудуд/area, масофа/distance ва йўналиш/direction уч ўлчамли юзаси икки ўлчамда хатоликни жалб этади Ҳеч қандай проект ушбу ҳамма хоссаларни сақлай олмайди, шунга қарамай баъзи бир шакл ва йўналиш каби комбинациялар (the Mercator projection) сақланган бўлиши мумкин. Харита тузувчи сифатида харитада сақлашни хохлаган хоссаларга кўра сиз харита проектини танлашингиз шарт. Бу сизнинг харитангизни мақсадига аниқ боғлиқ бўлади.



Шуни ёдда тутиш керакки, ArcGIS ушбу машғулотда агар зарур бўлганда аниқ тушунчаларни муҳокама қилишга ёрдам бериши мумкин бўлган жуда кўп проектлар ва координата тизимлари тўғрисида маълумотлардан таркиб топган кенг ёрдамчи тизимига эга. 

________________________________________________________________________



Ушбу амалий машғулотда:



· Проектланмаган маълумотлар тўплами учун проект қилишга аниқлик киритиш;

· Маълумот тўпламини қайта проектлаш;

· On – the – fly проекти;

· Турли хил харита проектларининг геометрик хоссаларга таъсирини ўргатади.



Вазифалар



Ушбу амалий машғулотни ўзлаштиргандан кейин қуйидагиларни бажара оласиз: 

· Харита проектларининг назарий тизимини асосини тушуниш;

· ArcMapда маълумотлар тўпламини проектлаш ва қайта проектлаш;

· ArcMapдаги харита намойишига маълумотлар рамкасининг таъсирини тушуниш;

· Турли хил проектлар билан боғланган, геометрик хатоликни ёритиб бериш.



ArcMap ҳужжати:  	Map projections.mxd

Адабиёт: 			Chapter 2 Coordinate systems



ФАЗОВИЙ МАЪЛУМОТЛАР ТЎПЛАМИ ПРОЕКТИ



Тасвирни проектлашни аниқлаш 



Қачонки сизнинг маълумот тўпламида проектлаш/projection аниқланмаган бўлса, сиз Проектлашни аниқлаш/Define Projection асбобидан фойдаланишингиз мумкин. Шунингдек, координата тизимида Аниқланмаган/Undefined рўйхатда берилади, бу маълумот тўпламининг (Layer properties window) Source иловасида намоён бўлади. 
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1-расм. Сиз маълумотлар тўпламининг харита проекти тўғрисида маълумотни Source иловаси тагида топасиз./Under the Source tab you find information about the map projection of the dataset.



Агар сиз проектни аниқлайдиган бўлсангиз, иккита координаталар тизимини ўртасида танлашингиз мумкин:



· Географик координата тизими/Geographic coordinate system

Сферик (3D) координата тизими. Жойлар кенглик ва узунлик орқали ифодаланади. Харита бирликлари: бурчакли (ўнли даража).



· Проектланган координата тизими/Projected coordinate system

Текис (2D) координа тизими. Жойлар X ва Y координаталари орқали ифодаланади. Харита бирликлари: чизиқли (метр, миль ва ҳоказо).



Агар сизнинг маълумотлар тўпламингиз географик координата системасига эга бўлса, сиз уни хали хам ўз харитангизда кўрсатишингиз мумкин. ArcMap шунчаки кенглик/узунлик координаталарини текис (x, y) координаталари кўринишида маълумотларни қайта ишлайди.



ҚЎЛЛАНМА: 



1. ArcToolbox ни очинг. Data Management Tools=>Projections and Transformations=>Define projections ни тангланг.

2. Input Dataset ёки Feature Class пастга қараган стрелкани танланг ва проектланмаган маълумот тўпламини танланг. 

3. Coordinate system илова ёнидаги тугмани босинг. Spatial Reference Properties ойнаси очилади. Select тугмасини босинг. Сиз geographic ва projected координата тизимлари ўртаси бирини танлашингиз мумкин.

4. Сиз белгиламоқчи бўлган маълумотлар тўпламини координаталар тизимида кўриб чиқинг. Add тугмасини босинг.  

5. Apply ни ва OKни танланг. Spatial Reference Properties ойнаси ёпилади.

6. Асбобни ишга тушириш учун OKни босинг. 



		

1.



ArcMap ҳужжатидан ‘Map projections.mxd’ни очинг. ‘Unprojected’ маълумот рамкасини актив ҳолатга келтиринг.



1а. ‘Netherlands_rd’ маълумотлар тўпламининг Layer  properties ни очинг. Source  иловасини танланг ва бу маълумот тўплами проектга эга эмаслигини тасдиқланг. 





1b. Бу маълумот тўпламини проектланг. Dutch координата тизимида  ‘Rijksdriehoekstelsel’ проектини танланг. Бу проектланган координата тизими ҳисобланади. Проектланган файл ‘National Grids’ папкасида жойлашган.





1с. ‘Netherlands_rd’ маълумот тўпламининг Layer properties ойнасини очинг. Чиққан маълумот эндиликда проектланган параметрларга эга (2-расм). Проектланган  координата тизимидан фойдаланиб бу маълумот тўплами координаталари жойларини тасдиқланг. Бу projected coordinate system қайси geographic coordinate system (datum) га асосланган?





1d. Проектланган координата тизимининг бирлиги нима ҳисобланади?
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2-расм. Маълумот тўплами харита проекти аниқлигига эга бўлганда проект параметрлари source иловаси тагида топилади. / When a dataset has a map projection defined, projection parameters can be found under the source tab.



Фазовий маълумотларни қайта проектлаш



ГАТни қўллашда сиз турли хил манбалардан маълумотлар тўплами йиғаётганингизда одатда турли хил харита проектларига эга маълумотлар тўплами билан тугаллайсиз. Project асбоби билан маълумотлар тўпламингизнинг харита проектини ўзгартиришингиз мумкин. Асбоб элемент/datum ва эллипсоид/ellipsoidни ўз ичига олган кордината тизимини аниқлаган янги натижага эга малумот тўпламини яратади.



ҚЎЛЛАНМА:



1. ArcToolboxни очинг. Data Management Tools => Projections and Transformations=> Feature =>Project ни танланг.

2. Сиз қайта проектламоқчи бўлган Input Dataset ёкиr Feature Class танланг.

3. Чиқиш маълумот тўпламини/Output dataset жойини ва номини аниқланг (кайта проектланган маълумот тўплами).



4. Coordinate system илова ёнидаги тугмани босинг. Spatial Reference Properties ойнаси очилади. Select тугмасини босинг. Сиз geographic ва projected координата тизимлари ўртаси бирини танлашингиз мумкин.

5. Сиз белгиламоқчи бўлган маълумотлар тўпламини координаталар тизимида кўриб чиқинг. Add тугмасини босинг.  

6. Apply ни ва OKни танланг. Spatial Reference Properties ойнаси ёпилади.

7. Geographic Transformation пастга қараган стрелкани танланг ва ўзгаришни/transformation танланг. Бу фақат элементни ўзгартириш/datum conversion тақоза этилгандагина керак бўлади. Масалан, ‘Amersfoort’ /кириш элементи/input datum (‘Rijksdriehoekstelsel’ проекти ҳолатида) ва WGS84 чиқиш  элементи/output datum (Mercator проекти ҳолатида) бўлганида.

8. Асбобни ишга тушириш учун OKни босинг.



		

2.



Бу машқда сиз ‘Country_rd’ маълумот тўпламининг ‘Rijksdriehoek’ (‘RD’) дан ‘UTM’ ва ‘Mercator’ харита проектига ўтиш учун Project асбобидан фойдаланасиз. Маълумотлар тўплами хариталари проекцияларини ‘UTM’ ва ‘Mercator’ проекцияларда кўриб чиқамиз.



2а. Харита проектини ‘RD’дан ‘UTM’га ўзгартиринг.

· Маълумот тўпламини ‘Country_utm’ деб номланг, маълумот тўпламини workspace да сақланг. 

· Проект фойлидан фойдаланинг: Projected coordinate systems\ UTM \ WGS84 \ WGS84 UTM Zone 31N. Geographic Transformation пастга қараган стрелкани танланг ва “Amersfoort_To_WGS84” ни танланг.



2b. Харита проектини ‘RD’ дан ‘Mercator’га ўзгартиринг.

· Маълумот тўпламини ‘Country_mercator’ деб номланг, маълумот тўпламини workspace да сақланг. 

· Проект фойлидан фойдаланинг: Projected coordinate systems\ World \ Mercator (world). Geographic Transformation пастга қараган стрелкани танланг ва “Amersfoort_To_WGS84” ни танланг.



2с. Учта маълумотлар тўпламини намойиш ойнасида/view window кўрсатинг. [image: ] тўлиқ кенгайтиришни босинг. Нима учун маълумотлар тўплами бир-бирини қопламаган/not overlap? Жавобингизни тушунтиринг. 





1-жадвал Мамлакатнинг учта турли проектлари учун узунлик/length, кенлик/width ва ҳудудни/area беради. 





2d. Меркатор проекти ва бошқа иккита проектларда ўлчам ва ҳудуд ўртасидаги катта фарқни тушунтиринг.





2e. Мамлакатнинг узунлик, кенлик ва ҳудудини энг яхши намойиш этган қайси проект беради? Жавобингизни тушунтиринг. 













		Projection

		Length (km)

		Width(km)

		Area (km2)



		RD

		312

		265

		34,749



		UTM

		313

		259

		34,753



		Mercator

		506

		431

		93,367







1-жадвал. Турли хил харита проектлари учун мамлакатнинг геометрик хоссалари./ Geometric properties of the country for different map projections.

[image: ]













































3-расм. Мамлакатнинг турли жойларига турли хил проектларни фарқи. / Different projections lead to different locations of The Country.



МАЪЛУМОТ РАМКАСИНИНГ ПРОЕКТИ 



On-the-fly проекти 



ArcGIS турли хил проектлар мавжуд бўлган маълумотлар тўпламини кўрсатиш учун ‘On-the-fly projection’ дан фойдаланади. Бу шуни англатадики, проектларга эга маълумотлар тўплами битта маълумот рамкасида намойиш этилиши, худда бир хил проектга эга каби маълумотлар тўплами проектлари автоматик тарзда кўрсатиши мумкин. Масалан, Меркатор проектига асосланган мамлакат харитаси UTM проектида худди шу давлатнинг харитасини бир-бирига қоплайди. Фойдаланувчи кўз билан кўриш/visually орқали таққослаши ва таҳлил қилиши ҳамда хариталарни проектлаш тўғрисида хавотир олмасдан принтердан чиқариши мумкин. 

Умумий проектлаш нимани билдиради?

ArcMap ҳужжатига янги маълумот рамкасини қўшганингизда, маълумот рамкасининг координата тизими ҳали аниқланган ҳисобланмайди. Маълумот рамкаси автоматик равишда маълумот рамкасига биринчи қўшилган маълумот тўпламининг координата тизимини олади./The data frame takes automatically the coordinate system of the first dataset added to the data frame. Агар сиз биринчидан кейин кўпроқ маълумотлар тўпламини қўшмоқчи бўлсангиз, маълумот рамкасидаги худди бир хил координата тизимида маълумотлар тўплами кўринади. Масалан, агар биринчи маълумот тўплами Меркатор проектига эга бўлса, маълумот рамкасида кўрсатилган бошқа барча маълумотлар тўплами худди Меркатор проектига эга каби намойиш этилади/displayed. Бу маълумот тўплами бошқа харита проектига эга бўлса ҳам! Бу шуни англатадики, бир хил ҳудудга эга турли проектларни кўрсатадиган  маълумотлар тўплами бир-бирини ҳали ҳам қоплаши мумкин. 



Нима учун 2с машқдаги маълумотлар тўплами устма-уст тушмаган?



‘Unprojected’ (1 ва 2 машқлар) маълумот рамкасига қўшилган маълумот тўплами проектланмаган, бу шуни англатадики, маълумот тўплами проектланмасдан қолган (Маълумот рамкаси Unknown координата тизимида белгиланган), шунинг учун ҳам турли хил проектларга эга маълумотлар тўплами намойиш ойнасида/view window турли жойларда кўрсатилган.



‘On-the fly’ проекти тўғрисида ёдда тутиш:

•	Умумий координаталар тизими, бўш маълумот рамкасига қўшилган биринчи маълумот тўпламининг мажбуриятини бажармаслик /default ёрдамидаги координата тизими ҳисобланади!!

•	Шуни билингки, on-the-fly projection маълумот тўпламининг координаталар тизимини ўзгартирмайди!! Бу фақатгина намойиш ойнасида кўрсатилган маълумот тўпламини усулини ўзгартиради!!

•	Агар маълумотлар тўплами фазовий таҳлилда турли хил координаталар тизимларига эга бўлса, жуда аниқ натижани олиш ва хатоликлардан қочиш учун сиз уни худди шундай координата тизимига ўзгартиришингиз керак!!



Маълумот рамкасининг координата тизими ва харита бирлиги



Маълумот рамкаси хоссалари/Data Frame Properties ойнаси бир нечта хоссаларни ўз ичига олувчи ҳар хил турдаги хоссаларни сақлайди. Бу хоссларнинг созлаш қурилмалари қандай қилиб сизнинг маълумот тўпламингизда кўрсатилганлигини аниқлайди, аммо маълумот тўпламининг  хоссасаларини эмас. Харита проектининг контекстида энг асосий иловалар General ва Coordinate System ҳисобланади.

ҚЎЛЛАНМА: 



1. Маълумот рамкасини ўнг тугмасини сичқонча ёрдамида босинг ва хоссалар ойнасини/properties window очинг.



2. General иловасини босинг. Бирликлар/Units рамкасида сиз харита/map ва шакл (ёзувлар)/display бирликларини ўрнатишингиз мумкин. Хариталар бирликлари (координата тизимининг бирликлари) маълумот тўпламининг геометрик хоссаларини яъни объектларнинг майдон ва периметрини ҳамда жойларнинг  координаталарини ҳисоблаб чиқади. Шакл(ёзувлар) кўз билан кўриш/визуал орқали  намойиш этиш учун фойдаланилади. Улар намойиш ойнасининг/view window пастки қисмида кўрсатилади. Агар сиз Measure асбобидан харитада масофани ўлчамоқчи бўлсангиз улардан фойдаланишингиз мумкин.



3. Coordinate System иловасини танланг (4-расм). Тепа қисмдаги рамка маълумот рамкасининг мавжуд координата тизимини кўрсатади. Бу координата тизими маълумот рамкасида берилган барча/all маълумотлар тўпламини проектлаш учун  фойдаланилади. Агар сиз маълумот рамкасининг координата тизимини  ўзгартирмоқчи бўлсангиз, пастки қисмдаги рамкада папкаларнинг бирини проектлаш учун танланг. Шуни эсда тутингки, янги координата тизими маълумот рамкасидаги барча маълумотлар тупламига қўлланилади 







[image: ]



4-расм. Маълумот рамкасининг координата тизими./ The coordinate system of the data frame.
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3а. ‘Unprojected’ маълумот рамкасини актив ҳолатга келтиринг. Тасвир маштабини [image: ]тўлиқ ўзгартиринг. Маълумот рамкаси хоссалари ойнасини очинг. Бу маълумотлар рамкасини 'Rijksdriehoekstelsel' га проектланг. Тасвир ойнасида маълумотлар тўпламининг йўналишига/orientation нима содир бўлганини тушунтиринг.





‘Projected’ маълумот рамкасини актив ҳолатга келтиринг. 





3b. Маълумот рамкаси хассалари ойнасини очинг. Бу маълумот рамкасининг айни вақтдаги координата тизими қандай?



3с. ‘Netherlands_mercator’ маълумотлар тўпламини ‘unprojected’ маълумот рамкасидан бўш маълумот рамкасига судраб ўтказинг/drag. Энди эса маълумот рамкасини координата тизими қандай?





Маълумот рамкасига ‘World’, ‘Alterra’ ва ‘Cities’ маълумотлар тўпламини қўшинг. Warning пайдо бўлгач OK ни босинг.





3d. Alterra ва Buenos Aires ўртасидаги масофани ўлчанг. 





Маълумот рамкаси проектини/Data frame projection Robinson га ўзгартиринг (Projected coordinate systems\World\Robinson).





3e. Alterra ва Buenos Aires ўртасидаги масофани яна ўлчанг. Масофа аввалги ўлчагандан фарқ қиладими? Жавобингиз тушунтиринг.













ГЕОМЕТРИК ХАТОЛИКЛАР



Сиз сферик юзани текис юзага проектлаганингизда, ҳудуд/area, шакл/shape, масофа/distance ва йўналиш/direction каби геометрик хоссаларни хатоликларини яратасиз. Турли хил проектлаш ҳар хил турдаги хатоликларга сабаб бўлади. Биз уларни тўрт хилини фарқлай оламиз:

· Конформал проектлаш/Conformal projects 



Конформал проектлаш ўзига хос/local шаклни сақлайди. Фазовий боғлиқликни ёритиб берувчи индивидуал бурчакларни сақлаш учун, конформал проектлаш харитада 90 градусда кесишиш учун меридианлар/meridians ва параллелларни/parallels кўрсатиши керак. 



· Эквивалент проектлаш/ Equivalent projections



Эквивалент (тенг-ҳудуд) проектлаш намойиш этилган объектларнинг ҳудудини сақлайди. Буни бажаришда, бошқа хоссалар – шакл, масофа ва йўналиш силжиган бўлади. Эквивалент проектлашда, меридианлар ва параллеллар тўғри бурчакда кесишмаслиги мумкин. 

· Эквидистант проектлаш/Equidistant projections



Эквидистант хариталар айрим нуқталар орасидаги масофани сақлайди. Масофа бутун харитада ҳеч кандай проектлаш орқали тўғри сақланмаган. Масофа кўпинча фақат параллеллар меридианларга ўлчанганда тўғри ҳисобланади. 



· Тўғри-йўналиш проекти/ True-direction projections



Тўғри-йўналиш хариталари йўналишни сақлайди, бу шуни англатадики, ерда йўналиш ўлчамлари харитадаги шу йўналиш ўлчамлари каби қилинганлигидир. Азимут (текис) проектлаш ҳар доим тўғри-йўналишдир. Конформал проектлаш каби Меркатор проектлаш ҳам тўғри-йўналишдир. 



Мамлакатнинг шакли ва ўлчамларига ҳар хил проектлаш турларининг таъсири 5-расмда кўрсатилади. Ҳар бир проектлаш учун проект деталлари яъни мамлакатнинг узунлиги, эни ва ҳудуди 2-жадвалда берилади. 5а-расм мамлакатни RD проектида намойиш этади. Бу ўзига хос проектлаш ҳисобланиб, мамлакатни текис харитада минимал хатолик билан намойиш этиш учун махсус ишлаб чиқилган. RD проекти текис проектлаш бўлиб у шакл ва йўналишни сақлайди. Масофа ва майдон силжишга/хатоликка эга. Шунга қарамай, мамлакатни нисбатан кичик майдонни қоплайди, хатоликлар жуда кам (масалан, нотўғри ҳисоблашлар бир километрга 10 сантиметр масофода). Биз мамлакатни шакли ва ўлчамларни RD проекти ҳақиқий баҳолаб берганлигига тахмин қиламиз. 5b, 5d ва 5f расмларида мамлакатни континентал (Европа) масштаби даражасида фойдаланиш учун коник проектида тузилганлиги намоён этилган. 5c, 5e ва 5g расмларида мамлакатни глобал масштаби даражасида фойдаланиш учун цилиндрик проектида тузилганлиги акс эттирилган. 



5с-расмда глобал масштаби даражасида фойдаланиш учун тузилган конформал проекти (Mercator) акс эттирилган. Бу ерда мамлакатнинг шакли сақланганлиги кўрсатилган. Ўлчам хатолиги RD проектига сиқилган тарзда таққосланган: ҳудуд 268%га катталашган, узунлик ва кенглик эса 162% га катталашган. 5b – расм ҳам мамлакатнинг конформал проектини кўрсатади, у континентал масштаби даражасида фойдаланиш учун тузилган. Бу ерда ҳам шакл сақланган, узунлиги, эни ва ҳудудида хатоликлар ҳали ҳам мавжуд лекин силжиш/хатоликлар Mercator проектига сиқилган тарзда таққосланганда бирмунча кам. 



5e-расм (глобал масштаби даражасига эквивалент проекти) шаклан ўзгарган давлатни кўрсатади: шимол ва жануб томондан сиқилган ва шаркий-ғарб томонга чўзилган. Шунга қарамай, RD худудига деярли тенг. 5d-расмда континентал эквивалент проекти фойдаланилган мамлакатни кўрсатилган. Ҳудуд 5e-расмни ҳудудига деярли ўхшаш, лекин шакл ва масофа яхши ҳолатда сақланган.

5g-расм мамлакатнинг глобал, эквидистант проектини кўрсатади. Мамлакатнинг узунлиги аниқ берилган. Шакли ва ҳудуди хатоликка эга. Мамлакат шарқий – ғарб йўналишига сиқилган ва ҳудуд RD ҳудудига нисбатан 19.5%га кичикроқ. 5f – расмда эквидистант проекти континентал масштаби даражасида кўрсатилган. 



Бу мисоллар харита проектларининг масштаб даражасида боғлиқ ҳолда берилган. Бу яъни сиз маълумотлар тўпламини проектлаётганингизда жуда эҳтиёт бўлишингизни англатади. Агар сиз ўзига хос масштаб даражасида ишлаётган бўлсангиз, глобал масштаб даражасида фойдаланиш учун тузилган харита проектларини танламаслигингиз керак. Хатоликлар сиқилган тарзда бўлиши мумкин. Иккинчидан, сиз тадқиқотингиз учун керак бўлиши мумкин бўлган геометрик хоссалари силжимаган харита проектини танланг. Масалан, агар сиз ҳудуди жуда муҳим бўлган тадқиқот ишини бажараётган бўлсангиз, сизнинг малумотлар тўпламингизнинг харита проекти эквивалент эканлигига ишонч ҳосил қилинг. 

[image: C:\Users\GD\Desktop\new photo\C360_2014-05-30-19-11-29-687.jpg]





















































5-расм. Мамлакат етти хил проектлашда намоён этилган./ The country represented in seven different projections            





[image: C:\Users\GD\Desktop\new photo\C360_2014-05-30-19-27-48-971.jpg]

2-жадвал. Етти хил проектларда етти хил масофа ва ҳудудда мамлакатнинг натижаси. /Seven different projections of the country result in seven different distances and areas.



Келгуси машқда сиз мамлакатларнинг ҳудудлари ва шаҳарлари ўртасидаги масофаларни дунё харитасига турли проектларининг қандай таъсир қилишини ўрганасиз. Шаҳарлар орасидаги масофани ўлчаш учун Measure [image: ]асбобидан ва маълумотларни топиш учун Identify [image: ]асбобидан фойдаланинг.
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Бу машқни бажариш учун сизга ‘Mercator’, ‘Equivalent’, ‘Equidistance’ маълумотлар рамкаси керак бўлади. Alterra биносининг жойи ва дунёнинг энг катта шаҳарларининг жойлари, ҳар бир маълумот рамкаси турли проектга эга дунё харитасидан ташкил топган. Сиз ҳудуд маълумотларини бераётганингизда F_Area майдонидан фойдаланишга ишонч ҳосил қилинг. 



‘Mercator’ маълумот рамкасини актив ҳолатга келтиринг. 



4а. Масофаларни Alterra-Johannesburg ва São Paulo–Jakarta ўртаси ўлчанг. АҚШ/USA, Конго Демократик Республикаси (Заир)/the Dem. Rep. Congo (Zaire)нинг ҳудудларини ва дунё ҳудудини топинг. Топган маълумотларингизни 3-жадвалга ёзинг.





‘Equidistant’ маълумот рамкасини актив ҳолатга келтиринг. 





4b. Масофаларни Alterra-Johannesburg ва São Paulo–Jakarta орасида ўлчанг. АҚШ/USA, Конго Демократик Республикаси (Заир)/the Dem. Rep. Congo (Zaire)нинг ҳудудларини ва дунё ҳудудини топинг. Топган маълумотларингизни 3-жадвалга ёзинг.





‘Equivalent’ маълумот рамкасини актив ҳолатга келтиринг.





4c. Масофаларни Alterra-Johannesburg ва São Paulo–Jakarta орасида ўлчанг. АҚШ/USA, Конго Демократик Республикаси (Заир)/the Dem. Rep. Congo (Zaire)нинг ҳудудларини ва дунё ҳудудини топинг. Топган маълумотларингизни 3-жадвалга ёзинг.











		

		Mercator

		Equidistant

		Equivalent

		True dist./ area



		Alterra – Johannesburg

(km)

		

		

		

		8,979



		São Paulo – Jakarta (km)

		

		

		

		15,646



		Area USA (km2)

		

		

		

		9,631,418



		Area Dem. Rep. Congo

(km2)

		

		

		

		2,345,410



		Area World (km2)

		

		

		

		148,939,100







3-жадвал. Турли проектлардан фойдаланилган масофа ва ҳудудни таққосланиши./Distance and area comparison using different projections.



		

5.



5а. •	Эквидистант проектлаш Alterra ва Johannesburg ўртасидаги масофага янг яхши баҳони беради. Лекин São Paulo - Jakarta ўртасидаги масофа учун қийинчиликлар яратади. Бошқа иккита проектлаш яхшироқ баҳо беради. Нима учунлигини тушунтириб беринг. 





5b. Эквивалент проектлаш иккита давлатнинг ҳудудларини ва дунё чегараси бўйича энг яхши баҳони беради. Mercator проектлаш ўзининг катта ўлчам хатоликлари маълум (масалан, AКШ ҳудуди, 3 -жадвал). Лекин Конго Демократик Республикаси  ўлчамлари тўғри ўлчамга жуда яқин, хатоликлар жуда кичик бўлиб кўринади. Нима учунлигини тушунтиринг.





5с. São Paulo – Jakarta нинг тўғри масофасини ҳамда Mercator ва Equivalent проектларининг ўлчанган масофа ўртасидаги фарқни тушунтиринг. 













		

6.



‘Geometric distortions’ маълумот рамкасини актив ҳолатга келтиринг. 



6а. Проектлашлар ўртасидаги асосий фарқларни кўрсатинг.





6b. ‘world_eqdist’ маълумот тўпламини белгилашдан чиқаринг/uncheck. ‘world_eqarea’ маълумот тўпламининг белги/symbol иловасини тангланг. Symbol Selectorдан Hollow ни танланг. Энини/width 2 га ўзгартиринг. Экваториал минтақаларни катталаштиринг (Northern South America, Central Africa, Indonesia).

Топилмаларингизни ёзинг. 





































































































4-амалий машғулотни бажаргандан кейин ўз-ўзини

текшириш учун саволлар











































Саволлар



1. Проектлаш/projection га таъриф беринг. Эллипсоид нима? 

2. Маълумотлар элементи/Datum га таъриф беринг. 

3. Харита проектига/map projection таъриф беринг (Chang, 2006). 

4. Харитани проектлаш нимани ўргатади? 

5.  4-амалий машғулотни ўзлаштиргандан кейин қандай вазифаларни бажара оласиз?

6. Проектни аниқлашда қандай координаталар тизимидан фойдаланасиз? 

7. Проектланган координата тизимининг бирлиги нима ҳисобланади? (1d)

8. ‘On-the-fly projection’ нимани англатади? 

9. Умумий проектлаш нимани билдиради?

10. Нима учун 2с машқдаги маълумотлар тўплами устма-уст тушмаган?

11. ‘On-the fly’ проекти тўғрисида нималарни ёдда тутиш лозим:

12. Сиз сферик юзани текис юзага проектлаганингизда, ҳудуд/area, шакл/shape, масофа/distance ва йўналиш/direction каби геометрик хоссаларни хатоликларини яратасиз. Турли хил проектлаш ҳар хил турдаги хатоликларга сабаб бўлади. Уларни қандай турлари мавжуд? 

13. Конформал проектлашга/Conformal projects ва 	Эквивалент проектлашга/ Equivalent projections таъриф беринг.

14.  Эквидистант проектлашга/Equidistant projections ва Тўғри-йўналиш проектлашга/ True-direction projections таъриф беринг. 

15. Нидерландиянинг шакли ва ўлчамларига ҳар хил проектлаш турларининг таъсири 5-расмда кўрсатилган. 5a, 5b, 5c, 5d, 5e, 5f, 5g, расмларига таъриф беринг. 

16.Шаҳарлар орасидаги масофани ўлчаш учун ва маълумотларни топиш учун  қандай асбоблардан фойдаланилади?









  .





























5 – АМАЛИЙ МАШҒУЛОТ









ХАРИТА ТАҚДИМОТИ
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КИРИШ 



ArcMap да хариталар фазовий маълумотларга асосланади. Фазовий маълумотлар қайси объектларни намойиш этишини аниқловчи атрибут маълумотлари билан бирга ер юзасида географик объектлар ва жойлашиш ўрни ҳамда уларнинг ўртасидаги боғлиқликлар тўғрисида маълумотларни билдиради.



Сиз бу комплекс маълумотларни жадваллар ёки рўйхатга кўра хариталардан кўпроқ самарали фойдаланишингиз мумкин чунки, хариталар рангларни, нақшларни интерпретация қилиш ва фазовий алоқаларни ажрата олиш каби табиий имкониялардан фойдаланиш устунлигига эга. Агар сиз маълумотларингизни харитада қулай тарзда намойиш этадиган бўлсангиз, олдин кўриш имконияти бўлмаган фазовий тақсимланишларни, алоқаларни ва йўналишларни кўришингиз мумкин. Сизнинг хариталарингиз қарор қабул қилишда ва муаммоларни ечишда ёрдам бериши мумкин. Қолаверса, улар сизнинг маълумотларингизни ва натижаларни бошқаларга кўпроқ фойдали равишда етказишга ёрдам беради. 



Географик хариталарни яратишингизда унда қандай маълумотларни намойиш этишни танлаш жуда муҳим қарор ҳисобланади. Сизнинг маълумотларингизни белгилаш учун объектларни намойиш этишда тўғри белги ва рангларни танлашни жалб этади. Бу уларнинг атрибутлари ва атрибут қийматларига боғлиқ ҳолда объектларни гуруҳлашни ёки синфлашни тақозо этади.  



________________________________________________________________________



Ушбу амалий машғулотда:



· Фазовий маълумотларни белгилаш;

· Матн ва графикларни харитага қўшиш;

· Маълумотлар тўпламини маркировка қилиш;

· График белгилари ва атрибутлардан фойдаланиш (Bertin);

· Харитани тақдим этиш учун 12 қадамдан фойдаланиш ўргатилади.



Вазифалар



Ушбу амалий машғулотни ўзлаштиргандан кейин қуйидагиларни бажара оласиз: 

· Харитани тақдим этиш учун 12 та қадамдан фойдаланиш;

· Маълумотларни символлаштириш: географик белгиларни/символларни ва атрибутларни тўғри танлаш.

· Тўлиқ форматдаги харитани яратиш.



ArcMap ҳужжати:  	Map presentation1.mxd, Map presentation2.mxd 

ва Map presentation3.mxd

Адабиёт: 			Chapter 10 Data display and cartography

Chapter 11: section 11.5 Geographic visualization



МАЪЛУМОТНИ БЕЛГИЛАШ УЧУН БЕЛГИЛАР РЕДАКТОРИДАН ФОЙДАЛАНИШ



Географик хариталарни яратишингизда унда қандай маълумотларни намойиш этишни танлаш жуда муҳим қарор ҳисобланади. Сизнинг маълумотларингизни белгилаш учун объектларни намойиш этишда тўғри белги ва рангларни танлашни жалб этади. Бу уларнинг атрибутлари ва атрибут қийматларига боғлиқ ҳолда объектларни гуруҳлашни ёки синфлашни тақозо этади. Символлар билан кўрсатиш/symbolization маълумотларни ўрганиш, тушуниш ва таҳлил қилиш учун кучли асбоб ҳисобланади.



Белгилар редактори/Symbology editor



1 – амалий машғулотда белги редактори/Symbology editor муҳокама қилинган эди. Бу амалий машғулотда ‘маълумотларингизни белгилаш’ / ‘Symbolizing your data’ қисмини қайта яна ўрганиш имконияти мавжуд.



Сиз намойиш ойнасида/view window (1-амалий машғулотга қаранг) маълумотлар тўламини қандай бошқариш учун Layer properties ойнасидаги Symbology иловасидан фойдаланасиз. Symbology editor очилганда сиз ҳар бир маълумот тўплами учун харита турини/map type сизнинг харитангиз намойиш этадиган маълумотларнинг турига асосланиб танлашингиз мумкин. Танлаш учун ҳар хил харита турлари ArcMapда мавжуд. 

[image: ]





































1-расм. Символлар редактори, бу ерда намойиш этилаётган харитангиз усулини ўзгартиришингиз мумкин./ The symbology editor; where you can change the way your data is displayed.





Объектлар/Features:

Маълумотлар тўпламида барча объектлар single symbol орқали белгиланади. 



Категориялар/Categories:

· Unique values of one field: битта атрибутнинг (атрибут=майдон) қийматларидан фойдаланиб категорияларни/синфларни намойиш этади;

· Unique values of many fields: 3 та атрибутгача бўлган ноёб атрибут комбинацияларининг қийматларидан фойдаланиб категорияларни/синфларни намойиш этади; 

· Match to symbol in a style: Услубда белги рўйхатидаги символларни атрибут қийматларига мослаштириш орқали категорияларни/синфларни намойиш этади;



Миқдорлар/Quantities:

· Graduate color: миқдор қийматлари билан атрибутда белгиланганидек ранглар шкаласидан фойдаланиб моқдорларни намойиш этади.  

· Graduate symbol: атрибутни белги ўлчами орқали аниқловчи символ ўлчамининг ўзгаришидан фойдаланиб миқдорларни намойиш этади. 

· Proportional symbol: аниқ қийматни кўрсатиш учун символ ўлчамлари орқали аниқловчи символ ўлчамининг ўзгаришидан фойдаланиб миқдорларни намойиш этади; 

· Dot density: атрибут қийматларида белгиланганидек нуқта зичлигидан фойдаланиб миқдорларни намойиш этади. 



Диаграммалар/Charts:

· Pie: ҳар бир объект учун кўп сонли атрибутларда белгиланганидек айланма диаграммани намойиш этади; 

· Bar/Column: ҳар бир объект учун кўп сонли атрибутларда белгиланганидек чизиқча/bar ёки устун/column шаклини намойиш этади. 

· Stacked: ҳар бир объект учун кўп сонли атрибутларда белгиланганидек трубасимон /stack шаклидаги диаграммани намойиш этади.



Кўп сонли атрибутлар/Multiple attributes:

· Категорияли миқдор: бир ёки бир неча атрибутларни ҳар бир категория/класс учун миқдорни кўрсатади.



		

1. 



‘Map presentation1.mxd’ ҳужжатини ArcMapда очинг. ‘Wag_south1’ маълумот рамкасини актив ҳолатга келтиринг ва ‘Soil_types’ маълумот тўпламининг Symbology редакторини очинг.









1а. ‘Soil_types’ маълумотлар тўпламини кўрсатиш учун қандай турдаги харитадан фойдаланилган?





1b. Бу ранг нимани акс эттиради?













Харита турлари ва маълумот масштаблари/Map types and data scales



ҚЎЛЛАНМА:



1. [image: ]Малумот рамкасини актив ҳолатга келтиринг, маълумотлар тўпламини текширинг ва Symbology редакторини очинг (Layer properties ойнасида)

2. Харита турини/map type танланг, маълумотни кўрсатиш учун Values легендасидаги пастки рўйхатдан атрибутни танланг. Categories => ‘unique values‘ни танлаганингизда ‘add all values’ да ‘all other values’ ни белгиламасликни/uncheck унутманг. 

3. Symbology редакторида символни ўзгартириш учун уни икки марта босинг. Symbol Selector ойнаси пайдо бўлади (2-расм). 2-расм. Символ танлагич/Symbol Selector





4. Symbology selector олдиндан аниқланган символларни танлашни таъминлаб беради. Буларни  Preview ёки Properties тугмаларини танлаш орқали ўзгартириш мумкин. 

5. Сиз шунингдек, олдиндан аниқланган символлар тўпламини (масалан: ўрмон/forestry, тупроқ/soils ва геология/geology) More Symbols тугмасини босиш орқали танлашингиз мумкин. 

Изоҳ: table of contents даги символни танлаш орқали асосий рангларни ҳам ўзгартириш имконияти мавжуд. 



		

2.



Бу машкда сиз турли хил хариталар танлаш оркали маълумотлар тўпламини кўрсатиш учун ўзгартирасиз.





2a. ‘Soil_types’ маълумотлар тўплами учун куйидаги шартли белгини тузинг: 

                                                                             Харита тури/Map type:Unique value 

                                                                             Майдон қиймати/Value field: Area



Бу харита тури ‘area’ атрибутини белгилашда мантиқий танлов ҳисобланадими? Жавобингизни тушунтиринг. 





2b. Харита турини ‘Graduated color’га ўзгартиринг; Value майдон учун ‘Area’ ни танланг. Нима учун ‘Soilcode’ атрибутини graduated colors да тақдим этишни имконияти мавжуд эмаслигини тушунтиринг. 





2с. ‘Soilcode’ атрибутини белгилаш учун мос бўлган харита турини/map type танланг. 



2d. Symbology редакторининг Label field да тупроқ объектлари учун қисқа ном беринг. Ҳар хил синфларга индивидуал тарзда ранг беринг; ўзингизга ранг танланг ва шартли белгини харитага қўлланг. 











ХАРИТА ТАҚДИМОТИ УЧУН 12 ТА ҚАДАМЛАР



Харитани яратиш ва уни такдим этиш осон иш эмас. Бу бўлим сиз учун харитани тақдим этишнинг кўрсатмасини беради. Бу кўрсатма харита тақдимотининг 12 та қадамлари/ the 12 steps to present a map деб номланади. Буни бажаришда сиз АrcMapдан фойдаланасиз.



Харитани тақдим этишда қуйидаги 12 та қадамлар/саволларга жавоб берилади:



1. Харита кандай мақсадга/purpose хизмат қилади?

2. Фойдаланувчи гуруҳ/user group нимага йўналтирилган? 

3. Харитани номи/title қандай бўлиши керак?

4. Шартли белгиларда кандай фазовий компонентлар/spatial components кўрсатилган бўлиши керак?

5. Компонентлар ўртасидаги иерархия / hierarchy between нимадан иборат?

6. Бу компоненларнинг маълумот маштаби/data scale нима ҳисобланади?

7. Ҳар бир компонент нечта синфни/classes ўз ичига олади?

8. Қандай график символи/graphic symbol қўлланилиши мумкин?

9. Қандай график атрибутлар/graphic attributes ташкил топган бўлиши керак?

10. Шимолий кўрсаткични/North arrow қўшиш.

11. Маштаб панелини ёки харита координатасини қўшиш.

12. Маълумотлар манбасини, матн ва графикни қўшиш.



Маълумот масштаби / Data scale



Объектларнинг атрибут қийматлари сифатий ёки миқдорий ҳисобланади. Маълумот масштаблари қуйидагилар ҳисобланади: 



Nominal: Табиатан сифатий/qualitative атрибут қийматлари турли хил ҳисобланади, битта аспектсиз ҳам бошқалар (масалан: ердан фойдаланишнинг шакли) дан кўра кўпроқ муҳим бўлади. 



Ordinal: Сифатий/qualitative атрибут қийматлари бир-биридан фарқланади, лекин бу ерда битта йўл уларни тартибга солиш учун муҳим, баъзилари бошқаларга нисбатан муҳимроқ/кучлироқ ҳисобланади (масалан, йўлнинг муҳимлиги);



Interval: Миқдорий/Quantitative атрибут қийматлари турли хил ва тартибга солинган бўлиши мумкин. Индивидуал ўлчамлар ўртасидаги масофа аниқланган бўлиши мумкин (масалан: Цельсий/Celsius ҳарорат шкаласи)



Ratio: Миқдорий атрибут қийматлари турли хил ва тартибга солинган бўлиши мумкин. Атрибут сифат белгилари фарқланган ва тартибланган бўлиши мумкин. Индивидуал ўлчамлар ўртасидаги масофа аниқланган бўлиши мумкин ва бу индивидуал ўлчамлар бир - бирига боғлиқ бўлиши мумкин. Улар шунингдек, мутлоқ нольга эга бўлади (масалан: ташриф буюрувчилар сони).



График белгилар/ Graphic symbols



Харитада тасвирланган фазовий маълумотларда ҳар доим реал ҳодисалар назарда тутилади. Улар маълум нуқталарда ўлчанган тепаликлар, автомагистрал тизими бўйича ўлчанган йўл-транспорт ҳаракатлари, ёки ҳудудларда истеқомат қилувчилар сони бўлиши мумкин. Биз нуқта, чизиқ ва ҳудуд жойларни тасвирловчи объектларни нуқта/point чизиқ/line ва ҳудуд (полигон)/area (polygon) орқали фарқлай оламиз. 



График атрибутлар/Graphic attributes



Символлар орасидаги барча фараз қилинадиган фарқларни қуйидаги 6 та график вариантлари орқали жамлаш мумкин (Bertin, 1983, 3 - расм):



•	ўлчам/size 

•	кулранг қиймат/grey value

•	текстура/textura

•	ранг тури/color hue 

•	ориентация/orientation 

•	шакл/shape



[image: ]

3-расм. Учта график символлар ва олтита график атрибутлар/Three graphic symbols and six graphic attributes.



График атрибутлари тасодифий тарзда/randomly ишлатилиши мумкин эмас. Харитадан фойдаланувчи орқали турли йўлларда ҳар бири қабул қилинади ва улар фойдаланиш хоссасига мос ҳолда ўзгартирилади. Масалан, рангдаги фарқ, ориентация ёки шакл, сифат ёки хоссасидаги фарқни изоҳлайди. Лекин ўлчамда ёки рангдаги қиймат сифатда ёки миқдордаги фарқ каби изоҳлайди. Маълум бир график атрибутни танлаш харитада тақдим этилган атрибутнинг маълумот шкаласига боғлиқ бўлади. 4-расм график атрибутларнинг рўйхати берилган бўлиб, қўпинча мос келадиган ҳар хил хоссаларни идрок этишни намойиш қилиш ҳамда бу маълумотлар шкаласи ва график атрибутлар ўртасидаги боғлиқликни кўрсатади.



[image: ]

4-расм. Маълумотлар шкаласи ва график атрибутлар ўртасидаги боғлиқлиқ./Relation between data scale and graphic attributes.



Хаританинг шартли белгиларини тайёрлаш (1–2, 4–9 қадамлар) /Preparing the map legend (steps 1 - 2, 4 - 9)



Фазовий маълумотларингизнинг харитасини яратишдан аввал, сиз харитангизнинг мақсади ва фойдаланувчилар гуруҳи ҳақида ўйлашингиз керак. Масалан, ҳарбийда фойдаланиладиган топографик харита оддий аҳоли учун фойдаланиладиган топографик харитадан фарқ қилади, чунки ҳарбийларни бошқа турдаги топографик маълумотлар (масалан: йўлларнинг эни) қизиқтиради, оддий аҳолини эса (йўллар иерархияси) қизиқарли. Бундан ташқари, топографик харита ердан фойдаланишни режалаштиришда жуда фойдали ҳисобланади, лекин курьер учун бундай эмас. Топографик харита биринчи навбатда йўлларга қаратилмаган, у курьерга фойдали бўлиши учун жуда кўплаб чалғитувчи маълумотларни ўзида сақлайди. Нидерландиянинг ер шаклини ҳар хил турда кўрсатиб берувчи мактаб болалари учун мўлжалланган/лойиҳаланган харита атроф муҳит муҳофазаси бўйича шуғулланувчи мутахассис фойдаланадиган ер шакли харитасига қараганда жуда оддий (деталларда, шунингдек терминологияда) тузилган бўлиши керак. Харитада тақдим этилаётган фазовий маълумотларнинг жиҳати хаританинг мақсадига жавоб бериши ва фойдаланувчи гуруҳига мувофиқ бўлиши керак. 



Маълумот кўриниши макет кўринишига қарши  



Кейинги машқлар давомида ArcMapда яратилган мавжуд харита ёрдамида харита тақдимотининг 12 та қадамларини/ the 12 steps to present a map амалиётда қўллайсиз. ArcMap харита кўринишининг 2 та йўлини таъминлайди:

· Маълумот кўриниши

· Макет кўриниши



Ҳар бир кўриниш харитада маълум йўналишларда қарашга ва ўзаро таъсир қилишга имкон беради. 



Маълумотлар тўпламингизни ‘тез кўриб’/’quick look’ чиқмоқчи бўлсангиз маълумот кўринишини/data view танланг. Сиз шу вақтгача маълумот кўринишида  ишлагансиз. Маълумот кўриниши тадқиқ қилиш, намойиш этиш ва маълумот бўйича сўров ўтказиш учун мақсадли кўриниш ҳисобланади. Бу кўриниш макет кўринишида яъни харита номланишини, шимолий кўрсаткични ва масштаб панелини аниқроғи барча харита элементларини сақлаган ҳолда/excludes all the map elements on the layout ҳамда оддий харита маълумот рамкаси учун мўлжалланган маълумотлар тўпламингизга имкон беради. 



Харитани тайёрлаётганингизда/ preparing your map яъни уни деворга осишда, ҳисоботга қўйишга ёки сайтда чоп этиш давомида сиз макет кўринишида/layout view ишлашни хохлашингиз мумкин. Макет кўринишида яъни сиз харита элементларини тартибга солиш ва жойлаштириш мумкин бўлган вертуал саҳифани кўрасиз/ you'll see a virtual page upon which you can place and arrange map elements. Сиз маълумот кўринишида деярли ҳамма нарсаларни бажаришингиз, шунингдек якуний харитангиз лойиҳасини яратишингиз мумкин. 



ҚЎЛЛАНМА:



1. Сиз menu bar даги View менюси орқали маълумот кўриниши/data view ва макет кўриниши/layout view ўртасида ўзгартиришингиз мумкин.

2. Ёки view window пастки қисмида чапда жойлашган иккита тугмадан фойдаланиб бу иккита кўринишни алмаштиришингиз мумкин. 



		

3.



‘Map presentation2.mxd’ ҳужжатини ArcMapда очинг. Бу ҳужжат Soil map – Wageningen south деб номланган жанубий Вагенинген ҳудудининг тупроқ харитасини ўз ичига олади. View windowда layout viewни ҳосил қилинг.  





3a. Бу тупроқ харитаси учун харита мақсади ва фойдаланувчилар гуруҳига мисол келтиринг. 











Харитангизнинг мақсади ва фойдаланувчилар гуруҳига асосланган ҳолда сиз харитангизда (шу йўсинда шартли белгилар ҳам) фазовий компонентлар/spatial components (маълумотлар тўплами) масалан, йўллар, ердан фойдаланиш, тупроқ турлари, шартли белгиларда компонентларнинг иерархиясидан/hierarchy ташкил этилишига қарор берасиз. Тупроқ харитасининг шартли белгилари иккиламчи маълумотлардан яъни қурилиш ҳудудлари ёки йўллардан эмас, балки тупроқ туриларидан бошланиши керак. Сўнгра, бу компонентларнинг маълумот масштабини/data scale аниқлайсиз. Бу муҳим, чунки маълумот масштаби символларни (график белгилар ва атрибут) аниқлайди, бу эса фазовий маълумотларни намойиш этишда мос ҳисобланади. Ундан кейин ҳар бир компонентда мавжуд бўлган категория(синф) сони/ number of categories(classes) билан давом эттирасиз. Катта йўлларни иккинчи даражали йўлдан ажратишингиз керакми ёки йўқми? Агар ‘ҳа’ десангиз, катта йўлларни ташкил этувчи компонент қийматлари ва иккинчи даражали йўллар қийматлари ажратилган синфлардан шу йўсинда турли символларга тегишли. Компонент синфларнинг сони харитангизнинг аниқ мақсадига боғлиқ бўлади. Харитада фазовий компонентларни қандай тақдим этишни ҳал қилиш якуний қадам ҳисобланади. Компонентларнинг маълумот масштабига мувофиқ равишда мос график белгиларни/graphic symbols ва атрибутларни/attributes танланг.



		

4.



Сиз бу машқда ArcMapда яратилган ‘харита тақдимотининг 12 та қадамларини’/ ‘12 steps to present a map’ амалиётда бажарасиз. 



Намойиш ойнаси макет кўринишида/layout view эканлигига ишонч ҳосил қилинг. Агар сиз харитангизни каттароқ вариантда (тўлиқ экранда) кўрмоқчи бўлсангиз,  menu bar дан File => Print Preview ни танланг.



Бу ерда ўрганилаётган ҳудуд жанубий тупроқ харитаси намойиш этилган.



4а. 1-жадвалга бу харита қандай яратилишининг 4 - 9 қадамларини тасвирланг. 





4b. 3 ва 4 расмларга мувофиқ танланган график атрибутлар ҳақида сизнинг фикрингиз қандай? 











		4-қадам

Фазовий компонентлар

		5-қадам

Компонент иерархияси

		6-қадам

Маълумот масштаби

		7-қадам

Компонент синфи

		8-қадам

График символлар

		9-қадам

График атрибутлар



		

		

		

		

		

		



		

		

		

		

		

		



		

		

		

		

		

		



		

		

		

		

		

		





1-расм. ‘харита тақдимотининг 12 та қадамлари’ усули бўйича 4 дан 9 гача бўлган қадамлар/ Steps 4 to 9 of the ‘12 steps to present a map’ approach.



Бу машқни тугатганингизда ArcMap ҳужжатини сақламасдан ёпинг.



Харита макети ва харитани босмадан чиқариш (3 & 10 – 12 қадамлар)



4-9 қадамларни бажариш давомида сиз харитангизда тақдим этишни хохлаган фазовий компонентларни (маълумотлар тўплами) яъни компонент иерархиясини, атрибут масштабини, синфлар ва символларни аниқлашингиз керак. Шунингдек, сиз балки харитангизда киритишни хохлаган маълумотлар билан яъни маълумотлар тўпламининг объектларини этикеткалашингиз керак. Эҳтимол, сизнинг харитангиз ҳали босмага беришга тайёр эмасдир. Унда ҳали ҳам баъзи бир муҳим харита элементлари етишмаслиги мумкин: номланиши/title, масштаб панели/scale bar, шартли белги/legend, шимолий кўрсаткич/north arrow, тавсифловчи матн/descriptive text ва баъзи графиклар/graphics.

Макет/layout сизга харитангизда тақдим этишни хохлаган фазовий компонентларни ва харита элементларни йиғишга/ assemble, хохлаган дизайн бўйича лойиҳалашга/ arrange ва тайёр бўлганда босмадан чиқаришга/print имкон яратади. 

Макетлар ArcMapда сифатли тақдимотни ишлаб чиқиш учун осонлик яратади. Сиз ArcMap ҳужжатингизда ҳар қандай диаграммаларни ва жадвалларни биргаликда макет ичига биттадан кўп маълумот рамкасини жойлаштиришингиз мумкин. Агар кейин фикрингизни ўзгартирсангиз, макетда қўйилган талаб бўйича ҳар бир элементни қўшиш, ўчириш, ўлчамини ўзгартириш ва кўчириб ўтказишингиз мумкин. 

Бу бўлим макетни қандай яратиш тавсифи билан давом эттирилади ва унга хаританинг турли элементларни қандай қўшиш кераклиги ҳамда мустақил ҳолда макет ярата олганингизда машқ якунланади.          



Харита макетини яратиш 



ҚЎЛЛАНМА:



1. [image: ]Ҳужжатни очинг ва харитада тақдим этмоқчи бўлган маълумотлар тўпламини белгиланг.

2. View window да макет кўринишини/layout view жойлаштиринг. 

3. Меню панелида/ menu bar Insert текст менюсидан харитангизга элементларни қўшиш учун  барча керакли тугмаларни топишингиз мумкин (5-расм). Бу тугмалар фақатгина макет кўринишда бўлгандагина актив ҳолатда бўлишига эътибор беринг. 



Layout view актив ҳолатда бўлгандагина созлаш параметрини/settings ўзгартириш имконияти бўлади. Тасаввур қилинаётган маълумотлар тўпламининг ўлчамини ва жойини ўзгартириш мумкин бўлади. Макет кўринишида ўнг тугмани босган ҳолда макетнинг турини/type ва бетларни тузатиш параметрларини/page settings ўзгартириш мумкин.5-расм. Харита объекти тугмалари/Map feature buttons





Макетга маълумот рамкасини қўшиш



Макетнинг марказий элементи бу маълумот рамкаси ҳисобланади. Бу рамка маълумотлар тўпламингизни тақдим этади. Макетингизда биттадан кўп бўлган  маълумот рамкасига эга бўлишингиз мумкин. Оддий хариталар одатда битта маълумот рамкасига эга бўлади. Баъзи ҳолларда ўзгаришларни вақт билан кўрсатишингизга тўғри келади, масалан, мамлакатда ердан фойдаланиш 1980, 1990 ва 2000 йилларда. Агар иш шундай бажарилиш керак бўлса, у ҳолда Сиз харитага 3 та маълумотлар рамкасини қўшишингиз мумкин. Ҳар бир рамка ердан фойдаланишни тегишли даврига эга.

ArcMapда макетдаги table of contentsда мавжуд бўлган барча маълумот рамкалари фойдаланилади. Агар сиз table of contentsда  иккита маълумот рамкасига эга бўлсангиз, сиз беихтиёр иккита маълумот рамкасини макетда кўришингиз мумкин. 



Огоҳлантириш: макетдан шунчаки бирор бир маълумотлар рамкасини ўчириб ташлаш мумкин эмас. Агар бу ишни қилсангиз мундарижадан тегишли бўлган маълумотлар тўпламини, шунингдек бир вақтнинг ўзида бутун харита ҳужжатини entire map document ҳам ўчирган бўласиз!!! Агар сиз макетингизда кўп сонли маълумот рамкаси бўлишини хохламасангиз, сиз мундарижада битта маълумот рамкаси ичида маълумотлар тўпламини қайта тузишингиз керак бўлади ва қолган рамкаларни ўчириб ташлашингиз мумкин.

Макет кўринишида рамкаларнинг хоссаларини ўзгартириш имконияти мавжуд: рамканинг ўнг тугмасини босиб, Propertiesни танланг. Масалан сиз рамканинг

чегарасини ўзгартиришингиз, масштабни жойлаштиришингиз ёки координаталарни харитага қўшишингиз мумкин. 



Харита макетига шартли белгини қўшиш

Шартли белги/legend харитадан фойдаланувчига объектларни тақдим этишда харитада қандай символлар мавжудлигини билдиради. Макетда шартли белги мундарижада аввалдан фойдаланилган шартли белги билан боғлиқ ҳисобланади. Сиз маълумотлар тўпламининг белгисини/symbology ўзгартирсангиз у беихтиёр макетда шартли белгини ўзгартиради.

ҚЎЛЛАНМА: 



1. Меню панелидан Insert => Legend ни танланг (бу фақат layout view да бўлганингизда ишлайди) 

2. Пайдо бўлган ойнада, шартли белгига қўшмоқчи бўлган маълумотлар тўпламини танланг. Сиз шунингдек, шартли белгиларда (иерархия тўғрисида ўйланг) юқорига ва пастга қараган стрелкалар ёрдамида маълумотлар тўпламининг тартибини/order ўзгартиришингиз мумкин. Next ни босинг.

3. Қуйидаги ойнада шартли белгиларни ўрнатиш учун баъзи вариантлар пайдо бўлади. Истасангиз, ушбу вариантлар билан хохлаганингизча иш олиб боришингиз мумкин. 

4. Макетда жойлашган шартли белгини кўчириб ўтказиш ва уни ўлчамини ўзгартиришингиз мумкин.

5. Агар сиз натижадан қониқмасангиз, ҳар доим шартли белгини алмаштиришингиз мумкин. Макетдаги шартли белгининг ўнг тугмасини босинг ва пайдо бўлган менюдан Properties танланг. Legend Properties ойнаси очилади ва у ердан баъзи шартли белгиларни тартибга солишингиз  мумкин. 

Ҳар доим бирор маълумотлар тўпламининг номини table of contentsни танлаш орқали ўзгартиришингиз мумкин.  

Харита макетига шимолий кўрсаткични қўшиш/Adding a north arrow to a layout



Шимолий кўрсаткич хаританинг йўналишини билдиради.



ҚЎЛЛАНМА:



1. Menu bar дан Insert => North Arrow ни танланг (бу фақат layout view кўринишида бўлсангизгина амални бажаришингиз мумкин).

2. North Arrow Selector менюсидан шимолий кўрсаткичнинг стилини/style танлашингиз мумкин. 

3. Properties тугмасини танланг ва аниқ бир ўлчамга келтириш бурчагини /calibration angle ишга тушириш учун North Arrow ни босинг. Стрелканинг ўлчамини, стилини ва шрифтини ҳам ўзгартиришингиз мумкин.

4. OKни босинг ва шимолий кўрсаткични макетда мос жойга кўчириб ўтказинг. 



Харита макетига масштаб панелини қўшиш/Adding a scale bar to a layout



Масштаб панели/scale bar объектларнинг ўлчамини ва харитада объектлар орасидаги масофанинг визуал ишорасини таъминлайди. Масштаб панели бўлакларга бўлинган чизиқча ёки панелдан иборат бўлиб, ернинг узунлиги билан белгиланади. Одатда харита бирликларининг бўлинадиган сонлари яъни ўнли километрда ёки юзли милда белгиланади. Агар харита кенгайтирилса ёки қисқартирилса, масштаб панели тўғрилигича қолади. 



Масштаб панелини макетга маълумотлар тўпламидан ва шартли белгидан кейин қўшинг. 



Изоҳ: Макетга масштаб панелини қўшишдан аввал маълумотлар рамкасининг  харита бирликлари /map units метрда/meters ўрнатилганлигига ишонч ҳосил қилинг!!! Буни текшириш учун меню панелидан  View=>Data Frame=>Properties=> General ни танланг



ҚЎЛЛАНМА: 



1. Menu bar дан Insert => Scale Bar ни танланг (бу фақат layout view кўринишида бўлсангизгина амални бажаришингиз мумкин).

2. Сиз ичига ўрнатмоқчи бўлган масштаб панелини танланг ва OK ни босинг.

3. Макетга қўшилган масштаб панелининг ўлчамини ўзгартиришингиз ва кўчириб бошқа жойга ўтказишингиз мумкин. Масштаб панелининг жуда кичкина эмаслигига ишонч ҳосил қилинг! 

4. Properties ойнасини очиш учун масштаб панелининг устига икки марта босинг. 

5. Бу ойнада масштаб ва бирликлар /scale and units  ҳамда сонлар ва белгилар /marks and numbers иловалари муҳим ҳисобланади. 

6.  Scale and Units иловасида Тақсимлаш қиймати /Division value ни ўрнатиш мумкин (жуда кичик бўлмаган), number of divisions, number of subdivisions ва масштаб панелида қайта ўлчаниши керак бўлгандаги амалларни бажаради (‘adjust division value’ дан фойдаланманг, чунки тақсимлаш қиймати ‘round number’ да яъни 1 км, 500 м ва ҳоказо бўлиши мумкин). 

7. Масштаб панели бирликларини/units танланг. 

8.  Number and Marks иловасида сонли қиймат қанчалик пайдо бўлишини масштаб панелида аниқлаш ва уни қаерда жойлаштириш имконияти туғилади. 

9. Apply ва OK тугмаларини босинг.  



Харита макетига матн ва бошқа графикларни қўшиш/Adding text and other graphics to a layout



ҚЎЛЛАНМА: 



1. Сиз [image: ] Text ускунасидан сарлавҳа/titles учун матн/text ва бошқа тасвирловчи матнларни/descriptive text қўшиш учун фойдаланишингиз мумкин, шунингдек, чизиш/drawing асбобини қутича/boxes, айлана/circles ва стрелка/arrow каби графикларни/graphics макетда қўшиш учун ишлатишингиз мумкин.

2. Чизиш асбоби/drawing tools Draw ускуналар панелида пастга қараган рўйхатда жойлашган. 

3. Сиз ҳар доим маълумотлар рамкасининг хоссаларини ўзгартира оласиз: макетда рамканинг ўнг тугмасини босинг ва Properties ни танланг. 

		

5.



‘Map presentation3.mxd’ ҳужжатини ArcMapда очинг. 



‘De Hoge Veluwe’ миллий боғида маълумот куни учун паркни кўришга тафриш буюрувчиларнинг сони бўйича маълумот берувчи харита яратилиши керак. Энг муҳими 1995 йил Пасха кунида паркда турли қулайликларга эга бўлган ташриф буюрувчиларнинг сони ҳисобланади. Бу куни Фазовий режалаштириш/Spatial Planning факультети магистранти М.Янсен (M.Janssen),турли имкониятларда тафриф буюрувчиларни санади. 



Ташриф буюрувчилар сони ҳақидаги маълумотларни 'facilities' маълумотлар тўпламидаги Vzon майдонидан оласиз.



5а. Харитани тақдим этиш учун 12 қадамни ёзинг. 4 қадамдан то 9 қадамгача бўлган жараёнларни олдин бажарган тартибда схема кўринишида беринг. 





5b. ArcMapдан фойдаланиб, ‘харита тақдимотининг 12 та қадамларини’/ ‘12 steps to present a map’ орқали харита яратинг. 

















































































































5-амалий машғулотни бажаргандан кейин ўз-ўзини

текшириш учун саволлар











































Саволлар



1.	ArcMap да фазовий маълумотлар нималарни билдиради? 

2.	Харита тақдимоти нимани ўргатади?

3.	Белгилар редакторида/Symbology editor нечта Категориялар/Categories мавжуд ва уларга таъриф беринг. 

4.	Белгилар редакторида / Symbology editor нечта миқдорлар/Quantities:ies мавжуд ва уларга таъриф беринг. 

5.	Белгилар редакторида / Symbology editor нечта диаграммалар/Charts:ies мавжуд ва уларга таъриф беринг. 

6.	Кўп сонли атрибутлар/Multiple attributes нимани кўрсатади? 

7.	Харитани тақдим этишдаги 12 та қадамлар/саволлар нималар иборат? 

8.	Маълумот масштаблари нималар ҳисобланади ва уларга таъриф бериф беринг?

9.	Символлар орасидаги барча фараз қилинадиган фарқларни нечта график вариантлари орқали жамлаш мумкин ва улар қайсилар? 

10.	ArcMap харитада маълумотлар тўпламини ‘тез кўриб’/’quick look’ чиқиш учун қайси кўриниш танланади ва унган таъриф беринг. 

11.	Макет кўринишига/layout view таъриф беринг. 

12.	Тупроқ харитасини яратишда шартли белгилар нимадан бошланиши керак? 

13.	Харитани тақдим этишда макетнинг/layout имкониятларни санаб ўтинг.

14.	Макетдан шунчаки бирор бир маълумотлар рамкасини ўчириб ташлаш мумкин эмас. Бунга сабаб нима? 

15.	Масштаб панелига /scale bar таъриф беринг. 

16.	 тext ускунаси ва чизиш/drawing асбоби орқали харита макетида қандай вазифаларни бажариш мумкин?















































6 – АМАЛИЙ МАШҒУЛОТ









ТАЛАБЛАР



















КИРИШ 											107



МАЪЛУМОТ ТЎПЛАМИНИ ЖАДВАЛ КЎРИНИШИДАГИ 

ТАЛАБЛАРИ 										109



Савол бериш ифодасини қўллаш орқали объектларни танлаш 		109



Атрибутларни саралаш									111



Такомиллаштирилган талаблар							111



ФАЗОВИЙ МАЪЛУМОТ ТАЛАБЛАРИ					112



Курсор орқали объектларни танлаш						112



ЯНГИ ВЕКТОР МАЪЛУМОТ ТЎПЛАМИ ИЧИГА ТАНЛОВНИ 

САҚЛАШ 											114



РАСТР МАЪЛУМОТ ТАЛАБЛАРИ 						114



Растр катакчаларини уларнинг қийматлари орқали танлаш 			115



‘CON’ асбобидан фойдаланиб растр катакчаларини танлаш ва тадқиқ 

этиш 												115





6-амалий машғулотни бажаргандан кейин ўз-ўзини текшириш учун 

саволлар											118































КИРИШ 



Фазовий муаммоларни ечиш учун ГАТни қўллашни хохлаганингизда, фазовий маълумотни йиғиш ва реал концептуал моделни аниқлаш билан бошлайсиз. Кейинги мантиқий қадам бу йиғилган маълумотдан фойдаланиб фазовий ва жадвал операцияларини жалб қилиш ҳисобланади. Сиз маълумотлар тўпламини таҳлил қилишингиз, боғлашингиз ва бирлаштиришингиз керак, бу маълумотни қайта ишлаш/data handling деб номланади, фазовий маълумотларни чиқариб олиш учун сиз фазовий муаммоларни ечишингиз керак бўлади. 



Савол бериш/query (‘савол ва жавоб’нинг/’question and reply’ қисқартмаси) бу биринчи маълумотни қайта ишлаш синфи ҳисобланиб, ArcGIS амалиёти давомида муҳокама қилинади. Талаблар/Queries бу шундай жараёнки, яъни жадвал кўринишидаги ва фазовий маълумот тўпламларини танлаш орқали ГАТдан маълумотларни чиқариб олиш демакдир. Танланган ишнинг тўплами/selection маълумотлар тўпламининг геометрик ва атрибут маълумотларини ўзгартирмайди. Талаблар ёрдамида, сиз барча маълумотлар тўпламини танлашингиз мумкин. Сиз янги фазовий боғлиқликларни ўрганишингиз ва таҳлил қилишингиз мумкин ҳамда қуйидаги саволларни бериб, муаммоларни ҳал қилишингиз мумкин: 

•	Каерда/Where is  - ….?

•	Энг яқини қаерда/ Where's the closest …?

•	Ичида нима мавжуд/ What's inside …?

•	Кесиб ўтиш нима/What intersects …?



ArcMap сизга турли саволларга жавоб топиш учун ёрдам берадиган бир неча асбобларни таъминлаб беради. Талаблар жадвалли ва фазовий маълумот тўплами талабларига/tabular and spatial dataset queries бўлиниши мумкин.  



Савол беришнинг тузилиши, қўлланилган сўров тилига боғлиқ бўлади. ArcGIS SQL (Тузулмалашган сўров тили/Standard Query Language)дан фойдаланади. SQLнинг асосий гап тузилиши/syntax:



Select <features/records>

From <dataset>

Where <condition>



		Жадвалли маълумот тўпламига савол беришга / tabular dataset query мисол: pH > 6 бўлган тупроқ нуқталари қаерда жойлашган? /‘Where are the soil points located with pH > 6?’

Select Point features

From Soil_points

Where pH-value > 6





Ушбу амалий машғулотда:



· Векторли маълумот тўпламига савол бериш:

· Маълумот тўпламининг жадвалли талаблари: савол бериш ифодасидан фойдаланиб объектларни танлаш;

· Танланган объектларни янги векторли маълумот тўпламига сақлаш;

· Растрли маълумот тўпламига савол бериш:

· Савол бериш ифодасидан фойдаланиб растрли катакчаларни танлаш;

· ArcMap даги «Con» воситасидан фойдаланиб растрли катакчаларни танлаш ўрганилади.



Вазифалар



Ушбу амалий машғулотни ўзлаштиргандан кейин қуйидагиларни бажара оласиз: 



· Жадвалли маълумот тўплами ва фазовий маълумот тўплами ўртасидаги фарқни тавсифлаш;

· ArcMap асбоблари билан ҳар хил талабларни бажариш;

· Танланган объект ёки растрли катакчалардан ташкил топган янги маълумотлар тўпламини ҳосил қилиш.



ArcMap ҳужжати:  	Queries.mxd 

Адабиёт: 	Chapter 11.2 – 11.4









































МАЪЛУМОТ ТЎПЛАМИНИ ЖАДВАЛ КЎРИНИШИДАГИ ТАЛАБЛАРИ



Жадвал қайдларининг тўплами жадвал кўринишидаги талабларни тузатади. Сизнинг саволингиз атрибутларга ва уларнинг қийматларига асосланган бўлади. Жадвал қайдлари объектларга боғлиқ бўлганда иккила жадвал қайди ва боғланган объектлар танланган бўлади. 



Савол бериш ифодасини қўллаш орқали объектларни танлаш 



Савол бериш ифодаси/query expression нимани танламоқчи бўлганингизнинг аниқ таърифи ҳисобланади. Савол бериш ифодасини тузиш бу объектларни танлашда/select features асосли йўлдир, чунки ифода кўп сонли атрибутларни ва операторларни ўз ичига олади. Ифода мантиқий операторлардан: Boolean (AND, OR etc) ва боғловчилардан (=,<, >, <> etc.) ташкил топган. Cавол бериш ифодасининг натижаси ТЎҒРИ/TRUE ёки ХАТО/FALSE ҳисобланади. Объектлар учун савол бериш ҳолати TRUE ҳисобланса танланади, объектлар FALSE бўлганда эса танланмайди. 



Объектларни танлаганингизда улар ранг билан белгиланади. Сиз жадвал атрибутини очганингизда танлаган объектларингиз белгиланганлигини кўрасиз. 

[image: ]

ҚЎЛЛАНМА:

1. Савол бермоқчи бўлган маълумот тўпламининг атрибут жадвалини очинг. 

2. Options => Select By Attributes 

[image: ]ни танланг. Сиз шунингдек, Menu bar дан Selection ни босиб, Select By Attributes ни танлашингиз мумкин. 

3. Select by Attributes ойнаси очилади. 

4. Method майдонида танлов тури/selection type аниқланиши мумкин. 

5. Атрибутни аниқлаш учун икки марта атрибутга босинг. 

6. Матн майдонида (=, >, <, etc.) operators ни қўллаб ҳолатни белгиланг. 

7. Ифодага қийматни/value теринг ёки танланган атрибутларнинг барча 1-расм.Атрибутлар орқали танлаш ойнаси/ The Select by Attributes window



қийматлари тўғрисида маълумот бериш учун  Get Unique Values ни танланг. 

8. Энди сиз single query ни туздингиз.  Бириктирилган савол беришни тузиш учун ‘ВА’/‘And’ ва ‘ЁКИ’/‘Or’ операторларидан фойланишингиз керак. Агар сиз бириктирилган савол беришни тузмоқчи бўлсангиз 5 – 7 қадамларни қайта бажаринг. Иккали ифода тўғри бўлганида ‘And’операторидан фойдаланинг. Битта ифода тўғри бўлганда  ‘Or’операторидан фойдаланинг. 

9. Танлаш учун Apply ни босинг. 

10. Clear Selection [image: ] тугмасини танлашни аниқлаштириш учун босинг. Бу тугма атрибут жадвалининг Options тугмасининг пастқи қисмида жойлашган.



Ифодада қанча объектларнинг амалга оширилган ҳолатини топиш учун ёки танланган объектларнинг атрибутларини қайта кўриш учун атрибут жадвални очинг. Танланган қайдларнинг сони атрибут жадвалнинг пастки қисмида кўрсатилган бўлади. 



		

1.



‘Queries.mxd’ ArcMap ҳужжатини очинг ва ‘Wag_south’ маълумот рамкасини актив ҳолатга келтиринг. 



1а. Савол тузувчидан/query builder фойдаланиб, 150000 m2 дан катта бўлган ҳудудни/area ‘Soil_types’ маълумот тўпламининг барча объектларидан танланг. Create a new Selection услуби қўлланилишига ишонч ҳосил қилинг. Нечта қайдлар танланди? 





1b. 150000 m2 дан каттароқ бўлган ҳудудни/area ‘Soil_types’ маълумот тўпламининг барча объектларидан AND ‘kalkhoudende poldervaaggrond’ синфини танланг. Нечта қайдлар танланди. 





1c. 1b машқдаги савол беришни SQL тузилишига кўра ёзиб чиқинг. 



Select:



From:



Where:















Атрибутларни саралаш



Муҳимлигига қараб объектларнинг рўйхатини атрибут жадвалда саралаш орқали тартибга келтиришингиз мумкин. 



ҚЎЛЛАНМА: 



1. Sort Ascending [image: ] тугмасини кичик қийматларни ёки алфавит тартибида саралаш учун танланг. 

2. Sort Descending [image: ] тугмасини катта қийматларни ёки алфавит тартибга қарама-қарши саралаш учун танланг. 

		

2.



2а. Sort Descending тугмасидан фойдаланиб, ‘Soil_types’ маълумот тўпламини ‘polygon_co’ майдонини атрибут қийматининг катта қийматлари бўйича тартибга келтиринг. 











Такомиллаштирилган талаблар/ Refining a query



Шу вақтгача баъзи бир савол бериш ҳолатларига асосланиб объектлар тўпламининг янги танланган ишнинг тўпламини/selection яратишни ўргандик. Баъзида, маълумот тўпламини танладингизда танланган ишнинг тўпламини/selection такомиллаштириш имконияти бўлди. Масалан, объектларнинг сонини кенгайтириш ёки тўпламни кичайтириш мумкин бўлди. ArcMap сизга танланган ишнинг тўпламини/selection такомиллаштиришнинг учта имкониятларини яратади, яъни: 

Амалдаги танланган ишнинг тўпламига қўшиш/Add to current Selection 

Мавжуд объектлар тўпламига савол беришда танланган объектларни қўшиш. Бу вариантни танланган ишнинг тўпламини кенгайтириш/ expand учун қўлланг. 

Амалдаги танланган ишнинг тўпламидан ўчириш/Remove from current Selection

Мавжуд объектлар тўпламига савол беришда танланган объектларни ўчириш. Бу вариантни танланган ишнинг тўпламини камайтириш/ reduce учун қўлланг.

Амалдаги танланган ишнинг тўпламидан танлаш/Select from current Selection

Бу амал аллақачон танланган объектлардан фойдаланиш учун савол беришда қўлланилади. Шу учун сиз ҳозирда мавжуд танланган ишнинг тўпламидан объектни танлайсиз. Сиз бу вариантни танланган ишнинг тўпламини камайтириш/reduce учун фойдаланинг яъни хохлаган объектга прогрессив равишда эътибор марказига тўплаш учун қўлланг. 

ҚЎЛЛАНМА:

1. Select by Attributes ойнасида Method нинг пастга қараган стрелкасини саволни беришни аниқлаштириш учун танланг ва вариантлардан бирини босинг. 

2. Савол беришни одатдагидек бажаринг. 

		

3.



‘Soil_points’ маълумот тўпламидан 10% дан кўп бўлган clay % ни танланг. 



3а. Нечта объектлар танланди.





3b. X9 нуқтанинг clay % пайдо бўлади ва бу ўлчов хатолигини ташкил этади. Танланган ишнинг тўпламидан ушбу нуқта объектини олиб ташланг/remove.









ФАЗОВИЙ МАЪЛУМОТ ТАЛАБЛАРИ

Фазовий маълумот талаблари тўпламни атрибутлардан ва савол бериш ифодасидан фойдаланмасдан объектлар билан тўғридан-тўғри ишлаш орқали танлайди. Бу шуни англатадики, яъни танланган объектлар муайян жойда ўзларининг масофасига ёки бошқа объектларга нисбатан фазовий боғлиқликга асосланади. Қуйида фазовий маълумот бўйича савол беришнинг курсор орқали танлаш/ selection by cursor услуби муҳокама қилинади:  

Курсор орқали объектларни танлаш

ҚЎЛЛАНМА: 

1. Маълумот рамкасини/data frame актив ҳолатга келтиринг. 

2. Select Feature tool [image: ]ни танланг ва танлашни хохлаган объектни босинг. SHIFT тугмасини босган ҳолда бир неча объектларни танланг. Fall partly or wholly inside the box обектлари танланади. Натижада танланган объектлар ҳаво рангда танланганлигини кўрсатиш учун белгиланади. 

3. Атрибут жадвални очинг. 

4. Show тугмасига босинг: Selected тугма [image: ]фақатгина танланган объектларнинг қайдини кўрсатади. 

Танланган ишнинг тўпламидан бирон бир объектни олиб ташлаш ва бошқа объектларни қўшиш учун сиз қуйидиги жараённи бажаришингиз керак:  

1. SHIFT тугмасини босиб турган ҳолда олиб ташламоқчи бўлган объектни танлаб Select Feature асбобидан фойдаланинг ва танланган ишнинг тўпламига қўшмоқчи бўлган объектни қўшиш учун танланг. 

2. Атрибут жадвални очинг, Show тугмасини босинг: Selected [image: ] тугмаси танланган объектларнинг қайдини кўрсатади. All тугмасини атрибут жадвалда барча қайдларни қайтадан кўрсатиш учун танланг. 

		

4.



4а. Фақатгина ‘Soil_types’ маълумот тўпламини кўрсатинг. “Kalkloze poldervaaggrond” деб номланган тупроқ объектини танланг/Select the soil feature with soil name “Kalkloze poldervaaggrond”. Атрибут жадвални очинг фақат танланган объектларнинг қайдини кўрсатинг. 





4b. SQL савол бериш тузилишига кўра саволларга жавоб беринг. 



Select:



From:



Where:



4c. Танланган ишнинг тўпламидан жанубий қисмда жойлашган тупроқ объектни олиб ташланг ва шимолий қисмда жойлашган тупроқ объектини танланган ишнинг тўпламига қўшинг. Кейин эса, жадвалда танланган қайдларни кўрсатинг. 











ЯНГИ ВЕКТОР МАЪЛУМОТ ТЎПЛАМИ ИЧИГА ТАНЛОВНИ САҚЛАШ 	



ҚЎЛЛАНМА:

1. Сизни қизиқтирган объектни танланг. 

2. Танлаган объектлар билан маълумот тўпламининг ўнг тугмасини босинг ва Data =>Export Data ни танланг.

3. Диалог ойна пайдо бўлади. Export пастга қараган стрелкани танланг ва хохлаган танланган объектни ёки маълумот тўпламини тўлдириш учун босинг.

4. Координата тизимини/Сoordinate system танланг.

5. Янги маълумот тўпламининг номини/name ва натижа ҳосил бўлган жойни/output location аниқлаштиринг.

6. ОК ни босинг.



		

5.



5а. ‘Land_use’маълумот тўпламидан (‘C2’= 3) ўрмон/forest объектини танланг. 





5b. Танланган объектларни янги маълумот тўпламига экспорт/export қилинг. 









РАСТР МАЪЛУМОТ ТАЛАБЛАРИ

Растр маълумот талаблари вектор маълумот талабларидан фарқ қилади. Вектор талаблари маълумотлар тўпламидан якка объектларни танлаш имконини беради. Лекин сиз якка растр катакчаларини танлай олмайсиз. Растрда савол берганингизда, сиз савол бериш ифодасини қўллайсиз. Савол бериш ифодасида атрибут қийматини ‘value’ қўллаганингизда, сиз растр маълумотлар тўпламининг ‘zone’ сини танлайсиз (зона бўйича маълумот учун 3-амалий машғулотга қаранг). Танланган ишнинг тўплами бир хил қийматли барча растр катакчаларидан ташкил топган бўлади. Бу турдаги танланган ишнинг тўпламини вектор эквиваленти – танланган ишнинг тўплам синфи ҳисобланади (синф бир хил атрибут қийматли барча объектлар билан шаклланган, масалан ердаги барча бинолар маълумотлар тўпламларидан фойдаланади).





Растр катакчаларини уларнинг қийматлари орқали танлаш

Сиз шунингдек, Select by Attributes диалог ойнасидан фойдаланишингиз мумкин. 

ҚЎЛЛАНМА:

1. Растер маълумот тўпламининг атрибут жадвалини/attribut table очинг.

2. Options => Select by Attributes ни танланг.

3. Савол беришни шакллантиринг. Танланган қийматларнинг катакчалари ойнада белгиланади. 

Афсуски, сиз танланган ишнинг тўпламини янги растр маълумот тўпламига экспорт қила олмайсиз/ cannot export. Select by Attributes функцияси орқали сиз фақат танланган ишнинг тўпламини кўришингиз мумкин. Янги маълумот тўпламини яратиш учун сиз Spatial Analyst асбоблар қутисида жойлашган CON асбобидан фойдаланишингиз керак. 

‘CON’ асбобидан фойдаланиб растр катакчаларни танлаш ва экспорт қилиш/Selecting and exporting raster cells using the ‘CON’ tool

CON асбоби билан агар/яна (if/else) шартли баҳолашга асосланган растр катакчаларни танлашингиз ва экспорт қилишингиз/select and export мумкин. Бу шуни англатадики, фойдаланувчи – аниқлаган савол бериш ифодаси киритилган растр маълумотнинг /input raster ҳар бир катакчаси учун баҳолайди деб ҳисобланади. Натижа/output – янги растер маълумот тўплами ҳисобланади.

Агар кирилган раст маълумотнинг/input raster катакчалари қийматлари TRUE деб баҳоланса, унда фойдаланувчи аниқлаган қийматлар/user – defined value(s) бу катакчаларни натижада ҳосил бўлган растр маълумот/output raster деб белгилайди. Фойдаланувчи аниқлаган қийматлар доимий/constant ёки бошқа растр маълумот тўпламининг қиймати бу ҳолатда ҳақиқий катакчалар қиймати бўлиши мумкин.

FALSE деб баҳоланган катакча қийматлари фойдаланувчи аниқлаган қийматлар тўпламининг турли хил бўлиши мумкин. Масалан, агар input rasterнинг катакча қиймати 10 дан катта бўлса, 1 бўлиб акс ҳолда 100 бўлиб қайтади. 

Танланган ишнинг тўпламида/selection геометрик ва атрибут маълумотлар ўзгармайди деб ҳисобланади. Бу ҳолатда ҳақиқий катакча қийматлари/original cell values натижада ҳосил бўлган растр маълумотда/output rastr сақланади. Агар бошқа қийматлар натижада ҳосил бўлган растр маълумотда/output raster сақланса, бу ерда фақат танланган ишнинг тўпламигина жойлашмайди балки операция ҳам/operation also жойлашади, чунки, растр ўзгаришларнинг тематик (атрибут) маълумоти ҳисобланади.

CON асбобидан фойдаланишнинг афзаллиги шундаки, ҳосил бўлган растр маълумотда ҳақиқий катакча қийматини сақлашингиз/retain the original cell value in the output raster мумкин! Сиз 7-амалий машғулотни бажариш давомида Raster Calculator функцияси орқали ишнинг тўпламини танлашингиз мумкин лекин бу ерда ҳақиқий қийматларни йўқотасиз. 

ҚЎЛЛАНМА:

1. ArcToolbox ни очинг ва Spatial Analyst Tools => Conditional => Con га босинг.

2. Input conditional raster ни танланг. Бу – савол бериш ҳолати орқали баҳоланадиган катакча қийматларидан ташкил топган растр ҳисобланади. 

Input true raster ёки constant value ни танланг. Бу агар ҳолат тўғри бўлса, натижада ҳосил бўлган растр маълумот каби катакчаларни белгилаши мумкин бўлган растр ёки доимий равишда ушлаб турувчи қиймат ҳисобланади. 

3. Агар сиз киритилган растр маълумот/input raster сифатида худди шу растрни танласангиз, ҳақиқий қийматни сақлашингиз мумкин.

4. Агар сиз хато/false ҳолатидаги натижада ҳосил бўлган қийматни растр катакчаларига олишни истасангиз Input false raster ёки constant value ни танланг. Агар сиз растр ёки доимий қийматни танламасангиз, хато ҳолатида бўлган катакчаларни NoData сифатида қиймат баҳолайди. Бу default setting ҳисобланади. 

5. Expression катакчасига мантиқий савол бериш ҳолатини киритинг. 

6. ОК ни босинг. 

		

6.



‘Raster’ маълумот рамкасини актив ҳолатга келтиринг ва ‘LU_raster’ маълумот тўпламини кўрсатинг. 



6а. ‘value = 5’ бўлган барча катакчаларни танланг. Нечта катакчалар белгиланди? 





6b. Clear the selection. Фақат катакча ҳисоблаган 4000 дан юқори бўлган ердан фойдаланиш синфларини/land use classes танланг. Қайси синфлар танланди. 





6c. ‘LU_raster’да ўрмон/forest сифатида (value=3) синфланган барча растр катакчалардан ташкил топган янги растр маълумот тўпламини яратинг. Ҳақиқий катакча қийматларини сақланг. Янги маълумот тўпламини workspace да сақланг. 





6d. ‘LU_raster’да бинолар/buildings (value=1) ва йўллар/roads (value=2) сифатида синфланган барча растр катакчалардан ташкил топган янги растр маълумот тўпламини яратинг. Натижада ҳосил бўлган растр катакчаларига доимий қийматни баҳоланг. Янги маълумот тўпламини workspace да сақланг. 













































































































6-амалий машғулотни бажаргандан кейин ўз-ўзини

текшириш учун саволлар





























Саволлар



1. Cавол беришнинг тузилиши нимага боғлиқ ва у қандай тузилган? .

2. Савол бериш ифодасининг/query expression мантиқий операторлари нималардан ташкил топган?

3. Sort Ascending ва Sort Descending тугмалари нималарни англатади? 

4. ArcMap сизга танланган ишнинг тўпламини/selection такомиллаштиришнинг учта имкониятларини яратади, яъни булар қайсилар, уларга таъриф беринг.

5. Фазовий маълумот талабларига таъриф беринг. 

6. Танланган ишнинг тўпламидан бирон бир объектни олиб ташлаш ва бошқа объектларни қўшиш учун қандай жараёнлар бажарилиши керак? 

7. Растр маълумот талабларига таъриф беринг. 

8. Spatial Analyst асбоблар қутисида жойлашган CON асбобидан қайси амални бажариш учун фойдаланиш мумкин ва у нимани англатади?
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КИРИШ 



Маълумотларни қайта ишлаш синфи шаклнинг ўзгаришини/transformations  ўз ичига олади. Шаклнинг ўзгариши учта гуруҳларга бўлиниши мумкин: 



· Шаклнинг ўзгариши проекцияси: хаританинг битта проекцияланган координата тизимидан бошқасига математик ўзгартириш. 

· Расмни боғлаш: контрол нуқталарнинг тўпламидан фойдаланиб рақамлаштирувчи бирликдан/digitizer units ёки сурат координаторидан проекцияланган координата тизимига геометрик шаклнинг ўзгариши. 

· Маълумот тизимининг шаклини ўзгартириш: битта маълумот тизимидан бошқасига ўзгартириш, масалан вектордан растрга. 



Биринчи шаклни ўзгартириш гуруҳи 4-амалий машғулотда ‘Харита проекцияси/Map projections’ муҳокама қилинган эди: сиз вектор маълумотлар тўпламини проекциялаган ва қайта проекциялаган эдингиз. Бу амалий машғулотда шаклнинг ўзгаришини бошқа икки гуруҳи ишлатилади. 



Бу амалий машғулот расмни боғлаш/georeferencing тўғрисида муҳокама қилади. Сиз расмни харитага ўзгаришини таъминлайсиз яъни бу расмни координата проекцияланган харита координаталарига ўзгартирасиз. 

____________________________________________________________________



Ушбу амалий машғулотда:



· Тасвир файлнинг геометрик ўзгариши ва суратни рўйхатга олиш;

· Растр ўлчамини қайта танлаш;

· RMS хатолик орқали позицион аниқликни баҳолаш: растр гео-манба малумотларининг тўғрилигини текшириш;



Вазифалар



Ушбу амалий машғулотни ўзлаштиргандан кейин қуйидагиларни бажара оласиз: 



· растр маълумотларининг геометрик ўзгаришлари оралиғидаги расмни рўйхатга олиш, расмни тузатиш, гео-манба, бошқарув нуқталар, маъқуллаш, фазовий ўлчам ва фазовий аниқлик терминларнинг маъносини изоҳлаш ва тушунтириш. 

· расмни тузатиш учун қандай маълумотлар ва қандай ҳаракатлар керак бўлишини санаб чиқиш; 

· расмни тузатиш ва расмни қайта танлаш услубларини муҳокама қилиш; 



ArcMap ҳужжати:  	Transformations part1.mxd

Адабиёт: 	Chapter 7 Geometric transformations

Chapter 5: section 5.5 Data conversion





















































































Расмни боғлаш



Талабаларга ва мутахассисларга бериладиган умумий савол қуйидагичадир: ‘Нима учун бу икки харита суратлари бир хил ҳудудни кўрсатса ҳам тўғри мослашмаган? Сизнинг кўпчилигингиз ўкишингизни кейинги босқичларида ёки профессионал карьерангиз давомида суратлар билан ишлашга тўғри келасиз ёки рақамланган хариталардаги маълумотлар чизиб кўрсатилган бўлиши лекин харита проекцияланмаган координата тизимига эга бўлиши мумкин. Агар сурат ёки харита маълум харита проекциясига фазовий боғланган бўлса, бу бошқа координата тизимига математик (қайта)проекцияланиши мумкин (3-амалий машғулотга қаранг).



Қолаверса, ArcGISнинг бу қисми амалиётга қайтарилиб туриладиган муаммоларга дахлдор яъни (1) янги рақамланган хаританинг координаталари қоғоз парчасида манба нуқтасидан рақамланган бирликлар орқали намойиш этилади ёки (2) суратнинг координаталари устун ва қатор пиксел индекси орқали намойиш этилган. Сиз GIS таҳлили учун бу маълумотлардан фойдаланиб рақамланган харита ёки суратни проекцияланган харита координата тизимига боғлашингиз/georeference керак (1-расм).
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1-расм. Дроевендаал тажриба хўжалиги/Droevendaal Experimental Farm нинг кўриниши (чапда), GISда топографик харитаси билан мос тушиши учун боғлаш керак.

Умумий бориладиган иш тартиби

Растр маълумотларни боғлаш одатда суратни тўғрилаш/image rectification назарда тутилади ва учта босқичга бўлиниши мумкин: 

· Расмни руйхатга олиш/Image registration

Расмни рўйхатга олиш маълум бўлган харита проекциясида маълумотлар тўпламини боғлаши ва киритилган суратда/ input image мос тушадиган нуқталарни таниши жараёнини намойиш этади. Бу нуқталар контроль нуқталар/control points деб аталади. 

· Геометрик шаклни ўзгариши

Контроль нукталари иккита (кўпҳадли/polynomial) шаклни ўзгариши учун коэффициентларни аниқлашда фойдаланилади яъни сурат координаталари ва харита координаталари ўртасидаги алоқани тасвирлаб беради (2-расм).x= f1 (X, Y)                  y = f2 (X,Y)

(x,y) = input image coordinates (column, row) /

кириш сурат координаталари (устунб қатор)

(X,Y) = map coordinates / харита координалари

f1, f2 = transformation equations / тенгламалар ўзгариши













2-расм. Ўзгаришлар функциялари контроль нуқталари асосида аниқланган.

Қайта намуна олиш /Resampling 

Энг кўп ишлатиладиган қайта намуна олиш усуллари бу - якин қўшни/nearest neighbor ва икки чизиқли интерполяция/bilinear interpolation ҳисобланади. Бу усуллар ҳар бир бўш катакча қийматини боғланмаган растр маълумот тўпламида катакча қийматларини баҳолаш орқали аниқлайди (кириш сурати/input image). Учинчи қайта намуна олиш усули бу – кубик ўрам/cubic convolution ҳисобланади. 

Расмни боғлаш жараёнининг схема тарзидаги кўриниши 4 расмда берилади.
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4-расм. Расмни тўғирлашда бажариладиган иш тартибининг схема тарзидаги кўриниши. 

(а) Расмни рўйхатга олиш: контроль нуқталарни расмда ва маълумотлар тўпламида боғлашни аниқлаш.

(b) Катакча марказида икки чизиқли ўзгариш функциясидан чиқиш растрда/output rastr фойдаланиш бу кириш растр/input rastr координата тизимидаги жойларга харитани чизиш/mapped ҳисобланади. Кейин, катакча қиймати қайта намуна олиш усулидан фойдаланишни аниқлаш ҳисобланади: яқин қўшни усули яқиндаги катакча марказининг қийматини аниқлайди (катакча атрофида тире-айлана сифатида белгиланган); икки чизиқли интерполяция кириш катакчасида/input grid тўртта яқин қўшнининг (катакча маркази атрофида айлана сифатида белгиланган) ўртача ўлчанган масофада ҳисоблашни жалб қилади. 



ArcMaрда расмни боғлаш



Бу амалий машғулотда ‘Droevendaal Experimental Farm’нинг суратини проекцияланган харита координатасига сурат координатасидан боғлашни бажарасиз. 

		

1.



‘Transformations part1.mxd’ ArcMap ҳужжатини очинг. ‘Scanned image’ маълумот рамкасини актив ҳолга келтиринг. Бу маълумот рамкаси  ‘Droevendaal Experimental Farm’ суратини ўз ичига олади.



1а. Номинал маълумот шкала нимага тенг? ‘Scanned map’ растр қатламининг қиймати номинал шкала эканлигини қандай биласиз? 





1b. Тадқиқ қилинган суратнинг координата бирлиги нима ҳисобланади (метр ёки пиксел/meters or pixels). Расм нечта устун ва қаторга эга?  





1c. Маълумот рамкасига ‘Top10vct.lyr’ вектор қатламини қўшинг. Бу қатламни маълумотлар папкасидан топиш мумкин.











Расмни руйхатга олиш: контроль нуқталарини олиш



Cиз расмни боғлашни контроль нукталарнинг координаталарини олишдан бошладингиз. 

ҚЎЛЛАНМА: 



1. Georeferencing асбоблар панелини очинг. Меню панели/menu bar даги View ни танланг, Toolbars ни босинг ва Georeferencing ни танланг.
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5-расм. Georeferencing асбоблар панели/ The Georeferencing toolbar



2. Мундарижада боғланган маълумот тўпламининг ўнг тугмасини босинг (‘Top10vct’ ҳолатида) ва Zoom to Layer ни танланг. 

3. Georeferencing асбоблар панелида Georeferencing пастка қараган стрелкани танланг ва Fit to display ни босинг. 

4. Энди бу иккита қатламлар намойиш ойнасида/view window кўрсатилади.

5. Control points асбобини танланг (box 1, расм 5). Кўрчаткич кесишга чизиқлар орқали намоён бўлади. 

6.  Контроль нуқтани қўшиш учун сичқончани кўрсаткичини растр маълумотлар тўпламига олиб келинг, бу боғланган маълумотлар тўпламини осонгина топиши мумкин. (масалан кесишган йўллар, 6-расм). x, y ҳолатига келтириш учун катталаштиришингиз/zoom керак бўлади. Контроль нуқталарни йиғишда, биринчидан маълумот тўпламининг манбасини/source (боғланмаган растр) танланг, кейин эса боғланган маълумот тўпламида мос келувчи нуқтага/ coinciding point босинг, геобоғланмаган растрга босилади, кейин эса маълумотлар тўплами йўналтирилган  тўғри келадиган нуқтага босилади.
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6-расм. Контроль нуқталарни тўплаш. Суратнинг деталлари ва боғланган маълумотлар тўплами шуни кўрсатадики яъни контроль нуқталар расмда бир хил жойларни (тепадаги) ва боғланган (пастдаги) маълумотлар тўпламига боғлайди. 

7. Ўзгариш тенгламасини ҳал қилиш учун мос контроль нуқталарни тўпланг. 

· 1st order polynomial (affine): minimal 3 control points/минимум 3 та контроль нуқталар;

· 2nd order polynomial: minimal 6 control points/ минимум 6 та контроль нуқталар;

· 3rd order polynomial: minimal 10 control points/ минимум 10 та контроль нуқталар.

Кераклигича нуқталар йиғиш учун бу энг ўринлидир. Қанчалик контроль нуқталар кўп йиғилган бўлса, аниқлик шунчалик юқори ва хатолик шунчалик кам бўлади!!

8. Контроль нуқталарнинг сурати ва харита координаталари Link Table да сақланган бўлади (7-расм). View Link Table тугмасига босинг (box 2, 5-расм). Жадвал контроль нуқталарининг х ва у координаталари ва residuals (errors) хатоликларини кўрсатади. Auto Adjust тугмаси белгиланганлигига ишонч ҳосил қилинг. 

9. Контроль нуқтани ўчириш учун уни танланг ва диалог ойнасининг тепа қисмида ўнг тарафидаги ўчириш тугмасини босинг. 
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7-расм. 12 та котроль нуқталари белгиланган алоқа жадвали. 12 та нуқта учун RMS хатолик 2.78 ни кўрсатади.

Харита контроль нуқталарнинг тарқалишини кўрсатади.







		

2.



2а. Контроль нуқталар нима ва уни каерда ишлатиш учун керак бўлади?





2b. Колдиқ нима ва у қандай ҳисоблаб топилади?  



Контроль нуқталарни йиғишни бошланг. Сиз 2 та ва 4 та нуқталарни тўплаган вақтингизда с ва d машқларига жавоб беринг. Умумий 12 та контроль нуқталарини тўпланг. Нуқталарни тўплаш давомида тадқиқ қилинган харитада/scanned map ҳар бир нуқтани тўплагандан кейин маълумотлар тўпламига белгиланган (ўзгартириш функциясига асосланган ҳолда) ҳисобланади. Нуқталар яхши тарқалганлигига ишонч ҳосил қилинг.



2с. 2 та нуқталарни тўплаганингиздан кейин Link Tableни очинг. У ерда аллақачон қолдиқ/residuals ҳисобланганми. Нима учун (йўқ)?





2d. 4 та нуқталарни тўпганингиздан кейин жадвални яни очинг. Total RMS error нима ҳисобланади (7-расм)?





2e. 12 та контроль нуқталарни тўплаганингиздан кейин, Total RMS error нимани кўрсатди? 2 ва 4 нуқталар орасидаги Total RMS error яроқли ҳисобланади.  Контроль нуқталар тўпламини сақланг/save (Link Table ни очинг ва save ни босинг). Файни workspaceда жойлаштиринг.











Геометрик шаклнинг ўзгариши ва қайта намуна олиш

	Сиз шу вақтгача ўн иккита контроль нуқталарни тўплаш орқали маълумотлар тўпламини боғлаш билан кириш суратларни/input image рўйхатга олдингиз. Бу нуқталар контроль нуқталарнинг координата қийматларига шаклни ўзгариш функциясини ўрнатиш учун фойдаланилди (масалан, коэффициентни аниқлаш).  Ҳар бир нуқта учун қолдиқ ҳисобланган яъни ушбу нуқталарнинг ‘тўғри/true’ координата қийматлари ва ўрнатилган координа қийматлари ўртасида фарқ ҳисобланади. 

Энди сиз кириш суратларининг геометрик шакл ўзгаришини ва қайта намуна олишни бажарасиз. ArcGISда бу иккита қадамлар битта опрецияга бирлаштирилган!



ҚЎЛЛАНМА:

1. Аввал transformation функциясини танланг. Georeferencing пастга қараган стрелкани асбоблар панелидан танланг, Transformation ни босинг ва transformation polynomial ни танланг.

2. Georeferencing пастга қараган стрелкани танланг ва Rectify ни босинг. Диалог ойнаси очилади (8-расм).

3. Output raster маълумот тўплами учун Cell Size ни жойлаштиринг. 

4. Resample Type ни танланг.

5. Output rasterнинг жойини ва номини аникланг.

6. Save ни босинг.
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8-расм. Тузатиш параметрларини киритиш/Enter the rectification settings.

		

3.



Тажриба хўжалигининг кириш суратини тузатинг. 1st order polynomial (Affine)  ўзгартириш функциясидан фойдаланинг. Nearest Neighbor ва Bilinear Interpolation иккала қайта намуна олиш турларидан хам фойдаланинг. Output rasterни ‘farm_1st_nn’ ва ‘farm_1st_bl  деб номланг. Output rasterни ўзингизни workspace гизда сақланг. Катакча ўлчамини/cell size ни 2 meter га ўзгартиринг. 



3а. Nearest Neighbor ва Bilinear қайта намуна олиш турларининг маънолари нимани англатади? 





‘Referenced image’ маълумот тўпламини актив ҳолга келтиринг ва иккала output rasterни қўшинг. Иккита растр маълумотлар тўпламинингбелгиларини/symbology ўзгартиринг. Symbology editor ни очинг ва farm.lyr ни импорт/import қилинг.





3b. Иккитасидан қайси бири тўғри ва нима учун? 











		

4.



‘Referenced image’маълумот тўпламига ‘top10vct.lyr’ қатламини қўшинг.



4а. Жойнинг ўзгаришида қайси шакл тузатилган сурат ва ‘top10vct’ қатлами ўртасида кузатилиши мумкин. Ишора/hint: катталаштиринг/zoom in.







		

5.



‘Scanned image’ маълумот рамкасини актив ҳолатга келтиринг. 2nd order шаклни ўзгартириш функциясидан фойдаланган ҳолда тузатишларни қайтаринг. Output rasterни ‘farm_2nd’ деб номланг. Мос келадиган қайта намуна олиш турини танланг. 





5а. Link Table ни очинг. Энди Total RMS error да қандай натижага эришдингиз?





‘Referenced image’ маълумот рамкасини актив ҳолатга келтиринг ва ‘farm_2nd’ маълумот тўпламини қўшинг.





5b. Тузатилган сурат ва ‘top10vct’ боғланган қатлами ўртасида фазовий мослик яхшиландими? 





5c. 5а машқдаги жавобингизга бу натижа қандай боғланган? Бу ерда 2nd order (quadratic) шакл ўзгариш функциясидан фойдаланишнинг қайдайдир сабаби мавжудми? 











Тасдиқлаш/Validation



Кам RMS хатолик аниқ тузатиш билан чалкаштирилмаслиги керак. Масалан, талаб этилган контроль нуқталарнинг минимум сони шаклни ўзгартириш функцияси орқали фойдаланилган. RMS ноль деб берилган бўлиши керак. Бундан ташқари, шакл ўзгариши ёмон киритилган котроль нуқталари натижасида катта хатолардан ташкил топган бўлиши мумкин. Аслини олганда, RMS фақат контроль нуқталар учун ўзгариш функциясини аниқ бир ўлчамга келтириш мумкинлигини кўрсатади. Мустақил боғланган нуқталарнинг тўплами билан тасдиқлаш/validation олинган  позицион аниқликни/positional accuracy текшириши мумкин. 

Хўжалик ичида махсус тажриба майдончаларини бурчакдаги нуқталарининг жойлашуви аниқликни ўлчаш асбоби (Real Time Kinematic GPS) орқали ўлчанди (сантиметр аниқлиги билан). Бу жойлар кейинчалик Dutch Grid (RD координата тизими) да проекцияланди. 9-расмда ўлчанган 15та жойлар кўрсатилган (шимолий-шарқ бурчак). Уларнинг координаталари (Dutch Grid) Validat.xls MS Excel файлда сақланган.

[image: ]

9-расм. Тажриба майдонларининг шимолий-шарқ бурчагида ўн бешта тасдиқланган жойлар/Fifteen validation locations, the north-east corners of experimental plots.



		

6.



Боғланган суратларни тасдиқланг. Қуйидаги процедурани бажаринг. 



1. ‘Farm_2nd’ растр маълумот тўпламида 15 та нуқталарнинг координаталарини ўлчанг. 

2. Координаталарни Validat.xls Excel файлга киритинг. Бу файлни D:\IGI\...*…\ArcGIS\data\georeferencing (*morning or afternoon) топишингиз мумкин. 

3. Хатоликларнинг RMS error автоматик равишда ҳисобланади.

4. ‘Farm_1st_nn’ растр маълумот тўплами билан ўчлашни ва ҳисоблашни қайта бажаринг.



6а. Умумий RMS error орқали нимага эришдингиз (бирликни кўрсатинг)? 





6b. 5a машқдаги жавоб билан таққослаганда бу қандай бўлади? 





6с. Эришилган позицион аниқликга қайси факторлар ёрдам кўрсатади?





















































































































7-амалий машғулотни бажаргандан кейин ўз-ўзини

текшириш учун саволлар













































Саволлар



1.	Шаклнинг ўзгариши/transformations учта гуруҳларга бўлиниши мумкин? 

2.	Шаклнинг ўзгариши амалий машғулотининг вазифалари нималардан иборат? 

3.	Растр маълумотларни боғлаш одатда суратни тўғрилаш/image rectification назарда тутилади ва нечта босқичга бўлиниши мумкин, улар қайсилар?

4.	Расмни руйхатга олиш/Image registration га таъриф беринг.

5.	Геометрик шаклни ўзгаришига таъриф беринг.

6.	Қайта намуна олиш /Resampling га таъриф беринг.

7.	Контроль нуқталарнинг аниқлиги ва хатолиги нимага боғлиқ бўлади? 

8.	Контроль нуқталар нима ва уни каерда ишлатиш учун керак бўлади











































































8 – АМАЛИЙ МАШҒУЛОТ
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КИРИШ 



Маълумотларни қайта ишлашнинг дастлабки иккита синфи яъни сўровлар/queries ва шаклнинг ўзгариши/transformation аввалги иккита амалий машғулотларда муҳокама қилинган эди. Ушбу амалий машғулот маълумотни қайта ишлашнинг учинчи синфи бўлган – операциялар /operations устида иш олиб боради. Бу амалий машғулот растр муҳитида операцияларни бажаришга қаратилган бўлиб, бу cell-based analysis деб номланади. Растр операциялар фазовий моделлашда кучли асбоб ҳисобланади.



АrcGIS фойдаланувчига катакчага – асосланган/cell – based GIS операциялар учун комплекс асбоблар тўплами: ArcGIS Spatial Analystни таклиф этади. Бу операциялар бешта турга бўлиниши мумкин: локал/local, фокал/focal, зонал/zonal ва глобал/global операцияларига ва махсус қўлланиладиган/specific application операцияларга бўлинади. Махсус қўлланиладиган операциялар бу амалий машғулотда муҳокама қилинмайди.



Cell-based опреациялар Map Algebraдан фойдаланади (Tomlin, 1990). Map Algebra Операциялар кириш қатламларнинг индивидуал катакча қийматларини/ individual cell value(s) of the input layer(s) амалга оширади (Heywood et al., 2002) Map Algebraнинг натижаси/output ҳар доим янги растр қатлам ҳисобланади.



Map Algebra function: 	output raster dataset = combine (input raster1, input raster2)

output raster dataset = square root (input raster)

Map Algebra operators: output raster dataset = (input raster1 + input raster2) / 3.14



Шуни эсда тутиш керакки, биттадан кўп бўлган кириш растр маълумот тўплами билан Map Algebra дан фойдаланишда, кириш растр маълумотлар тўпламининг геометрияси/geometry ўзаро мос келиши лозим.

____________________________________________________________________



Ушбу амалий машғулотда:



· Spatial Analyst Toolboxдан фойдаланиш;

· Локал операциялар билан растр калькулятор ва функцияларни боғлаш;

· Фокал операциялар: фокал статистика ўрганилади.



Вазифалар



Ушбу амалий машғулотни ўзлаштиргандан кейин қуйидагиларни бажара оласиз: 



· Турли хил операцияларнинг тавсифини бериш; 

· Ҳар бир операция гуруҳларининг имкониятларини таърифлаш; 

· ArcGISда Spatial Analyst Toolboxдан фойдаланиб, турли операцияларни амалга ошириш.



ArcMap ҳужжати:  	Raster operations.mxd

Адабиёт: 	Chapter 13 Raster Data Analysis







































































ЛОКАЛ ОПЕРАЦИЯЛАР



Локал операциялар растр чиқиш/rastr output маълумот тўпламини ҳисоблайди, бу ерда ҳар бир жойнинг (катакча) чиқиш қиймати кириш растрларда фазовий мос келувчи/spatially coinciding жойларда кириш қийматларининг функцияси ҳисобланади (1-расм). 
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1-расм. Локал операциялар фақат битта катакчага таъсир қилади/Local operations affect only one cell



Биз ушбу амалий машғулотда тўрт хил турдаги локал операцияларни муҳокама қиламиз. ArcGISда бундан кўпроқ операциялар мавжуд. Сиз уларни ArcToolbox да Spatial Analyst Tools нинг Local toolset асбоблар тўпламидан топишингиз мумкин. Агар хохласангиз, сиз уларни ўзингиз ўрганиб чиқишингиз мумкин. 



Локал операциялар амалга оширилаётганда қуйидагиларга эътибор каратиш лозим:

•	Агар кириш растр маълумот тўпламининг катакчаси NODATA қийматига эга бўлса, чиқиш растрининг худди шу жойидаги катакчасининг қиймати ҳар доим NODATA бўлади (2-6 расмлар)!!

•	Кириш растр маълумотлар тўпламининг катакча қийматлари чиқиш жадвалига атрибутлар каби қўшилмайди, ‘combine’ функциясини фойдалангандан ташқари. 

1. Ҳар бир жой учун чиқиш қийматларини ҳисоблаш/ calculate output values операциялари математик функциялардан фойдаланган ҳолда битта растр маълумот тўплами/single raster dataset да фазовий мос келувчи жойни катакча қийматларининг функцияси каби ҳисоблайди. 

Масалан, кириш қийматининг ‘e’ га асосланган чиқиш қиймати ҳисобланади (2-расм). 

Математик функциялар/Mathematical functions (f) синтаксисга эга: output raster = f(input). Улар битта кириш растрида қийматларга қўлланилади. Бу ерда математик функцияларнинг тўртта гуруҳлари бор: 

· Логарифмик/Logarithmic;

· Арифметик/Arithmetic;

· Тригонометрик/ Trigonometric;

· Даража/Powers 



Spatial Analyst toolbar: Raster Calculator.

[image: ]Spatial Analyst toolbox: Math toolset. 













2-расм. Логорифмик функция/logarithmic function ‘Exp’ (base e). Syntax: ouput raster = Exp(Inlayer1).

2. Ҳар бир жой учун чиқиш қийматларини ҳисоблаш/ calculate output values операциялари арифеметик (математик) ёки мантиқий операторлардан фойдаланган ҳолда икки ёки ундан кўп растр маълумот тўпламида фазовий мос келувчи жойни катакча қийматларининг функцияси каби ҳисоблайди. Масалан, иккита қийматнинг ўртачаси (3-расм) ёки кириш растр қиймати 1> кириш растр қиймати 2. Бу операциялар синтаксисга эга: output raster = (input1 ‘opr’ input2).



Арифметик операторлар/Arithmetic operators. Арифметик операторлар иккита растрларни қўшиш, айириш, кўпайтириш ва бўлиш амалларини бажариши мумкин.  





Spatial Analyst toolbar: Raster Calculator.
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3-расм. Арифметик операторлар ёрдамида иккита растр қатламларининг ўртачасини топиш. Syntax: ouput raster dataset = (Indataset1 + Indataset 2) / 2.



Мантиқий операторлар/Logical operators. Мантиқий операторлар шартли оператордан/conditional statement фойдаланиб кириш растрларнинг қийматларини ҳисоблайди. Мантиқий операторлар Boolean (AND, OR ва бошқ.) ёки Relational (<, >, <> ва бошқалар)  бўлиши мумкин. Битта шартли ифода бир ёки ундан кўп Boolean ва relational операторлардан ташкил топган. Мантиқий операторларнинг натижаси ҳар доим TRUE/ТЎҒРИ ёки ХАТО/FALSE бўлади.)



Spatial Analyst toolbox: Math => Logical. Мантиқий асбоблар тўплами Boolean ва relational асбобларидан ташкил топган. Мантиқий асбоблар/logical tools битта оператордан фойдаланади ва синтаксисга эга: output raster = (input1 ‘logical opr’ input2).
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4-расм. ‘Boolean AND’ ускунаси иккала растр маълумотлар тўпламида non-zero қийматга эга катакчаларни топди. Syntax: ouput raster dataset = (Indataset1 & Indataset 2). 



Spatial Analyst toolbar: Raster Calculator. Растр калькулятор ёрдамида битта  шартли ифода ичида мантиқий ифода ичида кўп сонли Boolean ва relational операторларини бирлаштиришингиз мумкин. Масалан, ‘output raster dataset = (soil type = 1 AND elevation >=40)’.



3. Ҳар бир жой учун умумий статистикани ҳисоблаш/ calculate summary statistics операциялари катакча статистика функцияларидан/cell statistic functions фойдаланган ҳолда икки ёки ундан кўп растр маълумотлар тўпламида/two or more raster datasets мос келувчи жойни катакча қийматларининг функцияси каби ҳисоблайди

Cell statistic functions синтаксисга эга: output = f(input1, input2). Сиз ўнта статистикани ҳисоблашингиз мумкин: 

· Majority

· Maximum

· Mean

· Median

· Minimum

· Minority

· Range

· Standard Deviation

· Sum

· Variety

· Figure
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5-расм. Учта кириш растр маълумот тўпламлари учун ўртача статистикасининг ҳисобланиши. Syntax: outgrid =mean(ingrid1, ingrid2, ingrid3).



Spatial Analyst toolbox: Local =>Cell statistics.



4. Локал операцияларнинг тўртинчи тури бу растр оверлей/raster overlay ҳисобланади. Оверлейда икки ёки ундан ортиқ кириш растр маълумотлар тўпламининг/two or more input raster datasets катакча қийматлари Spatial Analyst  бирлаштириш функцияси/combine function ёрдамида битта чиқиш растр маълумот тўплами ичига бирлаштирилади/combined.



Бираштириш функцияси ҳар бир жойдаги қийматларнинг ҳар бир ноёб комбинацияси/each unique combination га янги ноёб қийматни/unique value белгилайди. Ҳақиқий қиймат бирлиги ёки алтернатив майдон қиймати агар аниқ кўрсатилса, атрибут жадвалга чиқиш растрлар қўшилади: ҳар бир кириш растр учун битта (6-расм). 
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6-расм. Иккита кириш растр маълумотлар  тўпламининг оверлей қилиниши. Syntax: outgrid = combine(ingrid1, ingrid2, ingrid3). 

		

1.



‘Raster operations.mxd’ АrcMap ҳужжатини очинг. !!! Дастлаб Spatial Analyst extension ни автив ҳолга келтиринг. Меню панели дан Tools ни танланг, Extensions ни босинг ва Spatial Analyst ни белгиланг. Бу сизга растр маълумотларини қайта ишлаш учун Spatial Analyst tools дан фойдаланиш имконини беради!!!. 





1а. Локал операциялари - геометрик (фазовий/spatial) ёки тематик (фазовий эмас/non-spatial) операцияларми? Жавобингизни тушунтиринг. 





1b. Биттадан кўп бўлган маълумот тўпламини жалб қилган локал операцияларни амалга оширишда қандай геометрик танқидлар бажарилиши керак? 









Математик функциялар ва операторлар 



ArcMapнинг Растр калькулятори/Raster Calculator битта функция ёки комплекс математик ифодаларнинг бир нечта операторлар ва функциялар билан оддий математик ифодаларни яратиши мумкин. Чиқиш растр маълумот тўплами автоматик равишда ноёб рақамлар орқали ‘Calculation’ деб номланади. Яратилгандан сўнг ушбу ном ўзгартирилиши мумкин, у растр маълумот тўпламининг майдон номини босиш орқали ўзгаради. 

Жиддий эътибор қаратинг: Raster Calculator нинг чиқиш растр маълумот тўплами  сизнинг workspaceда эмас балки, қаттиқ дискда ‘TEMP’ папкасида сақланган ВАҚТИНЧАЛИК/TEMPORARY растр маълумот тўплами ҳисобланади. Агар сиз операциянинг натижасидан қониққан бўлсангиз, сиз растр маълумот тўпламини доимий/permanent ҳолатга ўтказишингиз мумкин. Сиз буни растр маълумот тўпламининг ўнг томонини босиб турган ҳолда Make permanent матнини танлашингиз мумкин. Растр маълумот тўпламига мос келадиган номни беринг ва уни workspace даги папкангизга сақланг. 

ҚЎЛЛАНМА:

1. Spatial Analyst асбоблар панелини очинг: меню панели дан View => Toolbars ни танланг. 

2. Spatial Analyst пастга қараган стрелкани босинг ва Raster Calculator ни босинг. 

3. Растр калькуятор диалог ойнаси  янги чиқиш растр маълумот тўпламини ишлаб чиқарадиган ифодани яратиш учун ёрдам беради. Ифода бир растр ёки бир нечта растр маълумот тўпламига асосланган бўлиши мумкин.

4. Raster Сalculator диолог ойнаси 7 та бўлимлардан иборат (7-расм). 

1. Актив ҳолатдаги маълумот рамкасида растр маълумотлар тўпламининг яроқли қатламлар/layers рўйхати ойнаси. 

2. Арифметик операторлар

3. Рақамлар клавиатураси 

4. Боғловчи операторлар 

5. Boolean операторлар 

6. Математик функциялар 

7. Ифода ойнаси 

5. Ифодангизни expression box ойнасига теринг ёки оператор тугмаси ёрдамида ифодани яратинг. 

6. Ифодангизга растр маълумотлар тўпламини layers рўйхатидаги растр маълумотга икки марта босиш орқали киритишингиз мумкин ва Recent Expressions ни танланг. Кейин эса ифодани expression box га кўчириб ўтказинг. 

7. Evaluate ни босинг. 

8. Output растр маълумот тўплами актив ҳолатдаги маълумот рамкасига қўшилган ҳисобланади.

9. [image: ]Output растр маълумот тўпламингизни доимий ҳолатга ўтказинг: workspaceда сақланг.

7-расм. Растр калькулятори

		

2.



‘Local’ маълумот рамкасини актив ҳолатга келтиринг. ‘dem’ маълумот тўплами (digital elevation model) баландлик қийматларидан ташкил топган, у метрда/meters берилган. Сантиметрда/centimeters ифодаланган баландлик бўйича янги растрни яратинг. 





2a. Raster Calculator диалог ойнасида сиз томондан шакллантириб яратилган ифодани ёзинг.





2b. Ушбу яратилган янги растр маълумот тўпламининг номи қандай? Растр маълумот тўпламини доимий ҳолатга келтиринг. Workspaceда сақланг ва мос келадиган қандайдир номга ўзгартиринг. 







		

3.



Ифодада Relational ва Boolean операторларидан фойдаланиб Raster Calculator билан растр катакчаларини танлашингиз мумкин. Ёдда тутинг: сиз ‘=’ ишорасини танлаганингизда иккита ‘=’ ифодаси пайдо бўлади. Бу растр калькулятор синтаксиси учун одатий ҳолат ҳисобланади. 



3а. 30 метрдан юқори баландликда жойлашган биноларнинг ифодасини raster calculator да яратинг ва ифодани ёзинг.





3b. Output растр маълумот тўпламидаги ‘0’ ва ‘1’ қийматларининг маъноси нима?





Сизга шаҳар ҳокимияти/муниципалитет томонидан қуйидаги шартлар асосида потенциал уйлар учун жой танлаш вазифаси юклатилади:



(1) Жой ‘Holtpodzolgrond’ (тупроқ коди/soil code ‘gY30’, қиймат/value 4) қисмда бўлиши керак, аммо ўрмонни кесишга рухсат этилмайди.



(2) Агар баландик камида 9 метр бўлса, бошқа турдаги тупроқ жойларидан ҳам  яроқли хисобланади.





3с. Ушбу танлов учун ифодаларни ёзинг. 





3d. Потенциал уйлар учун танланган жойнинг умумий ҳудуди қанча? 











Растр оверлей

Аввалги машқлар давомида яратилган output растрлар икки саноқли тизим/binary эди: Сиз ифодада келтирган шартлар растр катакчада амалга оширилди ёки амалга оширилмади. Output растрнинг аттрибут жадвали фақат ‘0’ ва ‘1’ қийматлардан ташкил топган. Агар сиз кейинги тҳлилни бажаришни истаганингизда, ноқолуй бўлган тупроқ коди/soil code ва ердан фойдаланиш кодининг/land use code қийматлари кўринмаган/ёки йўқолган ҳисобланган эди. 



Бирлаштириш функциясини қўллаш орқали растр оверлей/устки қоплама бу каби муаммоларни ҳал қилади. Input растрларнинг ҳақиқий қийматлари output растрнинг атрубут жадвалларда сақланган бўлади. 

ҚЎЛЛАНМА: 

1. ArcToolbox ни очинг. Spatial Analyst Tools => Local => Combine ни танланг. 

2. Input rasters ойнасининг пастга қараган стрелкасини босинг: бирлаштирмоқчи бўлган растрларни танланг. 

3.  Output raster ойнасида номини ва output rasterнинг жойини аниқлаштиринг.

4. OKни танланг. 

Ёдда тутинг: Output атрибут жадвалда қийматлар бутун сон/integer. Ўнли сондан ташкил топган қийматлар (баландлик қийматлари каби) равон/rounded қилинади.

		

4.



‘Soil_raster’, ‘lu_raster’ ва ‘dem’ растрларни combine функциясидан фойдаланиб оверлей қилинг. 





4a. Тупроқ коди ‘Rn95C’ (қиймат 3) бўлган тупроқда яйлов ҳудудлар/pasture area (қиймат 5) ни атрибут жадвалдан танланг. Танланган растр катакчаларнинг баландлик миқдори қанча? 





4b. Яйлов билан қопланган тупроқ коди Rn95C бўлган тупроқнинг қисми (%да) қанча?











ФОКАЛ ОПЕРАЦИЯЛАР

Фокал (/жой, теварак-атроф) операциялар/Focal operations (neighborhood) output растр маълумот тўпламини яратади яъни бир хил жойни эгаллаган input қийматнинг функцияси ҳар бир жойнинг output қиймати ва аниқ белгиланган жойнинг теварак атрофида катакчаларнинг қиймати ҳисобланади (8-расм). Бу операция Халқа/Annulus, Айлана/Circle, Тўғрибурчак/Rectangle ва ҳар қандай йўналишдаги учбурчак шаклида бўлиши мумкин. 
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8- расм. Фокал операциялар манба катакчасига фойдаланувчи белгилайдиган жойга таъсир кўрсатади.

Фокал операцияларнинг иккита муҳим турлари бу - фокал статистика ва фокал фильтрлар ҳисобланади. Ушбу амалий машғулотда эътиборни фокал статистикага, шунингдек, теварак-атроф статистикаси/neighborhood statistics каби англатилган статистикага қаратамиз.

Фокал операторлар қандай ишлайди? Биз биламизки, фокал операторлар манба катачасининг қийматидан фойдаланади ва манба катакчаси каби бир хил жойда/same location output растр катакча учун янги катакча қийматини ҳисоблашда катакчаларнинг қийматини манба қиймати атрофида фойдаланувчи белгилайдиган теварак-атрофда қўллайди. 

Фараз қилингки, биз 5х5 бўлган растр катакчаларнинг тўртбурчак шаклдаги теварак-атрофини белгиладик (9-расм) ва фокал функцияни, масалан ‘focal sum’ теварак-атроф/neighborhood статистикани танладик. Сиз теварак-атрофни ойна каби эътибор қаратилишини яъни растр маълумот тўплами қатлами атрофида ҳаракатланаётганини муҳокама қилишингизи мумкин. Бу мисолда харакатланувчи ойна растр маълумот тўплами қатламининг тепадаги чап бурчагида жойлашган (Neighborhood A, 9-расм).
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9-расм. 5х5 растр катакчалари орқали теварак-атрофни қайта ишлаш/Processing by 5x5 raster cells neighborhood.

Ойнадаги марказий катакча манба/source ёки қайта ишлаш катакчаси/processing cell ҳисобланади. Янги қиймат танланган функция асосида ҳар бир қайта ишлаш катакчаси учун ҳисобланади/calculated. Янги ҳисобланган катакча қиймати output растрда яъни бир хил жойда сақланган бўлади. Кейин ойна битта катакча ўнгга ҳаракатланади (Neigborhood B, 9-расм). Қайта ишловчи катакча/processing cell ҳам битта катакча ўнгга ҳаракатланади (9-расм). Янги қайта ишловчи катакча учун ҳисоблашлар қайтарилади. Натижа эса output растр маълумот тўпламида қайтадан сақланиш ҳисобланади. Кейин яна ойна битта катакча ўнгга силжийди … то input растр маълумот тўплами қатламининг охирги катакчасига эришгунча ҳаракатланади. 

10-расм ‘focal sum’ neighborhood статистикасининг ҳисобини намойиш этади. 10-расмнинг тепа қисми 3х3 тўртбурчак neighborhood функциясини кўрсатади. Қайта ишловчи катакчаси 2 қийматига эга. Output растрда худди шу катакча қайта ишловчи катакчанинг сумма қийматини, ҳамда neighborhood катакчаларининг қийматини олади: бу ҳолатда сумма 21 га тенг. 21 нинг қиймати input растрда қайта ишловчи катакча каби output растрда ўша жойида/at the same location катакчага белгиланган ҳисобланади. 10-расмнинг пастки қисми бутун растр маълумот тўплами учун натижани кўрсатади. 
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10-расм. ‘Focal sum’ neighborhood статистикасининг ҳисобланиши кўрсатилган.

Aгар катакча neighborhood да NoData қийматини кўрсатса, у қайта ишлаш жараёнида, локал операторларида NoData катакчалари билан тамомила қарши равишда эътиборсиз қолдирилади/ignored. Агар бутун neighborhood NoData катакчаларидан ташкил топган бўлса, output катакча қиймати NoData бўлади. 

Фокал (neighborhood) статистика 

ҚЎЛЛАНМА: 

1. ArcToolbox ни очинг. Spatial Analyst Tools => Neighborhood => Focal Statistics ни танланг.

2. Ҳисобламоқчи бўлган Input raster dataset ни танланг. 

3. Output raster ойнасида output растрнинг номини ва жойини аниқлаштиринг.



4. Neighborhood шаклини танлаш учун Neighborhood нинг пастга қараган стрелкасини босинг. Мос келувчи neighborhood лар: Халқа/Annulus, Айлана/Circle, Тўғрибурчак/Rectangle ва Учбурчак/Wedge ҳисобланади. 

5. Neighborhood нинг баландлиги/height ва энини/width аниқланг. Units ни Сell га жойланг.  

6. Statistic type рўйхатидан statistic ни танланг. Мос статистика, булар: Minimum, Maximum, Range, Sum, Mean, Standard Deviation, Variety, Majority, Minority ва Median.

7. OK ни босинг. 

		

5.



‘Focal’ маълумот рамкасини актив ҳолатга келтиринг. 



5а. ‘dem’ раст маълумот тўплами учун ‘mean’ neighborhood статистикасини ҳисобланг. Қуйидагиларни neighborhoodни бажаринг: 



- растр маълумот тўпламини focal_mean деб номланг. Уни workspaceда сақланг. 

- rectangular neighborhood дан фойдаланинг. 

- neighborhood ўлчами: 9х9 катакчалар. 



5b. Баландлик растри/elevation rast каби output растр учун бир хил белгини/same symbology танланг. ‘Focal mean’ операциясининг таъсирларини тушунтириб беринг. 





5с. ‘lu_raster’ растр маълумот тўплами учун ‘maximum’ neighborhood статистикасини ҳисобланг. Юқорида таърифланган neighborhoodни дан фойдаланинг. 





5d. Ҳисобланган қийматлар қандайдир маънони англатадими? Жавобингизда ‘маълумот шкаласи/data scale’ сўзидан фойдаланинг. 































































8-амалий машғулотни бажаргандан кейин ўз-ўзини

текшириш учун саволлар











































Саволлар



1. ArcGIS да катакчага – асосланган/cell – based операциялар нечта турга бўлинади ва уларнинг номлари қандай? 

2. Биттадан кўп бўлган кириш растр маълумот тўплами билан Map Algebra дан фойдаланишда, кириш растр маълумотлар тўпламига нима мос келиши лозим? 

3. Растр операциялар амалий машғулотининг вазифалари нималардан иборат? 

4. Локал операциялар амалга оширилаётганда нималарга эътибор каратиш лозим? 

5. Математик функцияларнинг нечта қандай гуруҳлари мавжуд? 

6. Арифметик операторлар қандай амалларни бажариши мумкин?

7. Мантиқий операторлар нима ҳисоблайди ва унга таъриф беринг? 

8. Локал операцияларнинг тўртинчи тури нима ва унга таъриф беринг? 

9. Raster Сalculator диолог ойнаси нечта бўлимлардан иборат ва улар қайсилар? 

10. Фокал операцияларига таъриф беринг.

11. Фокал операциялар қандай шаклларда бўлиши мумкин? 

12. Фокал операцияларнинг қандай муҳим иккита тури мавжуд? 
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